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Basic Safety Instructions

Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety
standards of our products up to date and to offer our customers the highest possible degree of safety. Our
products and the auxiliary equipment they require are designed, built and tested in accordance with the
safety standards that apply in each case. Compliance with these standards is continuously monitored by
our quality assurance system. The product described here has been designed, built and tested in
accordance with the EC Certificate of Conformity and has left the manufacturer’s plant in a condition fully
complying with safety standards. To maintain this condition and to ensure safe operation, you must
observe all instructions and warnings provided in this manual. If you have any questions regarding these
safety instructions, the Rohde & Schwarz group of companies will be happy to answer them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must
not be used in any way that may cause personal injury or property damage. You are responsible if the
product is used for any purpose other than its designated purpose or in disregard of the manufacturer's
instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions). Using
the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore
essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be
allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this
will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions
and the product documentation in a safe place and pass them on to the subsequent users.

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before and when using the product. It is also absolutely essential to observe the additional safety
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In
these safety instructions, the word "product"” refers to all merchandise sold and distributed by the Rohde &
Schwarz group of companies, including instruments, systems and all accessories. For product-specific
information, see the data sheet and the product documentation.

Safety labels on products

The following safety labels are used on products to warn against risks and dangers.

Symbol Meaning Symbol Meaning

Notice, general danger location | O ON/OFF Power

Observe product documentation

Caution when handling heavy equipment d) Standby indication

Danger of electric shock f— Direct current (DC)

> B>
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Basic Safety Instructions

Meaning Symbol Meaning
Caution ! Hot surface ~_ Alternating current (AC)
Protective conductor terminal = Direct/alternating current (DC/AC)
To identify any terminal which is intended for
connection to an external conductor for
protection against electric shock in case of a
fault, or the terminal of a protective earth
Earth (Ground) D Class Il Equipment
to identify equipment meeting the safety

requirements specified for Class Il equipment
(device protected by double or reinforced
insulation)

Frame or chassis Ground terminal

EU labeling for batteries and accumulators

For additional information, see section "Waste
disposal/Environmental protection”, item 1.

devices

Be careful when handling electrostatic sensitive

EU labeling for separate collection of electrical
and electronic devices

For additional information, see section "Waste
disposal/Environmental protection”, item 2.

Warning! Laser radiation

For additional information, see section
"Operation", item 7.

Signal words and their meaning

The following signal words are used in the product documentation in order to warn the reader about risks

and dangers.

& WARNING

A CAUTION

Indicates a hazardous situation which, if not avoided, will result in death or
serious injury.

Indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

Indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

Indicates information considered important, but not hazard-related, e.g.
messages relating to property damage.
In the product documentation, the word ATTENTION is used synonymously.

These signal words are in accordance with the standard definition for civil applications in the European
Economic Area. Definitions that deviate from the standard definition may also exist in other economic
areas or military applications. It is therefore essential to make sure that the signal words described here
are always used only in connection with the related product documentation and the related product. The
use of signal words in connection with unrelated products or documentation can result in misinterpretation
and in personal injury or material damage.
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Basic Safety Instructions

Operating states and operating positions

The product may be operated only under the operating conditions and in the positions specified by the
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local
or national safety regulations and rules for the prevention of accidents must be observed in all work
performed.

1.

Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:
predefined operating position is always with the housing floor facing down, IP protection 2X, use only
indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea
level. A tolerance of +10 % shall apply to the nominal voltage and +5 % to the nominal frequency,
overvoltage category 2, pollution degree 2.

Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation
that is not carried out as described in the product documentation could result in personal injury or
even death.

Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient
temperature must not exceed the maximum temperature specified in the product documentation or in
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or
even death.

Electrical safety

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock,
fire and/or serious personal injury or death may occur.

1.

Prior to switching on the product, always ensure that the nominal voltage setting on the product
matches the nominal voltage of the mains-supply network. If a different voltage is to be set, the power
fuse of the product may have to be changed accordingly.

In the case of products of safety class | with movable power cord and connector, operation is
permitted only on sockets with a protective conductor contact and protective conductor.

Intentionally breaking the protective conductor either in the feed line or in the product itself is not
permitted. Doing so can result in the danger of an electric shock from the product. If extension cords
or connector strips are implemented, they must be checked on a regular basis to ensure that they are
safe to use.

If there is no power switch for disconnecting the product from the mains, or if the power switch is not
suitable for this purpose, use the plug of the connecting cable to disconnect the product from the
mains. In such cases, always ensure that the power plug is easily reachable and accessible at all
times. For example, if the power plug is the disconnecting device, the length of the connecting cable
must not exceed 3 m. Functional or electronic switches are not suitable for providing disconnection
from the AC supply network. If products without power switches are integrated into racks or systems,
the disconnecting device must be provided at the system level.

Never use the product if the power cable is damaged. Check the power cables on a regular basis to
ensure that they are in proper operating condition. By taking appropriate safety measures and
carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be
hurt by, for example, tripping over the cable or suffering an electric shock.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

Basic Safety Instructions

The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher
fuse only after consulting with the Rohde & Schwarz group of companies).

Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the
socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.

Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric
shocks.

For measurements in circuits with voltages Vs > 30 V, suitable measures (e.g. appropriate
measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be
taken to avoid any hazards.

Ensure that the connections with information technology equipment, e.g. PCs or other industrial
computers, comply with the IEC 60950-1 / EN 60950-1 or IEC 61010-1 / EN 61010-1 standards that
apply in each case.

Unless expressly permitted, never remove the cover or any part of the housing while the product is in
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the
product.

If a product is to be permanently installed, the connection between the protective conductor terminal
on site and the product's protective conductor must be made first before any other connection is
made. The product may be installed and connected only by a licensed electrician.

For permanently installed equipment without built-in fuses, circuit breakers or similar protective
devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the
product, as well as the product itself, is adequately protected from injury or damage.

Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the
danger of an electric shock.

Any object that is not designed to be placed in the openings of the housing must not be used for this
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries.

Unless specified otherwise, products are not liquid-proof (see also section "Operating states and
operating positions", item 1). Therefore, the equipment must be protected against penetration by
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product
itself may be damaged, which can also lead to personal injury.

Never use the product under conditions in which condensation has formed or can form in or on the
product, e.qg. if the product has been moved from a cold to a warm environment. Penetration by water
increases the risk of electric shock.

Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such
as alcohol, acetone or diluents for cellulose lacquers.

Operation

1.

Operating the products requires special training and intense concentration. Make sure that persons
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries
or material damage may occur. It is the responsibility of the employer/operator to select suitable
personnel for operating the products.
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Basic Safety Instructions

2. Before you move or transport the product, read and observe the section titled "Transport".

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz
product, consult a physician immediately to determine the cause and to prevent health problems or
stress.

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be
sure to read and pay special attention to the section titled "Waste disposal/Environmental protection”,
item 1.

5. Depending on the function, certain products such as RF radio equipment can produce an elevated
level of electromagnetic radiation. Considering that unborn babies require increased protection,
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the
potential danger.

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and
protective clothing must be worn.

7. Laser products are given warning labels that are standardized according to their laser class. Lasers
can cause biological harm due to the properties of their radiation and due to their extremely
concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a
Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the
product documentation. The objective is to prevent personal injury (e.g. due to laser beams).

8. EMC classes (in line with EN 55011/CISPR 11, and analogously with EN 55022/CISPR 22,

EN 55032/CISPR 32)

— Class A equipment:
Equipment suitable for use in all environments except residential environments and environments
that are directly connected to a low-voltage supply network that supplies residential buildings
Note: Class A equipment is intended for use in an industrial environment. This equipment may
cause radio disturbances in residential environments, due to possible conducted as well as
radiated disturbances. In this case, the operator may be required to take appropriate measures to
eliminate these disturbances.

— Class B equipment:
Equipment suitable for use in residential environments and environments that are directly
connected to a low-voltage supply network that supplies residential buildings

Repair and service

1. The product may be opened only by authorized, specially trained personnel. Before any work is
performed on the product or before the product is opened, it must be disconnected from the AC supply
network. Otherwise, personnel will be exposed to the risk of an electric shock.
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Basic Safety Instructions

Adjustments, replacement of parts, maintenance and repair may be performed only by electrical
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed
after parts relevant to safety have been replaced (visual inspection, protective conductor test,
insulation resistance measurement, leakage current measurement, functional test). This helps ensure
the continued safety of the product.

Batteries and rechargeable batteries/cells

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g.
lithium cells) must be handled in accordance with the EN 62133 standard.

1.
2.

Cells must not be taken apart or crushed.

Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided.
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth.

Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a
drawer where they can short-circuit each other, or where they can be short-circuited by other
conductive materials. Cells and batteries must not be removed from their original packaging until they
are ready to be used.

Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted.

If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If
contact occurs, wash the affected area with plenty of water and seek medical aid.

Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells)
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see
parts list) in order to ensure the safety of the product.

Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the
national regulations regarding waste disposal and recycling.

Transport

1.

The product may be very heavy. Therefore, the product must be handled with care. In some cases,
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid
back or other physical injuries.

Handles on the products are designed exclusively to enable personnel to transport the product. It is
therefore not permissible to use handles to fasten the product to or on transport equipment such as
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of
transport or lifting. Noncompliance can result in personal injury or material damage.

If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the
product in the vehicle to prevent injuries or other damage in the event of an accident.
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Instrucciones de seguridad elementales

Waste disposal/Environmental protection

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted
municipal waste, but must be collected separately. It may only be disposed of at a suitable collection
point or via a Rohde & Schwarz customer service center.

2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but
must be collected separately.
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for
take-back obligations and disposal obligations for manufacturers within the EU. Contact your
Rohde & Schwarz customer service center for environmentally responsible disposal of the product.

3. If products or their components are mechanically and/or thermally processed in a manner that goes
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel)
may be released. For this reason, the product may only be disassembled by specially trained
personnel. Improper disassembly may be hazardous to your health. National waste disposal
regulations must be observed.

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal
regulations must be observed. Also observe the relevant safety instructions in the product
documentation. The improper disposal of hazardous substances or fuels can cause health problems
and lead to environmental damage.

For additional information about environmental protection, visit the Rohde & Schwarz website.

Instrucciones de seguridad elementales

iEs imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al dia
con los estandares de seguridad y de ofrecer a nuestros clientes el maximo grado de seguridad. Nuestros
productos y todos los equipos adicionales son siempre fabricados y examinados segun las normas de
seguridad vigentes. Nuestro sistema de garantia de calidad controla constantemente que sean cumplidas
estas normas. El presente producto ha sido fabricado y examinado segun el certificado de conformidad
de la UE y ha salido de nuestra planta en estado impecable segun los estandares técnicos de seguridad.
Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario debera
atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de empresas
Rohde & Schwarz esta siempre a su disposicién en caso de que tengan preguntas referentes a estas
informaciones de seguridad.

Ademés queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto
esta destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente
autorizado, para aplicaciones de campo y de ninguna manera debera ser utilizado de modo que alguna
persona/cosa pueda sufrir dafio. El uso del producto fuera de sus fines definidos o sin tener en cuenta las
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna
forma responsable de consecuencias a causa del mal uso del producto.
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Instrucciones de seguridad elementales

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las
indicaciones de la correspondiente documentacion del producto y dentro del margen de rendimiento
definido (ver hoja de datos, documentacién, informaciones de seguridad que siguen). El uso del producto
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el
uso de productos de Rohde & Schwarz, encontraria la informacion debida en la documentacion del
producto en el capitulo correspondiente. Guarde bien las informaciones de seguridad elementales, asi
como la documentacién del producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o dafios por
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del
producto. Deberan tenerse en cuenta todas las demas informaciones de seguridad, como p. €j. las
referentes a la proteccion de personas, que encontrardn en el capitulo correspondiente de la
documentacién del producto y que también son de obligado cumplimiento. En las presentes
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas

Rohde & Schwarz bajo la denominacién de "producto”, entre ellos también aparatos, instalaciones asi
como toda clase de accesorios. Los datos especificos del producto figuran en la hoja de datos y en la
documentacién del producto.

Sefializacién de seguridad de los productos

Las siguientes sefiales de seguridad se utilizan en los productos para advertir sobre riesgos y peligros.

Simbolo Significado Simbolo Significado

Aviso: punto de peligro general | O Tension de alimentacion de PUESTA EN

o, MARCHA / PARADA
Observar la documentacion del producto

Atencién en el manejo de dispositivos de peso d) Indicacion de estado de espera (standby)
A elevado
| 18 kg |
2 Peligro de choque eléctrico e Corriente continua (DC)
f Advertencia: superficie caliente A~ Corriente alterna (AC)
. Conexion a conductor de proteccion —_ Corriente continua / Corriente alterna (DC/AC)
Conexion a tierra D El aparato esta protegido en su totalidad por un
aislamiento doble (reforzado)
Conexi6n a masa Distintivo de la UE para baterias y
acumuladores

Mas informacién en la seccion
"Eliminacion/proteccion del medio ambiente",
punto 1.
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Instrucciones de seguridad elementales

Simbolo Significado Significado

Aviso: Cuidado en el manejo de dispositivos
sensibles a la electrostatica (ESD)

Distintivo de la UE para la eliminacion por
separado de dispositivos eléctricos y
electronicos

Mas informacién en la seccion
"Eliminacion/proteccion del medio ambiente”,
punto 2.

Advertencia: rayo laser

Mas informacion en la seccién
"Funcionamiento", punto 7.

Palabras de sefial y su significado

En la documentacidon del producto se utilizan las siguientes palabras de sefial con el fin de advertir contra
riesgos y peligros.

A PELIGRO Indica una situacion de peligro que, si no se evita, causa lesiones
graves o incluso la muerte.

Indica una situacién de peligro que, si no se evita, puede causar

A ADVERTENCIA lesiones graves o incluso la muerte.

Indica una situacién de peligro que, si no se evita, puede causar
lesiones leves o moderadas.

A ATENCION

m Indica informacién que se considera importante, pero no en relacion
con situaciones de peligro; p. €j., avisos sobre posibles dafios
materiales.

En la documentacion del producto se emplea de forma sindénima el
término CUIDADO.

Las palabras de sefial corresponden a la definicion habitual para aplicaciones civiles en el area
econdémica europea. Pueden existir definiciones diferentes a esta definicién en otras areas econémicas o
en aplicaciones militares. Por eso se deberd tener en cuenta que las palabras de sefial aqui descritas
sean utilizadas siempre solamente en combinacion con la correspondiente documentacién del producto y
solamente en combinacion con el producto correspondiente. La utilizacion de las palabras de sefial en
combinacion con productos o documentaciones que no les correspondan puede llevar a interpretaciones
equivocadas y tener por consecuencia dafios en personas u objetos.

Estados operativos y posiciones de funcionamiento

El producto solamente debe ser utilizado segun lo indicado por el fabricante respecto a los estados
operativos y posiciones de funcionamiento sin que se obstruya la ventilacion. Si no se siguen las
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con
posible consecuencia de muerte. En todos los trabajos deberan ser tenidas en cuenta las normas
nacionales y locales de seguridad del trabajo y de prevencion de accidentes.
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Instrucciones de seguridad elementales

Si no se convino de otra manera, es para los productos Rohde & Schwarz valido lo que sigue:
como posicién de funcionamiento se define por principio la posicién con el suelo de la caja para
abajo, modo de proteccién IP 2X, uso solamente en estancias interiores, utilizacién hasta 2000 m
sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicara una tolerancia de
+10 % sobre el voltaje nominal y de +5 % sobre la frecuencia nominal. Categoria de sobrecarga
eléctrica 2, indice de suciedad 2.

No sitle el producto encima de superficies, vehiculos, estantes o mesas, que por sus caracteristicas
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalacion del
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si
se realiza la instalacion de modo distinto al indicado en la documentacion del producto, se pueden
causar lesiones o, en determinadas circunstancias, incluso la muerte.

No ponga el producto sobre aparatos que generen calor (p. €j. radiadores o calefactores). La
temperatura ambiente no debe superar la temperatura maxima especificada en la documentacion del
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia
de muerte.

1.

Antes de la puesta en marcha del producto se deberd comprobar siempre que la tensién
preseleccionada en el producto coincida con la de la red de alimentacion eléctrica. Si es necesario
modificar el ajuste de tension, también se deberan cambiar en caso dado los fusibles
correspondientes del producto.

Los productos de la clase de proteccién | con alimentacion mévil y enchufe individual solamente
podran enchufarse a tomas de corriente con contacto de seguridad y con conductor de proteccion
conectado.

Queda prohibida la interrupcién intencionada del conductor de proteccién, tanto en la toma de
corriente como en el mismo producto. La interrupcion puede tener como consecuencia el riesgo de
gue el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de
enchufe, debera garantizarse la realizacién de un examen regular de los mismos en cuanto a su
estado técnico de seguridad.

Si el producto no est& equipado con un interruptor para desconectarlo de la red, o bien si el
interruptor existente no resulta apropiado para la desconexion de la red, el enchufe del cable de
conexion se debera considerar como un dispositivo de desconexion.

El dispositivo de desconexién se debe poder alcanzar facilmente y debe estar siempre bien accesible.
Si, p. €]., el enchufe de conexion a la red es el dispositivo de desconexién, la longitud del cable de
conexion no debe superar 3 m).

Los interruptores selectores o electrénicos no son aptos para el corte de la red eléctrica. Si se
integran productos sin interruptor en bastidores o instalaciones, se debera colocar el interruptor en el
nivel de la instalacion.

No utilice nunca el producto si esta dafiado el cable de conexién a red. Compruebe regularmente el
correcto estado de los cables de conexion a red. Asegurese, mediante las medidas de proteccién y
de instalacion adecuadas, de que el cable de conexién a red no pueda ser dafiado o de que nadie
pueda ser dafiado por él, p. €j. al tropezar o por un choque eléctrico.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

Instrucciones de seguridad elementales

Solamente esta permitido el funcionamiento en redes de alimentacion TN/TT aseguradas con fusibles
de 16 A como maximo (utilizacién de fusibles de mayor amperaje solo previa consulta con el grupo de
empresas Rohde & Schwarz).

Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por
completo y fuertemente en la toma de corriente. La no observacion de estas medidas puede provocar
chispas, fuego y/o lesiones.

No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto
podria causar fuego o choques eléctricos.

En las mediciones en circuitos de corriente con una tension Ug; > 30 V se deberan tomar las medidas
apropiadas para impedir cualquier peligro (p. ej. medios de medicién adecuados, seguros, limitacion
de tensidn, corte protector, aislamiento etc.).

Para la conexiéon con dispositivos informaticos como un PC o un ordenador industrial, debe
comprobarse que éstos cumplan los estandares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1
validos en cada caso.

A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y
puede causar lesiones, fuego o dafos en el producto.

Si un producto se instala en un lugar fijo, se debera primero conectar el conductor de proteccion fijo
con el conductor de proteccion del producto antes de hacer cualquier otra conexién. La instalacion y
la conexidon deberan ser efectuadas por un electricista especializado.

En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automatico ni otros
mecanismos de seguridad similares, el circuito de alimentacién debe estar protegido de modo que
todas las personas que puedan acceder al producto, asi como el producto mismo, estén a salvo de
posibles dafios.

Todo producto debe estar protegido contra sobretension (debida p. ej. a una caida del rayo) mediante
los correspondientes sistemas de proteccion. Si no, el personal que lo utilice quedara expuesto al
peligro de choque eléctrico.

No debe introducirse en los orificios de la caja del aparato ningin objeto que no esté destinado a ello.
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o
lesiones.

Salvo indicacién contraria, los productos no estan impermeabilizados (ver también el capitulo
"Estados operativos y posiciones de funcionamiento”, punto 1). Por eso es necesario tomar las
medidas necesarias para evitar la entrada de liquidos. En caso contrario, existe peligro de choque
eléctrico para el usuario o de dafios en el producto, que también pueden redundar en peligro para las
personas.

No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido
condensaciones sobre el producto o en el interior de éste, como p. €j. al desplazarlo de un lugar frio a
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico.

Antes de la limpieza, desconecte por completo el producto de la alimentacion de tension (p. €j. red de
alimentacion o bateria). Realice la limpieza de los aparatos con un pafio suave, que no se deshilache.
No utilice bajo ninglin concepto productos de limpieza quimicos como alcohol, acetona o diluyentes
para lacas nitrocelulésicas.
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Instrucciones de seguridad elementales

Funcionamiento

1.

El uso del producto requiere instrucciones especiales y una alta concentracion durante el manejo.
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos
necesarios en cuanto a aptitudes fisicas, psiquicas y emocionales, ya que de otra manera no se
pueden excluir lesiones o dafios de objetos. El empresario u operador es responsable de seleccionar
el personal usuario apto para el manejo del producto.

Antes de desplazar o transportar el producto, lea y tenga en cuenta el capitulo "Transporte".

Como con todo producto de fabricacion industrial no puede quedar excluida en general la posibilidad
de que se produzcan alergias provocadas por algunos materiales empleados —los llamados
alérgenos (p. €j. el niquel)—. Si durante el manejo de productos Rohde & Schwarz se producen
reacciones alérgicas, como p. €j. irritaciones cutaneas, estornudos continuos, enrojecimiento de la
conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las
causas y evitar cualquier molestia o dafio a la salud.

Antes de la manipulacién mecénica y/o térmica o el desmontaje del producto, debe tenerse en cuenta
imprescindiblemente el capitulo "Eliminacién/proteccion del medio ambiente”, punto 1.

Ciertos productos, como p. €]. las instalaciones de radiocomunicacion RF, pueden a causa de su
funcion natural, emitir una radiacion electromagnética aumentada. Deben tomarse todas las medidas
necesarias para la proteccion de las mujeres embarazadas. También las personas con marcapasos
pueden correr peligro a causa de la radiacién electromagnética. El empresario/operador tiene la
obligacion de evaluar y sefalizar las areas de trabajo en las que exista un riesgo elevado de
exposicion a radiaciones.

Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias téxicas
(gases, liquidos etc.) que pueden generar dafios a la salud. Por eso, en caso de incendio deben
usarse medidas adecuadas, como p. ej. mascaras antigas e indumentaria de proteccion.

Los productos con laser estan provistos de indicaciones de advertencia normalizadas en funcién de la
clase de laser del que se trate. Los rayos laser pueden provocar dafios de tipo biolégico a causa de
las propiedades de su radiacion y debido a su concentracién extrema de potencia electromagnética.
En caso de que un producto Rohde & Schwarz contenga un producto laser (p. €j. un lector de
CD/DVD), no debe usarse ninguna otra configuracion o funcion aparte de las descritas en la
documentacién del producto, a fin de evitar lesiones (p. ej. debidas a irradiacion laser).

Clases de compatibilidad electromagnética (conforme a EN 55011 / CISPR 11; y en analogia con EN

55022 / CISPR 22, EN 55032 / CISPR 32)

— Aparato de clase A:
Aparato adecuado para su uso en todos los entornos excepto en los residenciales y en aquellos
conectados directamente a una red de distribucion de baja tensiéon que suministra corriente a
edificios residenciales.
Nota: Los aparatos de clase A estan destinados al uso en entornos industriales. Estos aparatos
pueden causar perturbaciones radioeléctricas en entornos residenciales debido a posibles
perturbaciones guiadas o radiadas. En este caso, se le podra solicitar al operador que tome las
medidas adecuadas para eliminar estas perturbaciones.

— Aparato de clase B:
Aparato adecuado para su uso en entornos residenciales, asi como en aquellos conectados
directamente a una red de distribucién de baja tension que suministra corriente a edificios
residenciales.
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Instrucciones de seguridad elementales

Reparacion y mantenimiento

1.

El producto solamente debe ser abierto por personal especializado con autorizacion para ello. Antes
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tension de alimentacion, para
evitar toda posibilidad de choque eléctrico.

El ajuste, el cambio de partes, el mantenimiento y la reparacion deberan ser efectuadas solamente
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los
aspectos de seguridad (p. €j. el enchufe, los transformadores o los fusibles), solamente podran ser
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad
debera realizarse un control de seguridad (control a primera vista, control del conductor de
proteccién, medicién de resistencia de aislamiento, medicion de la corriente de fuga, control de
funcionamiento). Con esto queda garantizada la seguridad del producto.

Baterias y acumuladores o celdas

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterias y
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible
consecuencia de muerte. El manejo de baterias y acumuladores con electrolitos alcalinos (p. €j. celdas de
litio) debe seqguir el estandar EN 62133.

1.
2.

No deben desmontarse, abrirse ni triturarse las celdas.

Las celdas o baterias no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz
directa del sol. Las celdas y baterias deben mantenerse limpias y secas. Limpiar las conexiones
sucias con un pafio seco y limpio.

Las celdas o baterias no deben cortocircuitarse. Es peligroso almacenar las celdas o baterias en
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto reciproco o por contacto con
otros materiales conductores. No deben extraerse las celdas o baterias de sus embalajes originales
hasta el momento en que vayan a utilizarse.

Las celdas o baterias no deben someterse a impactos mecanicos fuertes indebidos.

En caso de falta de estanqueidad de una celda, el liquido vertido no debe entrar en contacto con la
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un
médico.

En caso de cambio o recarga inadecuados, las celdas o baterias que contienen electrolitos alcalinos
(p. €j. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o
baterias solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de
recambios).

Las baterias y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterias o
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales.
Respete en esta relacién las normas nacionales de eliminacion y reciclaje.

Transporte

1.

El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con
precaucion y, si es necesario, usando un sistema de elevacion adecuado (p. ej. una carretilla
elevadora), a fin de evitar lesiones en la espalda u otros dafios personales.
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Instrucciones de seguridad elementales

Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por
personas. Por eso no esta permitido utilizar las asas para la sujecion en o sobre medios de transporte
como p. €j. gruas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los
productos de manera segura a los medios de transporte o elevacion. Para evitar dafios personales o
dafos en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o
elevacién utilizado.

Si se utiliza el producto dentro de un vehiculo, recae de manera exclusiva en el conductor la
responsabilidad de conducir el vehiculo de manera segura y adecuada. El fabricante no asumira
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un
vehiculo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehiculo
debidamente para evitar, en caso de un accidente, lesiones u otra clase de dafios.

Eliminacién/protecciéon del medio ambiente

1.

Los dispositivos marcados contienen una bateria o un acumulador que no se debe desechar con los
residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminacién se debe
efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atencién al
cliente de Rohde & Schwarz.

Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar,
sino que deben ser recogidos por separado.

Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminacién de residuos y asume
plenamente los deberes de recogida y eliminacién para los fabricantes dentro de la UE. Para
desechar el producto de manera respetuosa con el medio ambiente, dirijase a su servicio de atencion
al cliente de Rohde & Schwarz.

Si se trabaja de manera mecéanica y/o térmica cualquier producto o componente mas alla del
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales
pesados como p. ej. plomo, berilio o niquel). Por eso el producto solo debe ser desmontado por
personal especializado con formacién adecuada. Un desmontaje inadecuado puede ocasionar dafios
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminacién de
residuos.

En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que
deban tratarse como residuos especiales (p. €j. refrigerantes o aceites de motor con intervalos de
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas
sustancias y las normas regionales de eliminacion de residuos. Tenga en cuenta también en caso
necesario las indicaciones de seguridad especiales contenidas en la documentacién del producto. La
eliminacién incorrecta de sustancias peligrosas o combustibles puede causar dafios a la salud o
dafios al medio ambiente.

Se puede encontrar mas informacion sobre la proteccién del medio ambiente en la pagina web de
Rohde & Schwarz.
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Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz
equipment.

Up-to-date information and upgrades

To keep your instrument up-to-date and to be informed about new application notes related to your
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish.
We will take care that you will get the right information.

Europe, Africa, Middle East Phone +49 89 4129 12345
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +6565 1304 88
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /
+86-400-650-5896
customersupport.china@rohde-schwarz.com

ROHDE&SCHWARZ

1171.0200.22-06.00
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R&S UPV-K9/-K92 Overview

1 Overview

The acoustic transmission and reproduction quality of a mobile phone is its most
important characteristic in everyday use. Even the most visually appealing design and
wonderfully sophisticated operating concept are not much use, when the user cannot
or can hardly understand what is being said at the other end.

Instruments and methods for measuring acoustic characteristics are therefore essential
tools for assessing the quality and suitability of a mobile phone.

R&S UPV-K92 provides all tests specified in TIA-1042 version 1.0 (3GPP2 C.S0056-0
Version 1.0). It uses the NORMAL real speech signal for sending and receiving
frequency response and loudness rating measurements and the ECHOLOSS speech
signal for the echo loss measurement.

An additional test case for peak acoustic level is provided. This test uses the
PEAKLEYV test signal.

For sending measurements, the frequency response of the artificial mouth needs to be
equalized. For the equalization of arbitrary signals like the NORMAL speech signal,
R&S UPV-K92 provides an off-line filtering tool that compensates the frequency
response of the artificial mouth used in order to generate an acoustically correct
spectrum of the test signal at the mouth reference point (MRP).

With update key R&S UPV-K9201 present, the program provides in addition all
testcases according to TIA-1042-A:2013-03 (3GPP2 C.S0056-A v1.0). This version is
harmonized with 3GPP TS 26.132 and uses Single Talk speech signal according to
ITU-T P.501 for frequency response tests and a dynamically compressed real speech
signal for echo loss tests.

The new testcase “Speech Quality in sending in the Presence of Ambient Noise”
requires additional option R&S UPV-K98 and R&S UPV-K101, additional hardware
R&S UPP200 with R&S UPP-B8 and R&S UP-Z8A as well as additional acoustic
equipment not supplied by Rohde & Schwarz.
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2 Preparation and Start of the Application
Software

2.1 Required Measuring Instruments and Accessories

The R&S UPV audio analyzer with the options as described below is required for the
measurements.

The CDMA2000® 1xRTT mobile phone under test is connected via the RF interface
using either the Universal Digital Radio Communication Tester R&S CMU200, called
herein below CMU200, or the Wideband Radio CommunicationTester R&S CMW500,
called herein below CMW500. This tester simulates a base station for the mobile
phone so that a call can be set up. Tests with wideband EVRC codec (SO68 and
SQO73) are only possible using the CMW500.

The CMU200 must be equipped with the options CMU-B83 v22 (CDMA2000 1xXRTT
Signalling Unit), CMU-B85 v22 (8k/13k QCELP, 8k EVRC, EVRC-B Speech Codec)
and the appropriate software options CMU-K8x for the band used (CMU-K83: 450MHz
bands, -K84: Cellular bands, -K85: PCS bands, -K86: IMT-2000 bands). The firmware
version in the CMU200 must be 3.50 or higher.

The CMW500 must be equipped with the options CMW-B400B (Audio Board), CMU-
B405A (Speech Board), CMW-B200A, CMW-B220A and CMW-PK80.

Acoustic devices such as an artificial mouth, artificial ear and other accessories are
required for the measurements. The following equipment from Briiel & Kjeer or
G.R.A.S. is normally used:

Table 1: Third party acoustic test equipment

Device Description Type (examples)
Telephone test head Device for fixing the DUT in the B&K 4602B
(Only for TIA-1042) prescribed position
Wideband ear simulator IEC 711 type occluded ear B&K 4195 (type 3.2)
(Only for TIA-1042) simulator with adapters for
connection to the ear piece of the
DUT
Artificial mouth Special loudspeaker for simulation | B&K 4227 or G.R.A.S. 44AB or
(Only for TIA-1042) of the mouth 44AA (with power amplifier)
Head and torso simulator Head and torso simulator with B&K 4128D

artificial ear (type 3.3) and artificial
mouth, may be used alternatively
to the abovementioned devices

Second (left) artificial ear for head | Required for handsfree tests and | B&K 4159C (included with 4128D-
and torso simulator adjustment of the background 002)

noise field for “speech quality in
presence of ambient noise”
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Device

Description

Type (examples)

Handset fixture for Head and
Torso simulator

Required to position the handset
on the artificial head, and to apply
a defined force with the earpiece
against the pinna

B&K 4606 (included with 4128D)

Drive amplifier for artificial mouth

Required for delivering the current
into the 5 Ohms load of the
loudspeaker. Should have roughly
0 dB voltage gain.

B&K 2735

Measurement microphone

Ya” measurement microphone with
preamplifier for measurement of
artificial mouth output during
calibration.

B&K 4939 with B&K 2670 or
G.R.A.S. 40BF with G.R.A.S.
26AC

the 4231 calibrator

Acoustic calibrator Sound level calibrator for B&K 4231
calibrating the measuring
microphone

a" Adapter for calibrator For inserting 4" microphones into | B&K DP0775

Microphone power supply

Power supply and preamplifier for
the measuring microphone

B&K 2829, 5935L or 2690A0S2
or G.R.AS. 12AR or 12AA

With the amplifier set to 0 dB, the microphone power supply B&K 2690A0S2 produces
too much noise for measuring idle noise and distortion. It is therefore advisable to set
a gain of 20 dB.

Natural speech signals have a high crest factor (approx. 24 dB peak-to-rms value).
Therefore, the R&S UPV generator cannot deliver enough peak power to drive the
artificial mouth even using the impedance transformer that is supplied along with option
R&S UPV-K9. Thus, it is necessary to connect the artificial mouth via an additional
audio power amplifier. The generator 1 output of the R&S UPV is connected to the
power amplifier input, and the power amplifier output is connected to the artificial
mouth.

Any standard small audio power amplifier can be used for this task. An output power of
only a few watts is sufficient. The most important factor is the long-term stability of the
gain of this amplifier. The voltage gain should be set to about 0 dB and must remain
unchanged after mouth calibration. An amplifier with a means of holding the gain
control steady or at least with a lock knob for the volume control is preferred in order to
avoid any unwanted gain variation.

For use with Digital Radio Communication Tester CMU200, a cable with male
(analyzer) and female (generator) XLR connector is supplied for connection to the
"Speech" connector of the Digital Radio Communication Tester CMUZ200.
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UPV Analyzer Generator

Figure 2-1: Assignment of 9-contact speech connector on CMU front panel

This cable is configured for connection to link handler #1 in the CMU200. Depending
on the CMU200 hardware, link handler #2 in the CMU200 can also be used for
CDMAZ2000, in particular if the CMU200 also supports GSM and/or WCDMA. In this
case, the supplied adapter must be inserted between the cable and the speech
connector on the CMU200.
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NOTICE

If the CMU CODEC calibration fails, the adapter has most likely to be inserted.

The CMU connects pin 1 and 3 of the R&S UPV generator output to the equipment
grounding conductor of the mains. If an external power amplifier is used, care must be
taken that the external power amplifier does not connect R&S UPV generator output
pin 2 to the equipment grounding conductor of the mains. If available, a balanced
connection to the power amplifier should be preferred.

An external power amplifier should be switched on after the R&S UPV-K9y program
has been started, and switched off before the program is ended. This prevents the
artificial mouth from undue power loading by setups which are loaded external to the
application.

An external USB keyboard and a mouse must be connected to the R&S UPV.

NOTICE

R&S UPV-K9y does not support the use of headphones. Do not connect headphones
to the R&S UPV during mobile phone tests. High level signals may be present at the
headphone connector.

The audio analyzer must be equipped as follows:

R&S UPV firmware version 4.0.3.136 or higher

Option R&S UPV-K9 installed

Option R&S UPV-K92 installed.

Testcases according to TIA-1042-A:2013-03 (3GPP2 C.S0056-A v1.0) require
update key R&S UPV-K9201. This update key is automatically delivered with
every new R&S UPV-K92 option. For older installations this update key can be
ordered separately and retro-fitted.

For the testcases “speech quality in sending in the presence of ambient noise”
narrowband and wideband the following additional equipment and options are required:

Table 2: Test equipment from R&S required for speech quality tests in the presence of ambient noise

Description Instrument Type Ordering Number

R&S UPV-K98 Background noise control software | 1424.2003.02
acc. ETSI ES 202 396-1

R&S UPV-K101 Measurements using background | 1424.2203.02
noise acc. ETSI TS 103 106 and
EG 202 396-3
R&S UPP200 Audio Analyzer two channels 1411.1003.02
R&S UPP-B8 Eight-channel generator 1411.2700.02
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Description Instrument Type Ordering Number
R&S® UP-Z8A 8-channel analog cable for 1411.3206.02
R&S UPP-B8

The following equipment not supplied by Rohde & Schwarz is also required:

Table 3: Third party equipment required for speech quality tests in the presence of ambient noise

Device Description Type (examples)

2 Pairs of full-range speakers Frequency response at least Behringer Truth B2031A
100 Hz to 10 kHz

Subwoofer Frequency response at least M-Audio SBX-10
40 Hz to 120 Hz

5 Speaker cables XLR male — XLR female
length approx. 10m

4 Speaker stands The base plane of the speaker
should be adjustable such that the
tweeter of the speaker is at the
same height as the artificial ears
of the head-and-torso simulator.
With the B2031A speakers, the
tweeter is about 31 cm above the
base. With the Bruel & Kjaer
HATS, the entrance of the artificial
ear is about 60 cm above the
base.

2.2 Installing the Software

The application program requires option keys K9 and K92 to be installed. Testcases
according to TIA-1042-A:2013-03 (3GPP2 C.S0056-A v1.0) require option key K9201
to be installed. The keys are installed in the factory in case a new R&S UPV is ordered
together with these options. If the options are ordered separately, the keys as well as
the installation manual are part of the delivery.

For details on the software installation, please see the release note. Please follow the
described installation procedure accurately.

To have full control over minimized windows, it is recommended to set the windows
taskbar to “Auto-hide”, on top of other windows. Right-click on the Windows Start
button and click “properties”.
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Fig. 1  Context menu for taskbar

In the properties window, click tab “Taskbar” and activate “Auto-hide the taskbar” and
“Keep the taskbar on top of other windows”. Click “Apply” and close the window.

Taskbar and Start Menu Properties

Fig. 2  Properties window for taskbar

2.3 Test Setup

In the setups using the input switcher, each device type (e.g. free field microphone,
right artificial ear, left artificial ear, decoder output) is always assigned to the same
switcher input. Therefore connections which are not required for a specific setup do not



have to be removed. The schematics below, however, show only the connections
required for the specific setup.

RF to Mobile
\
\
|
‘ N —————— o
| e S
. | gu' :ﬂ Microphone
-l cofaTe o) Power
. | WPV e sl

Figure 2-2: Test setup and connection of external components with R&S CMU200

RF to Mobile

Microphone
Power
Supply

Figure 2-3: Test setup and connection of external components with R&S CMW500
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Figure 2-4: Test setup and connection of external components with input switcher R&S UPZ and
R&S CMU200
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Figure 2-5: Test setup and connection of external components with input switcher R&S UPZ and
R&S CMW500
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Figure 2-6: Test setup and connection of external components for the adjustment of the background
noise field
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Figure 2-7: Test setup and connection of external components with input switcher R&S UPZ for the
adjustment of the background noise field
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Figure 2-8: Test setup and connection of external components with CMU200 for measurements with
background noise field
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Figure 2-9: Test setup and connection of external components with R&S CMW500 for measurements
with background noise field
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Microphone FF . )
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Figure 2-10: Test setup and connection of external components with CMU200 and input switcher UPZ
for measurements with background noise field
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TRIGGER

TRIGGER OUT

Figure 2-11: Test setup and connection of external components with R&S CMW500 and input
switcher R&S UPZ for measurements with background noise field

2.4 Starting the Application Software

After installation, the program can be started by double-clicking the Icon "UPV-K9y
Mobile Phone Tests" or by clicking "R&S UPV Applications - UPV-K9y Mobile Phone
Tests" in the "Programs" menu.

At the first start after an update from a previous version, a query window appears:
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Mewer ¥ersion Detected

Ipdate files [zalibrations, sequences and zetup file are not touched]?
Cancel | Yes I
Y

Figure 2-12: Query window after update from previous version

Click “Yes”. All files in D:\Phone except for sequence subdirectories and user data like
results and calibration files are updated.

At the fist start of the program, selection windows appear for the standard according to
which the measurements should be made, and for the artificial ear and artificial mouth
used.

@ Standard [_ [

Fleaze zelect a standard below:

T14-1042-4-2013 Handzet Marrow j

[T Allow only selected measurements

[ Do not show this dialog again

Cancel | Ok I w

o

Figure 2-13: Query window for selection of applied standard

If "No Standard" is selected in the standard selection window, all measurements
appear in the "Measurement" menu. If a "standard" is selected, all measurements
appear in the "Measurement" menu, but compliant measurements are checked. If
"Allow only standard measurements" is checked, non-compliant measurements are
suppressed in the Measurement menu.

"TIA-1042:2005" comprises sending and receiving tests (frequency response and
loudness rating) for CDMA2000 and AMPS, weighted terminal coupling loss and the
maximum acoustic pressure test from annex B. "TIA-1042:2005 and Auxiliaries"
comprises in addition sidetone masking rating, sending and receiving distortion and
idle channel noise tests according to 3GPP standard. These tests are not specified in
TIA-1042 and offered for information only.

"TIA-1042-A-2013 Handset Narrow" and "TIA-1042-A-2013 Handset Wide" offer all
testcases according to the updated standard for narrowband and wideband
connections, respectively. "TIA-1042-A-2013 Handset Narrow and Auxiliaries" and
"TIA-1042-A-2013 Handset Wide and Auxiliaries" provide additional testcases
according to 3GPP TS 26.132 Release 11.

While 3GPP2 C.S0056-A and TIA-1042-A-2013 do not specify testcases for handsfree
devices, the present software provides tests for handheld handsfree, desktop
handsfree and vehicle-mounted handsfree devices according to 3GPP TS 26.132
Release 11 in "Standards CDMA2k HHHF Narrow", "CDMA2k HHHF Wide", "CDMA2k
DTHF and VMHF Narrow" and "CDMA2k DTHF and VMHF Wide".
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Select Ear Simulator

Type 1

Type 3.2 Low Leak

Type 3.2 High Leak

Tvpe 3.3

Tvpe 3.4

Electic connection

[nduction coil

[~ Do net zhow this dislog again

Cancel | 0k I
A

Figure 2-14: Query window for selection of artificial ear

Select mouth type

Thiz dialog zelects the artificial
mauth far handzet and headzet
meazurements.

LRGFITU-T P.51

HATS ITU-T P.58

Generic speak.er

Electric connection

Far all hands free measurements
the handz free zettings apply.

[ Do rnaot show thiz dialog again

Cancel Ok |
A

Figure 2-15: Query window for selection of artificial mouth
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Preparation and Start of the Application Software
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Figure 2-16: Query window for selection of system simulator

When the checkbox "Do not show this dialog again” is checked, the corresponding

selection window will not appear at the program start in future. However, the selection
is still available in the "Option"s menu (see below). After the last of the three selection
windows has been closed, the main window of the R&S UPV-K9 opens.

@UPV—KQV cdmaz000{R )} Mobile Phone Tests {D:'\Phone'Results.xml)

File Data Calbration Measurement Standards Config, Meas, Sequence Report  Options

Help

Testresults overview

Select | Date and time: | Measurement title | Test object ‘Veldi | Main Result =
|| [T Dzeve0is130E32 3GPPZ Sending Handset Narowband LE 2 P53 Sending Loudness Rating
| | [T D2/2ve015130734 3GPPZ Weighted Temminal Coupling Loss, NB- LIE 2 PASS EcholLoss =498 dB
|| [T o2eve0151303:33 3GPPZ ldle Channel Noise Sending MB LE 2 PASS Idle Channel Naise Sendir
| | [T 0272015131008 IGPP2 STMR NB. Mominal Valume Setting UE 2 FalL  Sidetone Masking Rating
| [ 0227015131108 IGPP2 Talker Sidetone Delay UE 2 P&SS [rull]
| [T nzersemsizies JGPPE Receiving Handset MB. nom. Yol UE 2 FAIL  ALR =-10.7 dBt
| [ oere0s1312:29 IGFP2 Idle channel noise receiving, max, vol.  UE 2 FaIL  Idle Channel Noise Recei
| [ 02/27/20151312:47 IGPP2 Sending Handset Narowband UE 2 PASS Sending Loudness Rating
| [T 0227201513133 IGPP2 Weighted Temminal Coupling Loss, NBE LE 2 PASS Echoloss =451 dB
| [T oze7s05131432 3IGPP2 Idle Channel Moise Sending MB LE 2 FAIL  Idle Channel Maoise Sendir
| [T 0227/20151314:47 IGPP2 STMA ME. Mominal Yalume 5 etting UE 2 FaIL  Sidetone Masking Rating
|| T mzvems1aEen 3GPP2 Talker Sidetone Delay UE 2 PASS  [rull) i
|| [T ovems14349 3GPPZ Receiving Handset NB, nom. Yal UE 2 FAIL  RALR =-356dB
I [T 02/27/2015 14:35:33 3GPP2 Idle channel noise receiving, max. vol.  UE 2 PASS Idle Channel Moise Recei
R [T 02/27/2015 14:35:52 3GPP2 Sending Handset Marowband UE 2 FAIL  Sending Loudness Rating
I [T 02/27/2015 14:36:51 3GPP2 “Weighted Terminal Coupling Loss, NB LUE 2 PASS EchoLoss =92.2 dB
R [T 02/27/201514:37.53 3GPP2 |dle Channel Moise Sending MB UE 2 PASS Idle Channel Maoise Sendir
I [T 02/27/2015 14:38:08 3GPP2 STMA MB, Mominal Yalume Setting LE 2 FAIL  Sidetone Masking Rating
|| [ Ozeve0151433:09 3GPP2 Talker Sidetone Delay UEZ FAIL  [rull)
|| [ bzezve015 150001 3GPPZ Receiving Handset MB, nom. Yal LUE 2 FAlL  RALR =-356dB
| [T 02/27/20151501:05 3GPP2 Idle channel noise receiving, max. vol.  UE 2 P45S Idle Channel Noize Receiy
[ 2R L P 3GPPZ Sending Handset Narowband LUE 2 Fall  Sending Loudness Rating
|| [ oeveoisim0za 3GPPZ Weighted Terminal Coupling Loss, NE LE 2 P45S Echo Loss = 92.2 dBt
|| [T erenis1m03s 3GPPZ Idle Channel Noise Sending MB LUE 2 P4SS  Idle Channel Noise Sendir
|| [T ozeve01s1m0310 3GPPZ Receiving Handset MB, nom. Yol LE 2 Fall RALR =-356dB
I [T 0227015151014 3GPP2 Idle channel noise receiving, max. vol UE 2 P455 Idle Channel Noize Receiy

T neeeremeaRIna? AEPP? Sendinn Handset Marmishand LIF 2 Fall  Sendinn | nndness Fatinn 2
< o
|TIA71 042-4-2013 Handset P|E\ectric cohnection replacwr| ‘ UE 2 |
| Report lagt | | Report last | | Esit |
meaguiament sEqUEnce

M

Figure 2-17: Main window

Initially the data grid in the center of the screen which shows the result overview is

empty. The screenshot in Figure 2-17: Main window shows an example after a number
of measurements have been made.
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Operating Concept

Operating Concept

R&S mobile phone tests consist of at least two components. R&S UPV-K9 provides the
main user interface window, general settings, calibration routines, data handling,
automatic sequencing and reporting tools.

Separate options for different standards (R&S UPV-K92 for CDMA2000 tests) provide
test macros for basic measurement types defined in the standards. Each measurement
type provides a set of parameters (R&S UPV setup files, limits etc.) which are defined
in separated measurement definition files, one for each test case.

Options (General settings)

The "Options” menu in the main window allows to change a set of general settings like
ear type and mouth type used which are valid for all or at least a plurality of the tests.

Standard
"Standard" allows to select one of the available standards. Measurements belonging to
this standard will be checked in the measurement menu. "If Allow only standard

measurements"” is checked, it is not possible to start single measurements which do
not belong to the standard.

Select Standard at startup

If "Select standard at startup” is checked, the selection window for the standard is
opened at each start of the program.

Ear Simulator
"Ear simulator" allows to select the type of ear simulator used for handset and headset

tests. For details on the handling of calibration data see section Calibration on
page 38.

Select ear simulator at startup

If "Select ear simulator at startup” is checked, the selection window for the ear
simulator is opened at each start of the program.

Artificial mouth

"Artificial mouth" allows to select the type of artificial mouth used for handset and
headset tests. For details on the handling of calibration data see section Calibration on
page 38.
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3.1.6 Select artificial mouth at startup

If "Select artificial mouth at startup” is checked, the selection window for the artificial
mouth is opened at each start of the program.

3.1.7 System simulator

"System simulator” allows to select the type of system simulator used. For details on
the handling of calibration data see section Calibration on page 38.

3.1.8 Select system simulator at startup

If "Select system simulator at startup” is checked, the selection window for the system
simulator is opened at each start of the program.

3.1.9 Hands free settings

"Hands free settings" allows selecting the acoustic instruments used for hands free
testing. It is possible to use an ITU-T P.51 artificial mouth together with a free field
microphone, a HATS with one atrtificial ear or a HATS with two artificial ears. If two
artificial ears are used, the decoder has to be disconnected from analyzer input 2 and
the second artificial ear has to be connected to it for receiving measurements. Do not
forget to re-connect the decoder for any measurement in sending direction.
Alternatively a R&S UPZ input switcher can be used for automatic connection of the
sound sources to the R&S UPV analyzer inputs.

3.1.10 Activation signal for distortion tests

In the sub-menu to "Activation signal for distortion tests", signals can be imported to
the test system. If more than one imported signal is available, it is possible to choose
one of them for actual use.
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Import Activation Signal

Browse to an appropriate wave file.

The file muzt be recorded in mono with 48 kHz
zample rate.

I aximum permizsible length is 10 seconds.

File Marne Browse

ID AUPYSUsershalel 1 48kHz way

Sample Rate I 43000 Hz

| hohn ) Steren

Diuration I 2596 Seconds
Everage Level I 2113 dBFS
Active Level I 1973 dBFS

W Equalize for 5elected Atificial bouth

™ Immediately select thiz activation signal

Cancel Ok |
Y

Figure 3-1: Window for import of activation signals

Use the "Browse" button to select a wave file which fulfills the conditions shown on top
of the window. The selected signal is analyzed and checked for appropriateness. Note
that a high crest factor of the signal may overdrive the codec or artificial mouth. If
"Equalize for Selected Artificial Mouth" is activated, the file is immediately equalized for
the selected artificial mouth when the "Ok" button is clicked. Otherwise or when the
mouth calibration has been re-done or a different artificial mouth has been selected in
the meantime, the signal is equalized automatically immediately before the sending
distortion test starts.

If "Immediately select this activation signal” is checked, the signal is selected for use
when the "OKk" button is clicked.

Show Operator Instructions

If "Show operator instructions" is checked, instructions to the operator are displayed in
a window before the measurement starts. The operator may be prompted to position
the mobile in a defined way or to set the volume to a certain setting.
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3.1.12 Auxiliary delay measurements

For the alignment of the acquisition with the arrival of the test signal at the analyzer
input, an auxiliary end-to-end delay measurement is performed before the main
measurement. The item "Auxiliary delay measurements — Configure" allows to select
the measurement method (sine burst or cross correlation), the test signal for the cross
correlation method (composite source signal or real speech word “five”) and the re-use
of a delay value which has been measured for the same device under test on the same
path for a previous test. A maximum age has to be specified for the use of existing
delay values to avoid the use of outdated values.

Auxiliary Delay Measurement

Meazurement method
IEru:uss-u:u:urreIatiu:un j
Crozz-Correlation Test Signal
IHeaI zpeech, word Mfive" j

¥ Fe-use existing delay value
b axirmum age of exizting value

OO = =zeconds

Cancel | Ok I

4

Figure 3-2: Window for configuration of auxiliary delay measurements

The recommended method for auxiliary delay measurement is cross-correlation using
the real speech word “five” as test signal. Re-use of existing delay results speeds up
the tests, which is particularly helpful in automatic test sequences. It avoids changing
of the test setup when uplink and downlink delay values are required for echo loss and
stability loss tests.

However, if changes are done in the setup which could have an influence on the end-
to-end delay, like changing the device under test, the codec or codec rate etc, the
auxiliary delay measurement has to be re-run. If a different device under test is
selected in menu item "Data — Test object — Select ...", the memorized auxiliary
delay values are automatically invalidated. In all other cases the operator has to
invalidate them using menu item "Auxiliary delay measurements — Invalidate all
existing values".

3.1.13 R&S CMU remote control

If it is intended to remote control a R&S CMU200 from a sequence of this program,
menu item "CMU remote control" can be used to select the communication interface
(GPIB or RS-232) and, if multiple devices are found, to select one of them.
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CMMU
— MU Remate Control
0ff viaGPE | viaFs232 |
—GFIE
Dieas [GPIB0:19: FiohdelS chwarz ChiL 200-1100.0008.02.1 DB662/V5.1 3 =]
—R5-232
COM Interfacz [COMB: FiohdedSchwarz,CMU 200-1100.0008.02,1 DB662,V5.13 =]

Cancel | Ok I
5

e

Figure 3-3: Window for configuring the R&S CMU remote control

For remote control via RS-232, an external USB-to-serial converter has to be
connected and installed. For remote control via GPIB, the R&S VISA has to be
installed. The installer for the R&S VISA is distributed with the Option R&S UPV-K92.
For details of the remote control see section Automatic Test Sequences on page 143
and the operation manuals of the R&S CMUZ200.

R&S CMU subsystem

In "CMU subsystem", one of the communication standards can be selected. This
allows sequences to be run in different communication standards without changing the
subsystem in every single CMU control instance in the sequence.

R&S CMW Remote Control

For roundtrip delay measurements using the wideband radiocommunication tester
R&S CMW500 as system simulator, the R&S CMW500 has to be remote controlled
from the R&S UPV-K9 program. Available remote control interfaces are TCP/IP (LAN),
GPIB and USB. The item “CMW Remote Control” in the options menu allows selecting
the device and the interface to be used. For TCP/IP connections, enter the device
name ("CMW50050-", followed by the serial number) or the current IP address of the
R&S CMW500. For GPIB connection use the connector labelled “IEEE 488 CH1” on
the backplane of the R&S CMW500.

Noise Calibration Configuration

In "Noise Calibration Configuration" parameters for the background noise field used for
the "Speech Quality in Presence of Ambient Noise" test can be set.

The configuration of the noise field calibration comprises

1. Choice of the calibration method
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2. Speaker configuration and setup
3. Bandwidth and tolerance settings
4. Switcher usage

5.  Other settings.

It is done in the "Noise Calibration Configuration" window. This window is opened with

item "Noise calibration configuration” in the "Options" menu. The figure below shows
the default settings. If any item has been changed then user can retain the default
settings by selecting the button "Set to default”.

Moise Calibration Configuration [=[= =S
Murnber of fulliange speakers pairs ’El Madify speaker delay 3
Murnber of subwonofers ’G Additional delay FL 000 3: ms
Subwonfer connected to UPP Channel 7= Additional delay RL 1700 me
b airnum output lewvel 13.78 =1 4pv Additional delay FR 11.00 3: s
E ar equalization D . Additional delay RR 23.00 3: 8
Bandlimit low A0.00 =T 12 Man iterations during equalization ,E
Bandlimit high 2000000 = Hz Use Pink Noize for all equalizations [
Flatness start at 50.00 “ Hz Ambiance used for equalization |WOIK_N0\SE_DffiCe_Ca"CEntEl J
Flatness end at 1000000 =5 Hz Pirk Noise level £5.00 3: dBsplia]
Crossover Frequency 120,00 = 4, Pink Moise duration 30,00 3: N
Flatness width B = Pink Noise filename [PirkNoise1 BBit! 20sFikered wav -
Min distance HATS to speaker 150 3: - Final test of all ambiances 2
Max distance HATS to speaker 250 3: G lghore uncritical level warnings v
Wan level deviation ] =1 4p Actian on final flatness deviation Prampt -
Max THD 20,00 = & Use All speaker Equalization =
Min Sound Pressure Level BI00 = despl Al 5peakers Post Equalization [Fast frecommended by RaS) =]
Use Input Switcher UPZ 2 Report intermediate steps r
Set to default Cancel
P

Figure 3-4: Noise Calibration Configuration Window, Default state

The configuration is saved in the settings of the R&S UPV-K9y program, so that any
modification will be effective and re-used as long as the speaker configuration and
calibration methods do not need to be changed.

Choice of calibration method

Three different calibration methods are available which differ in time consumption and

accuracy:

Pink Noise Equalization (recommended by Rohde & Schwarz) equalizes speaker and
room with an uncorrelated, non-periodical Pink Noise signal and uses this equalization
for all ambiances. It offers the best compromise between calibration time and
accuracy. After room equalization with the pink noise signal only an individual level
correction has to be done for each ambiance.
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Usze Pink Noize for all equalizations [

Ambiance used for egualization |W|:|rk_N oize_Office_Callcenter J

Pink Moize level £5.00 3: B =pl[)
Pink. Moize duration 30.00 El: 3

Pink. Moize filename |F'inkN aize1 BBt 20zFiltered. veaw

Figure 3-5: Configuration Window, calibration method Pink Noise

Although it is not recommended to change the default settings, a user can select level
and duration of the Pink Noise. Specifying a longer duration results in longer calibration
time but might increase the accuracy especially at low frequencies. Instead of using
the recommended WAV file the user could provide an own noise file.

Shared equalization with one ambiance (recommended by ETSI ES 202 396)
equalizes speaker and room with one of the ambiances and uses this equalization for
all other ambiances, too. Because the real ambiances do not contain the same energy
in each frequency band, the equalization is optimal only for the selected ambiance.

Usze Pink Maise for all equalizations [

Ambiance uged for equalization oiork Noiee Office Calloenter

Pink. Moise level All Ambiences -
Pub_Moize W2

Pirk Moize duration Dutzide_Traffic_FRoad

Dutzide_Traffic_Crogsroads

Train_Station
Fullzize_Car1_130Kmh

Final tezt of all ambiances Cafeteria_Maoize
Menza ks

m

Pink. Moize filename

Figure 3-6: Configuration Window, calibration method shared ambience

This method takes the same calibration time as Pink Noise but normally offers worse
accuracy. After room equalization, the individual level correction has to be done for
each ambiance.

Individual equalization of each ambiance results in best equalization accuracy but
makes the calibration process more than 3 times longer (about 8 hours). It could be
considered if the room and speaker setup will never be changed.

Use Pink Moise for all equalizations [

Ambiance uzed for egualization Al Ambiences j

Pink Moize level ER.00 El dBspli)
Pink. Moize duration 3000 El T

Fink Maize filename |F'inkN oize] BBt 20:zFiltered waw

Figure 3-7: Configuration Window, calibration method individual ambiance
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3.1.16.2 Speaker configuration and setup

Currently two different speaker configurations are allowed for background noise
generation:

Murber of fullrange speakers pairs IE

Humber of subwoofers IEl

Subwoofer connected to UPP Channel E

Figure 3-8: Configuration Window, speaker configuration

4 full range speakers (2 pairs) with 1 subwoofer or 4 full range speakers without
subwoofer. A subwoofer must be used if the full range speakers do not pass
frequencies down to 50 Hz. The full range speakers are connected to R&S UPP
channel 3...6. The optional subwoofer is connected to channel 7. R&S UPP channel 10
is reserved for connection to R&S UPV output.

If a subwoofer is used, the crossover frequency between full range speakers and
subwoofer can be adjusted:

Crozsover Frequency 120.00 3: Hz

Figure 3-9: Configuration Window, speaker crossover frequency

To avoid overdriving maximum input voltage of the speakers (or amplifiers), the
operator can adjust the R&S UPP maximum (RMS) output level:

b astirnum output level 1378 =~ dBv

Figure 3-10: Configuration Window, speaker maximal output level

At the beginning of the calibration process, checks for each speaker are performed to
achieve a minimum sound preasure level and to detect speaker overdrive by
measuring THD. The operator is instructed to increase the speaker (or amplifier) gain if
the required sound level could not be reached. The required sound pressure level can
be set in the range from 80 to 99 dBspl:

Min Sound Pressure Lewvel an a0 El: dBspl

Figure 3-11: Configuration Window, speaker Min Sound Pressure Level

For speakers that generate higher harmonic distortion than 10% (-20 dB), the tolerable
THD can be increased (to e.g. -10 dB):

kax THD 2000 3: 48

Figure 3-12: Configuration Window, speaker Max THD

To detect left/right speaker connection faults, the calibration process needs to know
the rough speaker-to-microphone distances. If the test room is much larger or smaller
than the recommended size, the operator has to adjust the minimum or maximum
speaker distance:
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Min distance HATS to speaker 150 El: m
Max diztance HATS to speaker 28] 3: m

Figure 3-13: Configuration Window, expected HATS to speaker distance

Bandwidth and tolerance settings

The bandlimits specify the frequency range where the equalization will be performed.
B andlirmit low 40.00 1 Hz
B andlimit high 20000.00 = Hz

Figure 3-14: Configuration Window, Bandlimit

The low value additionally enables a highpass filter. To include the lowest third octave
(50 Hz), the lower bandlimit should be lower or equal to a half third octave (f / 1.122)
below. To exclude the 40 Hz third octave from equalization, the bandlimit low should
be set to 44.5 Hz

Flatness check is limited to the frequency range between start and end.
Flatheszs start at 50.00 ! Hz
Flatheszz end at 1000000 = Hs

Figure 3-15: Configuration Window, Flatness range

According to ETSI ES 202 396 the equalization must be flat to +/-3 dB, thus the
flatness width must not be greater than 6 dB.

Flatrness width E.00 El: de

Figure 3-16: Configuration Window, Flatness width

To achieve an even better flatness this value might be reduced by 1 or 2 dB, if room
and speaker setup are able to fulfil such narrow flatness.

Switcher Usage

To reduce user interaction during calibration and measurement an R&S Input switcher
R&S UPZ can be used. This allows hard wired connection to be established between
each signal source and the R&S UPZ while the calibration process automatically
switches the required R&S UPZ input channels to R&S UPV input

Ise Input Switcher UPZ v

Figure 3-17: Configuration Window, Use Input Switcher R&S UPZ

Other settings

All other configuration settings normally need not to be changed. User should modify
these settings only to change the default behaviour of the calibration.
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Ear equalization W -
B andlimit lovs DF

FF
B andlimit high

Figure 3-18: Configuration Window, Ear equalization
Instead of using ID ear equalization (Independent of Direction), "free field (FF)" or
"diffuse field (DF)" ear equalization can be selected.

Modify speaker delay r

Additional delay FL o0 = ms
#dditional delay RL Hro = ms
Additional delay FR H1m = ms
Additional delay RR 2900 = ms

Figure 3-19: Configuration Window, Modify speaker delay

To avoid coherent superposition of sound from two speakers reproducing the same
signal, the determined speaker delay is individually increased. Only experienced users
should modify these settings to fix acoustical problems!

Max iterations during equalization IE

Figure 3-20: Configuration Window, Max iterations during equalization

To achieve flat frequency response, several iterations of equalization are performed for
single and pair of speakers. Iteration is terminated if flatness is better than 1 dB or
"Max iterations during equalization” is reached. This value can be selected between 1
(no iteration) and 5.

Action on final flatness deviation Frompt =

- Frompt
I1ze Al zpeaker Equalization Retry once
vam - - . Retry bwice

Figure 3-21: Configuration Window, Action on final flatness deviation

This item specifies how the calibration process should behave if — after all iteration
steps — the flatness deviation is higher than "Flatness width". By default it would
prompt the operator how to proceed (retry, ignore or abort). To avoid this interruption of
calibration process, the operator can predefine if (and how often) the measurement
should be retried.

Faw level deviation 0.20 El: dE

Figure 3-22: Configuration Window, Max level deviation

During level adjustment the sound pressure level of each speaker is iterated to the
requested value. This iteration terminates if the level deviation is below the selected
"Max level deviation". To achieve higher level accuracy this value can be decreased;
however, this might increase the count of iteration steps and total calibration time.
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Ignore uncritical level warnings [v

Figure 3-23: Configuration Window, Ignore uncritical warnings

To avoid interruption of calibration process, by default only errors are reported to user.
Warnings about uncritical deviations (e.g. noise floor, flatness of unequalised room,
level deviation during single speaker adjustment) are suppressed, but entered in
report.

To get uncritical warning as soon as they appear, this tick box has to be deactivated.

Ilze All speaker Equalization v

Al Speakers Post Equalization azt [recommended by
accaording to ES 202 396-1

Repart intermediate steps

Fast [recommended by R&S]

Figure 3-24: Configuration Window, Use All speaker Equalization

If the sound super positioning of all speakers degrades the flatness to more than 6 dB
(or the selected "flatness width™) a post equalization process should be used to
improve this flatness. Otherwise the calibration would fail!

Instead of using the R&S recommended algorithm, the post equalization can be done
according to ES 202 396-1.

Final test of all ambiances v

Figure 3-25: Configuration Window, Final test of all ambiances

After successful calibration a final level and equalization test of all ambiances should
be performed. Additionally this test adjusts the total level setting to minimum deviation.

Disabling this test reduces the total calibration time.

The final test of successfully calibrated noise field (but without level optimization) can
be performed separately from the calibration process by executing the calibration and
skipping all calibration steps.

Report intermediate steps -

Figure 3-26: Configuration Window, report intermediate steps

In case of problems during the calibration process the operator can activate a detailed
reporting that logs all intermediate steps.

Selecting "Report intermediate steps" does not increase total calibration time but the
number of pages in the report.

R&S UPP Remote Control

This dialog allows to detect and connect a R&S UPP with option R&S UPP-B8 on the
LAN, to be used as playback system for the background noise generation.
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upPp

TCRAP
’7UPP hiost hame or I[P address |

find devices... | I j Cancel | Ok I

Figure 3-27: Window for connecting to a R&S UPP on the LAN

A click on the "find devices..." button searches the local area network for audio
analyzers and fills the combobox next to the button with the computer names and IP
addresses of the found devices. Select the appropriate instrument in the combobox
and click "Ok".

To establish a remote control connection between R&S UPV and R&S UPP do the
following:

1. Once the LAN LED on the R&S UPP is on, press button "CASCADE / LAN
RESET" once and wait until the "CASCADE LED" is blinking.

2. Pressthe "CASCADE / LAN RESET" button again.

3. Click the "Find" button in the R&S UPP remote control window on the
R&S UPV.

4. Now the computer name on the R&S UPP appears in the R&S UPP remote
control window. Select it and close the window with "Ok".

3.1.18 Input Switcher

"Input Switcher" allows configuring the use of an R&S UPZ input switcher connected to
the R&S UPV RS-232 port, to switch analyzer input 2 between sending tests and
binaural receiving tests.

Switcher Settings

Usze UPZ input switcher to connect second artificial
™ &ar for binaural measurements and calibration
[Analpzer [nput 2]

Use UFZ input switcher far all connections
[&nalyzer Inputs 1 and 2]

Output A | Output B

Decoder output connected to UPZ input no. I 33:

"UF'Z output connected ta analyzer input 2

2nd artificial ear connected to UFZ input no. I 1 3:

Cancel | Ok I

A

Figure 3-28: Switcher window

If only the first tick box is activated, the switcher is only used to switch the second
analyser input between decoder output and second artificial ear. In this case the
channel assignments in the "Switcher Settings" window are applied.
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If the second tick box is activated, the switcher is used for all signal sources and both
R&S UPV analyser inputs.

The following table shows the assignment of the signal sources to the switcher
channels when the second tick box is activated.

Table 4: Input switcher channel assignment

Channel |Signal Source

1 Second (left) artificial ear

2 First (right) artificial ear

3 Decoder output

4 Free field microphone

5 Diffuse field microphone

6 R&S UPP-B8 output channel 10

Connect switcher output A to R&S UPV analyser input 1 and switcher output B to
R&S UPV analyser input 2.

3.1.19 Report settings

"Report settings" allows defining the type of information which should appear in the
reports. For details on reporting, see section Automatic Test Sequences on page 143.

3.1.20 Generate temporary export files

If "Generate temporary export files" is checked, some of the measurement macros
create result.exp With result value and verdict, and, if applicable, curve.exp or
abscurve.exp and relcurve.exp files with curve data in ASCII format. This
function is provided for compatibility with R&S UPL-B9.

3.1.21 Generate temporary image files

Item "Generate temporary image files" causes the measurement macros to store a
screenshot of the measurement window after completion of the test to a file
Image.TIF for use by a remote controlling host.

3.1.22 Store results of further measurements

If "Store results of further measurements" is checked, curves and calculated values like
loudness ratings are also stored for additional measurements started with the "Add
Measurement" key. They will appear in reports of the respective measurements.
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3.1.23 Do not change scale for further meas.

Menu item "Do not change scale for further meas." deactivates the automatic Y-axis
scaling if the curve of an additional measurement leaves the plot area partially or
totally.

3.1.24 Store loaded curve data to results
If "Store loaded curve data to results” is checked, curves loaded from file with the

"Load Curve" softkey are stored to the results database and will appear in reports of
the respective measurements.

3.1.25 Enable remote control

Menu item "Enable remote control" activates the interface of the program for remote
control using the client ControlK9.exe.
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4 Calibration

4.1 Calibration Devices

R&S UPV-K9 allows to simultaneously storing calibration values for multiple individuals
of the same type. This allows switching devices without the requirement for re-
calibration. However, regular re-calibration is recommended in order to assure the
correct function of the used devices.

@UPH‘—KQ:{ cdmaZ000{R) Mobile Phone Tests {[:'Phone'Res

File DatalCaIihratiun Measurement  Standards  Config, Meas, ¢

Sale Microphone 2

[~ Artifical Ear P Lndset N
I— DR.P ko ERP correction b T erminal
r Free field equalization ¢ el Moize
r Diffuse Field equalization 4 Momina
r 1D (Independent of Direction) Equalization  * Ltone De
[ Atificial Mouth Mgk
r Artificial Mouth (Hands Free) r | i

el hoize |
r Codec g andset M
r Induction coil Terminal
I— Electric connections ' el Naoise
r cdmaz2000 ref. spectrum ¢ Homina
r irﬁgﬁl ST E[FEEERIE, ST : etone De
II: Background naoise Figld » :a:;z:t|
r Mew Device anidzet M
r Select Device Terminal
r Delete Device el Moize
r Show all walues Marmina
r Show selected devices bhane De
_— S

Figure 4-1: Calibration menu

For every device to be calibrated, an entry must be created using "Calibration - New
device" in the main menu. This menu item opens an entry window to specify the
calibrated device. A category of device must be chosen from the combo box on top.
Type, manufacturer and serial number are entered into the text boxes below. The
entries are confirmed by clicking on the "Save and close" button.
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@) Calibrated Device -0 x|

|lzage

| =]
Type

b anufacturer

Serial Hurmber

Cancel | | Save and cloze ,I*ﬁ

Figure 4-2: Input window for information about calibrated device

Before a device can be calibrated or used, it must be selected with "Calibration 2>
Select device" in the main menu. Clicking on this item opens a window with a table of
all entered devices.

Select Calibrated Devices

o | Manutacturer | Type | SeriglMo. | Date and Time | Calib. value | File name = |
(LB} mbient noise field Default 08/29/2007 17:21 [rul] D:43GPPACa
| |Decodsr Default 07/13/2006 17:50 [} D:43GPPACa
| |Diffuse field microphone Default 07/13/2008 17.57 [rull] D:AIGPPACa
| |Electric connection replacing decoder Default 07/13/2006 17:54 [rull] D:\3GPPAC
| |Electic connection replacing ear Default 1041172007 11:36 [ruall) D:4\3GPPACa
| |Electric connection replacing encoder Default 0741372006 17.54 [rwall) D:%3GPP\Ca
| |Electric connection replacing mouth Default 07/13/2008 17.51 [rull] D:W3GPPACa
| |Encoder Default 07/13/2006 17.51 [rl) D:43GPPACa
| |Fres field microphone Default 06/07/2006 15:50 [rull] D:\3GPPAYC
| |Generic speaker Default 0741372006 16:33 [rull) D:53GPPACa
| |HATSITU-T P52 Art. Maouth Default 0E/07/2006 15:47 [rul] D:43GPPACa
| |HATS Type 3.3 41 Ear Default 0E/07/2008 15:52 [} D:43GPPACa
| |HATS Type 3.4 At Ear Default 0E/07/2006 15:54 [rl) D:43GPPACa
| |Induction coil (input) Default 07/13/2006 18:04 [rull] D:\3GPPAC
| |Input digital Default OB/07/2006 15:43 [rwall) D:%3GPPACa
| |LRGPITU-T P.51 Art. Mouth Default 07/13/2006 17.59 [rul) D:43GPPACa
|| Output digital Default 0E/07/2006 15:50 [} D:43GPPACa
| |Second Type 3.3 At Ear Default 07/11/2007 15:09 [rull] D:43GPPACa |
| |Second Type 34 At Ear Default 07/11/2007 15:09 [rull] D:\3GPPACa
| |Twpe 1A Ear Default 06/07/2006 15:51 (] D:43GPPACa
i Twoe 3.2 Hioh Leak &t Ear Default 0E/07 /2008 15:51 Tl | D436 F'F'ﬁﬂ
|Se\ect uzage type first! j SElect Cancel | Ok I

Figure 4-3: Window for selection of calibrated devices

In the combo box lower left, a category of devices must be selected. Subsequently the
table is reduced to available devices in this category. At first startup, there is only a
"Default” device for each category, but when more devices have been created with the
"New device" function, a choice will be available in this view. In this state a row in the
table can be marked with a mouse click on its left end. A mouse click on the button
"Select" selects this device for the associated usage.
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Usage | Manutacturer | Type | SeiiglMo. | Date and Time | Calib. walue | File name

Type 3.2 Low Leak Ar.Ear B&K 495 1708754 04/22/2009 14:25 [l D:43GPPACAE3:
Type 3.2 Low Leak Art.Ear Default 07/13/2006 17.57 [rull] D:W3GPPYCAl33)
Type 3.2 Low Leak &rt.Ear G.R.A.5. FA005E & RA 26740 & 4636 04/22/2009 14:27 [rll) D:43GPPACAE3

IType 3.2 lows leak, art, ear j Select Cancel | Ok I

Figure 4-4: Selection window for particular device type

Subsequently this procedure may be repeated for other categories. Finally all
selections are confirmed by clicking the "Ok" button.

All calibration data are stored on the R&S UPV hard disk and are therefore
automatically available again after every restart. The calibration values for the
R&S UPV-K9 option are stored independently of other options.

All calibration routines below require as pre-requisite that a device for the respective
usage has been generated and selected.

To simplify the procedure for the case that it is not intended to use multiple devices of
the same category or to include information about the used devices into a report, there
is a "Default" device selected for each device type or category after the first start of the
program.

An overview all selected calibration devices together with the calibration values is
given under the menu item "Calibration > Show selected devices".

4.2 Microphone Calibration

1. Insert the measuring microphone fully into the adapter of the sound level calibrator

After inserting the microphone, wait about 10 s to allow for static pressure
equalization.

and switch on the calibrator.

Call the test routine with "Calibration > Microphone > Free field or Calibration »>
Microphone - Diffuse field" from the main menu, depending on the microphone.
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4.3

4.3.1

Calibration

Microphone calibration

Connect microphone to analyzer input 1.
Insert microphone into calibrator using
adapter UCO210 and switch on calibrator.

[T Calibration level increaszed by 20 dB [not validated)

[ Delay start by I EIE: zeconds

Cancel | ] 3

Figure 4-5: Initial window of microphone calibration

For calibrators providing a sound pressure level of 114 dB (10 Pa), the checkbox
"Calibration level increased by 20 dB" must be checked. In all other cases the
checkbox must remain unchecked!

The output voltage of the microphone is measured and the sensitivity displayed with
reference to 1 Pa. If a mere power supply without gain is used, the displayed sensitivity
must approximately match the value in the calibration certificate of the microphone
capsule (typical value for microphone capsule 4134 of artificial ear 4185 is approx.

12 mV/Pa, display = 120 mV/Pa). If a conditioning amplifier with 20 dB gain
(recommended value) is used, the displayed sensitivity must be about 10 times higher.
If the voltage measured is below 3 mV, an error message is displayed. Possible error
sources are, for example, a switched-off microphone power supply or a disabled
calibrator. In this case, the program requests that the test be repeated. After switching
on the microphone power supply, wait approx. 20 s before restarting the measurement
with the "Ok" button.

Calibration of Artificial Ear

Prior to the measurements, the absolute sensitivity of the microphone in the artificial
ear must be determined using a sound level calibrator such as the Briel & Kjeer 4231
with a sound pressure level of 94 dBSPL or a sound pressure of 1 Pa at 1 kHz.

Calibration of Ear Type 1

The use of artificial ear type 1 is not foreseen in TIA-1042. However, R&S UPV-K9
offers the use of this device regardless whether it is supported by the particular
standard applied.
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1. Switch off the microphone power supply.

The 200 V polarization voltage of the microphone may cause a slight electric shock.
The current is harmless, but the microphone preamplifier may be damaged.

2. Remove the microphone from the artificial ear.
3. Screw back the microphone capsule and switch on the operating voltage.

4. Insert the microphone fully into the adapter of the sound level calibrator and
switch on the calibrator

After inserting the microphone wait about 10 s to allow for static pressure
compensation.

4.3.2

5. Select Calibration - Artificial ear - Type 1 from the main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the checkbox
"Calibration level increased by 20 dB" must be checked. In all other cases the
checkbox must remain unchecked!

The output voltage of the microphone is measured and the sensitivity displayed with
reference to 1 Pa. If a mere power supply without gain is used, the displayed sensitivity
must approximately match the value in the calibration certificate of the microphone
capsule (typical value for microphone capsule 4134 of artificial ear 4185 is approx.

12 mV/Pa, display = 120 mV/Pa). If a conditioning amplifier with 20 dB gain
(recommended value) is used, the displayed sensitivity must be about 10 times higher.
If the voltage measured is below 3 mV or fluctuating by more than 0.2 dB, an error
message is displayed. Possible error sources are, for example, a switched-off
microphone power supply or a disabled calibrator. In this case, the program requests
that the test be repeated. After switching on the microphone power supply, wait
approx. 20 s before restarting the measurement.

The reference value measured is stored in a file on the hard disk and used for all
subsequent measurements when the same artificial ear type 1 is used as currently
selected.

Calibration of Ear Type 3.2 Low Leakage

1. Connect the sound level calibrator tightly to the artificial ear using the adapter
DP0939 and switch on the calibrator.

2. Select "Calibration - Atrtificial ear > Type 3.2 Low Leak" from the main menu.
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4.3.4

Calibration

For calibrators providing a sound pressure level of 114 dB (10 Pa), the checkbox
"Calibration level increased by 20 dB" must be checked. In all other cases the
checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the sensitivity
displayed with reference to 1 Pa. If the voltage measured is below 3 mV or fluctuating
by more than 0.2 dB, an error message is displayed. Possible error sources are, for
example, a switched-off microphone power supply or a disabled calibrator. In this case,
the program requests that the test be repeated. After switching on the microphone
power supply, wait approx. 20 s before restarting the measurement.

The measured reference value is stored in a file on the hard disk and used for all
subsequent measurements when the same ear type 3.2L is used as currently selected.

Reading the Calibration Data of Ear Type 3.2 LL

The frequency response of the artificial ear of type 3.2L is supplied on a floppy
together with the artificial ear. The data is used for transforming the measurement
values from the drum reference point to the ear reference point.

1. Connect a USB floppy disk drive with the calibration disk to the R&S UPV, copy
the file OES LL.ADA from the manufacturer’s calibration disk to a USB stick or a
CD-ROM or make this file available on a network drive via LAN.

2. Call the routine "Calibration > DRP to ERP Correction > Type 3.2 Low leak".
Browse to the file OES_LL.ADA and click "Open".

The calibration file is read. The modified data is stored on the R&S UPV hard disk. This
procedure needs only be repeated after a change of the calibration data, e.g. after a
recalibration of the ear by the manufacturer, or when the Phone directory has been
renamed or removed.

Calibration of Ear Type 3.2 High Leakage

1. Connect the sound level calibrator tightly to the artificial ear using the adapter
DP0939 and switch on the calibrator.

2. Select "Calibration - Atrtificial ear > Type 3.2 High Leak" from the main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the checkbox
"Calibration level increased by 20 dB" must be checked. In all other cases the
checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the sensitivity
displayed with reference to 1 Pa. If the voltage measured is below 3 mV or fluctuating
by more than 0.2 dB, an error message is displayed. Possible error sources are, for
example, a switched-off microphone power supply or a disabled calibrator. In this case,
the program requests that the test be repeated. After switching on the microphone
power supply, wait approx. 20 s before restarting the measurement.

The measured reference value is stored in a file on the hard disk and used for all
subsequent measurements when the same ear type 3.2H is used as currently
selected.
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4.3.6

Calibration

Reading the Calibration Data of Ear Type 3.2 HL

The frequency response of the artificial ear of type 3.2H is supplied on a floppy
together with the artificial ear. The data is used for transforming the measurement
values from the drum reference point to the ear reference point.

1. Connect a USB floppy disk drive with the calibration disk to the R&S UPV, copy
the file OES HL.ADA from the manufacturer’s calibration disk to a USB stick or a
CD-ROM or make this file available on a network drive via LAN.

2. Call the routine "Calibration > DRP to ERP Correction - Type 3.2 High leak".
Browse to the file OES_HL.ADA and click "Open".

The calibration file is read. The modified data is stored on the R&S UPV hard disk. This
procedure needs only be repeated after a change of the calibration data, e.g. after a
recalibration of the ear by the manufacturer, or when the "Phone" directory has been
renamed or removed.

Calibration of Ear Type 3.3

1. Connect the sound level calibrator tightly to the artificial ear using the adapter UA-
1546 and switch the calibrator on.

2. Select "Calibration -> Artificial ear > HATS Type 3.3" from the main menu.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the checkbox
"Calibration level increased by 20 dB" must be checked. In all other cases the
checkbox must remain unchecked!

The type 3.3 ear calibration requires the calibrator with adapter UA-1546 to be held
manually against the ear. If the HATS is installed remote from the R&S UPV, the
checkbox "Delay start by ... seconds" can be checked and a time interval can be
entered by which the start of the calibration measurement is delayed. The countdown
is displayed on the R&S UPV screen.

]
Operating Manual 1402.0643.12 - 03 44



R&S UPV-K9/-K92

4.3.7

4.3.8

Calibration

Microphone calibration

Connect artificial ear to analyzer input 1.
Put art. ear on calibrator with adapter part
LIA1546 and switch on calibrator.

[ Calibration level increased by 20 dB [not validated)

¥ Delay start by I EE: zecondsz

Cancel | )3

Figure 4-6: Ear calibration window with delayed start

The output voltage of the microphone in the ear is measured and the sensitivity
displayed with reference to 1 Pa. If the voltage measured is below 3 mV or fluctuating
by more than 0.2 dB, an error message is displayed. Possible error sources are, for
example, a switched-off microphone power supply or a disabled calibrator. In this case,
the program requests that the test be repeated. After switching on the microphone
power supply, wait approx. 20 s before restarting the measurement.

The measured reference value is stored in a file on the hard disk and used for all
subsequent measurements when the same ear type 3.2L is used as currently selected.

Reading the DRP-ERP Correction Data of Ear Type 3.3

Call the routine "Calibration - DRP to ERP Correction > Type 3.3 >From ITU-T P.57
Table 2b". This procedure needs only be repeated when the Phone directory has been
renamed or removed.

Alternatively it is also possible to load individual DRP-ERP correction data from a
calibration disk. This option is not conformant with the standards.

Reading the Diffuse Field Equalization Data of Ear Type 3.3

3GPP C.S0056-A (TIA1042-A), diffuse field equalization is applied to receiving
frequency response results with handset and headset UEs. Call the routine "Calibration
-> Diffuse field equalization > Type 3.3 >From ITU-T P.58 Table 3". This procedure
needs only be repeated when the Phone directory has been renamed or removed.

Alternatively it is also possible to load individual diffuse field equalization data from a
calibration disk. This option is not conformant with the standards.
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4.3.10

4.3.11

4.4

Calibration

Calibration of Ear Type 3.4

1. Remove the pinna and the ear canal simulator, connect the sound level calibrator
tightly to the artificial ear using the short steel adapter and switch the calibrator on.

2. Select "Calibration = Artificial ear > HATS Type 3.4" from the main menu.

For Head Acoustics HMS II, calibrator B&K 4231 must be used in conjunction with the
short steel calibration adapter.

For calibrators providing a sound pressure level of 114 dB (10 Pa), the checkbox
"Calibration level increased by 20 dB" must be checked. In all other cases the
checkbox must remain unchecked!

The output voltage of the microphone in the ear is measured and the sensitivity
displayed with reference to 1 Pa. If the voltage measured is below 3 mV or fluctuating
by more than 0.2 dB, an error message is displayed. Possible error sources are, for
example, a switched-off microphone power supply or a disabled calibrator. In this case,
the program requests that the test be repeated. After switching on the microphone
power supply, wait approx. 20 s before restarting the measurement.

The measured reference value is stored in a file on the hard disk and used for all
subsequent measurements when the same ear type 3.4 is used as currently selected.

Reading the DRP-ERP Correction Data of Ear Type 3.4

Call the routine "Calibration > DRP to ERP Correction - Type 3.4 > From ITU-T
P.57 Table 2b". This procedure needs only be repeated when the Phone directory has
been renamed or removed.

Alternatively it is also possible to load individual DRP-ERP correction data from a
calibration disk. This option is not conformant with the standards.

Reading the Diffuse Field Equalization Data of Ear Type 3.4

From Release 10 of 3GPP TS 26.132, diffuse field equalization is applied to receiving
frequency response results with handset and headset UEs. Call the routine "Calibration
-> Diffuse field equalization > Type 3.4 > From ITU-T P.58 Table 3". This procedure
needs only be repeated when the "Phone" directory has been renamed or removed.

Alternatively it is also possible to load individual diffuse field equalization data from a
calibration disk. This option is not conformant with the standards.

Calibration of Artificial Mouth for Handset Tests

Before a mobile phone can be tested, the absolute sensitivity and frequency response
of the artificial mouth have to be measured and corrected with the aid of a previously
calibrated pressure-field microphone. The measuring microphone removed from
artificial ear type 1 can be used for this purpose or an additional microphone capsule is
screwed to the microphone preamplifier. The standard microphone is used as a
reference for determining the frequency response of the mouth. The frequency
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response of the microphone can be ignored in the test frequency range (100 Hz to
8 kHz) (see also calibration certificate of microphone capsule).

Since interfering sound falsifies the corrections, the artificial mouth must be calibrated
in the sound-proof test chamber.

First of all, the measuring microphone has to be calibrated.

1. Select a reference microphone type with "Calibration - Artificial mouth > Select
reference mic".

For the selected microphone type, a device must be selected and calibrated (see
above). This device must be connected to R&S UPV analyzer input 1 via power
supply/conditioning amplifier.

If the selected reference microphone is a diffuse field or pressure field type (e.g. B&K
4131 or 4134) or a microphone from a Typel artificial ear, fit the microphone at right
angles to the mouth at the mouth reference point (MRP) using the gauge supplied with
the mouth (positioning at right angles is necessary because diffuse field or pressure-
calibrated microphones have a flat frequency response to sound from random incident
direction and therefore exhibit an emphasis on high frequencies with frontal sound
incidence).

If the selected microphone is a free field microphone, it must be mounted in the axis of
the sound outlet of the artificial mouth.

2. Call the calibration routine with "Calibration = Atrtificial mouth > LRGP ITU-T
P.51 or Calibration - Artificial mouth > HATS ITU-T P.58" from the main menu.

The sound pressure generated at the MRP is set to exactly -4.7 dBPa in an automatic
measurement routine at 1 kHz. The generator voltage required is stored in a file on the
hard disk and used as a reference for all subsequent settings with the same artificial
mouth. If the sound pressure cannot be adjusted to -4.7 dBPa, an error message is
displayed with a request to check the connection of the artificial mouth and to repeat
the measurement. A possible error source would be that the transformer supplied is
not connected between the generator and the artificial mouth.

The uncorrected frequency response of the artificial mouth is measured and displayed.
Next, the frequency response is measured with the inverse frequency response
correction automatically selected in the generator (equalization). Residual errors
caused by nonlinearities of the speaker in the mouth are measured and taken into
account in the final equalization file as fine correction.

To verify the results, the absolute sound pressure versus frequency is measured at a
sound pressure of 4.7 dBPa (reference value for most of the measurements). The
absolute sound pressure at each frequency must be within a tolerance band of

+0.2 dB. Correct calibration without interfering sound yields an almost straight line in
the middle between the two limit lines.

Before sending tests can be performed, a reference spectrum calibration of the
sending signal at the Mouth Reference Point is required which equalizes the speech
signal “Normal” according to the measured frequency response of the artificial mouth
and measures the resulting acoustic spectrum at the MRP.
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4.6
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Speech Spectrum Calibration

For tests using speech signal “Normal” or natural voice according to ITU-T P.501 as
test signal, the spectrum of the test signal has to be measured and stored as reference
spectrum for the transfer function (gain) calculation. For sending and sidetone tests,
the signal has to be filtered in addition with the inverse frequency response of the
artificial mouth. A calibrated reference microphone must be placed at the Mouth
Reference Point (MRP) for this purpose. It is recommended to perform the reference
spectrum calibration directly after the mouth calibration, using sub-menu item
"Calibration-> Artificial Mouth > ... - With cdma2000 Ref. Spectrum or Calibration->
Artificial Mouth = ... > With P.501 Ref. Spectrum"”, respectively.

The reference spectrum calibration for the receiving direction does not require external
equipment or wiring. The reference signal at the output from the R&S UPV generator to
the speech input of the system simulator is measured via internal connection to the
R&S UPV analyzer input. For narrow-band tests in receiving direction, a band-limited
version of the test signal is used. Each version of the test signal has to be calibrated
separately.

@UPU—KQV cdmaZ000{R) Mobile Phone Tests (D:\Phone'Results.aml})
File Data | Calibration Measurement Standards  Config. Meas. Sequence Report  Options  Help
v Selective
Sele Mic.r?p.hone b | Test object |
l_ Artificial Ear _ : landset Marrowband UE 2
r ERP tf? lEdRP ‘”rlfectt_'m > [Teminal Coupling Loss, N UE 2
r T;e 'EF_ qu”a 'Zc'l'_ on , {e! Noise Sending NE UE2
I b usz b ;qualiz:atfon . e 3 Marminal Yolume Setting UE 2
r D (FIn Tpen :nt of Direction) Equalization ’ Ltone Delay UE 2
[ Artiicial Moo Handset NB, rom, ol LE2
Artificial Mouth {Hands Free) » . L
[N p , el noige receiving, max. vol.  UE 2
I Cod ec_ i andset Marrowband LE 2
r IT UETEmEE , [Terminal Coupling Loss, N UE 2
[ Fletic connections ol Noise: Sending NB UE 2
l_ cdmaZz000 ref, spectrum L T T A AR UE 2
r P.S01 5T Speech Ref. Spectrum ld  Receiving 3 I e A
r AMPS 3 Sending Handset 3 Art. Mouth LRGP ITU-T P.51
r Background noise field » Sending Handsfree * Art, Mouth HATS ITU-T P.5&
I— Nelw Dewcn.a - st Manowband Glener.lc Speaker.
r S Iect Dew@ T erminal Coupling Loss, b Electric Conneckion
r D: et fl’e"'lce el Noise: Sending NB UE 2
N Show a lva uedsd . Maominal Yolume Setting UE 2
r Shaw selected devices Ltone Delay UE 2
e e e TR o o
Figure 4-7: Submenu for reference speech spectrum calibration

Calibration of CMU Speech Codec

The calibration of the speech coder and decoder is necessary to be able to calculate
absolute loudness. Calibration has to be performed only once and must be repeated
only if the R&S CMU used is replaced.

Note that encoder and decoder are handled as separate devices but calibrated with
one routine.

Auxiliary settings required for calibration can be found in the R&S CMU under "Service
Cfg.". Call the calibration routines with "Calibration - Codec" from the main menu.
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The following information is displayed:

EE—

Establish call and set 'Bit Stream’ to 'DecoderCal'l

Figure 4-8: Message box during decoder calibration

Set up a call to the mobile phone. Set bit stream or voice setting on the R&S CMU to
"Decoder Cal" and then click the "OK" button.

The actual voltage at the decoder output of the R&S CMU is now measured for a
digital full-scale signal and the required correction value is calculated and saved in the
R&S UPV. The following request is then displayed:

Set 'Bit Stream' to ‘Encodercal'!

Figure 4-9: Message box during encoder calibration

After the "OK" button has been clicked, the input sensitivity of the speech coder is
measured and the input voltage required for digital full scale is measured at the speech
coder and saved in the R&S UPV.

4.7 Calibration of CMW Speech Codec

The R&S CMW500 does not provide the “Decoder Cal” and “Encoder Cal”
functionalities. Instead the maximum peak input and output voltage can be set in the
user interface.

B-S peech Analysis

--Routing AF-1
----- Signaling Ho Connection
E-Control

----- Input Level Full-Scale (Peak) 0.100 v

- Qutput Level Full-5cale (Peak) 0.300 v

Figure 4-10: Setting of the full-scale peak input and output values in the CMW user interface

"Calibration — Codec — CMW" opens windows where these values can be entered in
unit mV in the mobile phone test program.
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4.8 Calibration of Noise Field for “Speech Quality in
Presence of Background Noise” Test

4.8.1 Connections

TRIGGERIN] Bm I ks
T LOJ eforarar 14|
5 UpPv 13‘."".__;7
Nl | eeeeeees 9000 s
E —~eeee Upp
TRIGGEROUT "l -

Figure 4-11: Test setup and connection of external components for the adjustment of the background
noise field without switcher

Connect
LAN socket of R&S UPV to LAN socket of R&S UPP
R&S UPP trigger output to R&S UPV trigger input
R&S UPP-Z8A output 3 to input of front left active speaker

1

2

3

4. R&S UPP-Z8A output 4 to input of rear left active speaker
5.  R&S UPP-Z8A output 5 to input of front right active speaker
6. R&S UPP-Z8A output 6 to input of rear right active speaker
7

R&S UPP-Z8A configured subwoofer output (by default 7) to input of active
subwoofer

8. Right artificial ear to R&S UPV analyzer input 1 via microphone power supply
9. Left artificial ear to R&S UPV analyzer input 2 via microphone power supply

For the delay measurements, the operator will be prompted to modify the input
connections: a connection has to be made from R&S UPP-Z8A output 10 to R&S UPV
input 1, and both artificial ears have to be connected subsequently to R&S UPV
analyzer input 2.

Optionally a R&S UPZ input switcher can be used (see chapter 4.8.4).
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4.8.2 Establishing the remote control connection between R&S UPV and
R&S UPP

After power up of both instruments and the interconnection with a LAN switch cable,
first an IP connection has to be established between R&S UPV and R&S UPP.

1. Start the R&S UPV-K9x program and open window "Options — UPP remote
control".

2. Once the LAN LED on the R&S UPP is on, press button "CASCADE / LAN
RESET" once and wait until the" CASCADE" LED is blinking.

3. Pressthe "CASCADE / LAN RESET" button again.
4. Click the "Find" button in the R&S UPP remote control window on the R&S UPV.

5. Now the computer name on the R&S UPP appears in the R&S UPP remote
control window. Select it and close the window with "Ok".

4.8.3 Prerequisites

The calibration of both artificial ears of the HATS is required for performing the
calibration of the background noise field.

4.8.4 Switcher Support

If "Input Switcher UPZ" is enabled in "Noise Calibration Configuration”, the calibration
process will try to connect all required signal sources automatically to R&S UPV input
instead of prompting the operator to change cabling. This presumes:

R&S UPV is connected to R&S UPZ via serial cable (RS232) OR USB cable (do not
connect USB if you want to use RS232!);

USB-to-serial device driver is installed (only if using USB connection);

R&S UPZ is powered ON (green ON-LED on switcher front panel)
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TRIGGER OUT

Figure 4-12: Test setup and connection of external components with input switcher R&S UPZ for the
adjustment of the background noise field

When starting the calibration process, a dialogue is displayed to instruct the operator
how to connect the input switcher's analogue input and output connections. The
connections to R&S UPZ input channel 3, 4 and 5 are not necessary for the calibration,
but will be needed for later measurement (note: only 1 microphone need to be
connected to input channel 4 or 5, respectively)

Sniitcher UPL =

Please connect input switcher UPZ to UPW:

- swyitcher output channel 1to UPY analog input channel 1

- switcher output channel 2 to UPY analog input channel 2

Please connect switcher input channels

- connect HATS output left ear to UPZ input channel 1

- connect HATS output right ear to UPZ input channel 2

- connect decoder output (ChW, Chill or CBT) to UPZ input channel 3
- connect free field reference microphone to UPZ input channel 4

- connect diffuse field reference microphone to UPZ input channel 5

- connect UPP-B3 output channel 10 to UPZ input channel &

Ok

Figure 4-13: Switcher support, analogue connection instructions

or — if switcher could not be detected — how to establish the control connection from
R&S UPV to R&S UPZ:
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Swiitcher UPE ==

Input Switcher UPZ not connected or switched off, Please check

- USE or Serial connection must be established between UPY and UPZ

- Powver cable must be connected to UPZ

- UPZ must be turned OM (rear panel)

- if using COM interface 'Used for' must be setto "Switcher' (Config Panel
- if using U3E interface 'USE Serial Port' device driver must be installed
'‘Cancel will continue without switcher; cabling rmust be done manually!

Retry Cancel

Figure 4-14: Switcher support, control connection instructions

If the switcher cannot be enabled at this point, "Cancel" will disable switcher for the
current calibration. The cabling has to be done manually. The corresponding setting in
configuration window will not be changed. On next start of calibration it will again be
attempted to use the switcher.

The calibration process checks the connection to R&S UPZ whenever the switcher
needs to be operated. If switcher control fails while calibration is running (e.g. by
unplugging the control or power cable), the user will be prompted to establish the
analogue connections manually. This allows the calibration to terminate correctly:

Switcher UPZE =]

Swiitcher not available; please establish UV input connections manually:
- connect UPP-B3 output channel 10 to UPY analog input channel 1
- connect HATS output right ear to UMY analog input channel 2

Ok

Figure 4-15: Switcher support, error message if switcher failed during calibration

4.8.5 Starting the calibration process

Before calibration can be started user has to select the reference microphone:
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Calibration | Measurement Standards  Config, Meas.  Sequence Report  Options  He

v Selective
Microphane ¥ Test object
Artificial Ear y Presence of
) Presence of
DRP to ERP correction P Lence of Am
Free field equalization P izence of Am
Diffuse field equalization p psence of Am
N L zence of Am
ID Independent of Direction) Equalization * sence of Am
Artificial Mouth F heence of Am
Artificial Mouth (Hands Free) » pzence of Am
Codec y FEence of &m
zence of Am
Induction coil
Electric connections *
cdrma2000 ref. spectrurm »
P.501 5T Speech Ref, Spectrum 3
ARAPS 3
Background noise field * Select Reference Mic
Mewy Device Office Room

Figure 4-16: Selecting the reference microphone for the background noise calibration process

Calibration is started by selecting the "Office Room"™:

Background noise field » Select Reference Mic

Mew Device Office Room

Figure 4-17: Starting the background noise calibration process

A brief set of cabling instructions appears first of all:

Setup speakers and HATS according to ETS Standard ES 202 396-1
Connect UPP generatar

- channel 3 to speaker Front Left

- channel 4 to speaker Rear Left

- channel 5 to speaker Front Right

- channel 6 to speaker RearRight

- channel 7 to subwoofer {optional)

018

Figure 4-18: Cabling instructions for the speakers

4.8.6 Stopping and resuming the calibration process

The calibration process can be stopped at any time. All of the calibration data recorded
up to this point are then available and can be viewed in the report.
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To abort a running calibration (e.g. to improve the loudspeaker positions) is possible in
the following ways:

e If adialog box appears, click the "Abort" or "Cancel" button

ore foor measorement T

) Moise Flaor ba high; 36.51371 dBsplia); should be below 30 dBspl{a)!
- Improve noise absorption,

abort I Retry | Ignore |

Figure 4-19: Dialogue with "Abort" button to abort calibration

Delay Measurement =1 |

Speaker Front Right; delav cannot be negative (-1 ms),
' Check connection of UPY analyzer channel 1; must be connected to UPP generator channel 10!
Complete Delay measurement will be repeated!

Cancel |

Figure 4-20: Dialogue with "Cancel" button to abort calibration

e |f measurement is running, click the "Cancel" button and confirm with "Break™":

x|

ﬂl Measuring ﬁ

BGMoize, noise floor measurement

‘ Cancel I

Repeat curent sequence |

Break Measurement

W'ould wou really like to break
the running measurement?

Return to
Break b eazurement

.

Figure 4-21: Window during running measurement and "Cancel" confirmation dialogue

e  After calibration has been stopped, a dialog box informs the operator about the
calibration section that was aborted.
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4.8.7

4.8.7.1

Calibration

Background Maise Field Calibration aborted while level adjusting
Cutside_Traffic_Road!

Ok

Figure 4-22: "Calibration aborted" message, e.g. when level adjusting Outside_Traffic_Road

A calibration that had been aborted can be resumed at certain resuming points. When
restarting a calibration that partly had been finished the calibration process will prompt
the user at every resuming point

e to resume the calibration at this point (recalibrate this and the following)
e to skip this calibration section
e to abort the calibration

By skipping all successfully terminated calibration sections, the calibration process will
be resumed at the beginning of the section where it had been aborted. For details
please see section Calibration Sections and Resuming Points on page 68.

Preparatory Measurements for Delay Measurement

Before the delay measurement is performed, additional plausibility checks are carried
out at each speaker to ensure that the wiring is correct and that the sound pressure
level is high enough.

Measurement of Sound Pressure

The unweighted sound pressure level should reach at least 80 dBspl (or the value
selected as "Min sound pressure level” in configuration window, if modified) at normal
drive level.

comectonrest T

Level koo low on UPY channel 2 (70,2 dBspl)!
. Increase amplifier gain For Speaker Front Right by at least 9.3 dB!

Rekry I Cancel |

Figure 4-23: Message for insufficient level

If this sound pressure is not reached, an error message appears which cannot be
ignored. After the gain factor of the external amplifier or active speaker has been
increased, the measurement can be repeated (by selecting "Retry").
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4.8.7.2 Measurement of Level Change at Microphone Amplifier Output

During this measurement 2 different levels are successively applied to each speaker.
The output at the microphone amplifier (measured by R&S UPV input channel 2) is
expected to change by the same amount (5 dB).

a x

Level sweep Failed on UPY channel 2!
! Speaker Front Right not connected to UPP generator channel S or switched ofF,
Right Artificial Ear not connected to UPY analyzer channel 2

ot power supply off
Cancel |

Figure 4-24: Message for insufficient sound pressure level increase

If the amplifier output does not change with the R&S UPP output level, this may have
the following causes:

the microphone amplifier is switched off

the HATS ear is not connected to the correct amplifier channel

the microphone amplifier is not connected or is incorrectly connected to R&S UPV
input channel 2

the desired speaker is switched off

the desired speaker is not connected to the correct R&S UPP output channel

the requested sound pressure level cannot be output by the speaker (speaker
gain to high or '"Maximum output level' to high)

After the error has been rectified, the measurement can be repeated by selecting
"Retry". If the configuration has to be changed, the calibration must be aborted
("Cancel" button).

4.8.7.3 Measurement of Level Change at Reference Input

During this measurement 2 different levels are successively applied to R&S UPP
output channel 10. The input level at R&S UPV input channel 1 is expected to change
by the same amount (5 dB).

Connection Test al x|
!E Level sweep failed on UPY channel 11
-

PP generatar channel 10 not connected to UPY channel 1.
Cancel |

Figure 4-25: Message for insufficient level change at reference input

If the reference input does not change with the R&S UPP output level, there is no
connection between R&S UPV channel 1 and R&S UPP output channel 10.

After the error has been rectified, the measurement can be repeated by selecting
"Retry".
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4.8.8 Delay Measurement

The delay measurement determines the time it takes for the sound to travel from the
speaker membranes to the left and right ear of the HATS. The travel time and therefore
the distance of the full-range speakers from the HATS is measured by means of
cross-correlation of the acoustic (sound pressure) signal and the electrical reference
signal.

Since the delay measurement is quite complicated owing to the required cabling
modifications, it can be skipped if a valid delay calibration is already available and if the
speaker layout and the HATS position have not been changed in the meantime. The
latter is not recognizable by the calibration process; it is therefore the responsibility of
the user to repeat the delay calibration if necessary.

Delay compensation ==

% Currently these distances between HATS and speakers are set:

' L7994 rn from HATS to Speaker Front Left

1.515 mi from HATS to Speaker Rear Left

1772 m frorm HATS to Speaker Front Right

L6011 rm frorm HATS to Speaker Rear Right

1500 rm frorm HATS to Subwoofer

Recalibration is required if position of HATS or any speaker has been
modified since last Calibration

Recalibrate delays?

Yes Mo Cancel

Figure 4-26: Message querying the start of the delay calibration

To perform the delay measurement, the reference signal from channel 10 of the

R&S UPP generator is connected to analyzer channel 1 of the R&S UPV, and the
signal from the respective ear is connected to analyzer channel 2 (via a preamplifier).
Dialog boxes show which ear is currently being measured and therefore must be
connected (to R&S UPV input channel 2. If the R&S input switcher R&S UPZ is used,
the connection will be switched automatically without any user interaction.

Delay Measurement al x|

i Connect UPP generator ch10 to UPY analyzer chi,
Right Ear to UPY analyzer chz,

Figure 4-27: Instruction for connections during delay measurement

This box must be confirmed after reconnection of the R&S UPV analyzer; then the
measurement and the generator signal are started.

Connection problems can be determined from the measured value obtained during the
delay measurement:

e  Checking of the delay differences between the measurement channel and
reference channel
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Delay Measurement =1

Speaker Front Right: delay cannok be negative (-1 ms).
' Check connection of UPY analyzer channel 1; must be connected to UPP generator channel 101
L]

Complete Delay measurement will be repeated!

Cancel |

Figure 4-28: Plausibility check for the delay result

If the reference channel has a greater delay than the measurement channel, it is
not connected to the reference signal but instead to the 2nd channel of the
microphone amplifier.

e Distance between the speaker and associated HATS ear is too large

Delay Measurement =] |
Speaker Front Right: delay koo long £10 ms).
Left and right ear seems ko be swapped or
! ft and righ b d

diskance to Right microphone to long (3,43 m)!
Check ear connections and position of Speaker Fronk Right

Cancel |

Figure 4-29: Message for unexpectedly long delay

If the measured distance is greater than the expected maximum distance, the
longer indirect sound path to the ear located opposite may possibly have been
measured. In this way it is possible to detect inadvertent swapping of the HATS
ears. The 'Max distance HATS to speaker' can be adjusted in the configuration
window after cancelling the calibration.

e Distance between the speaker and associated HATS ear is too small

Delay Measurement (=]

Speaker Front Right: delay cannot be measured; seems to be too short (3 ms),
! Check distance bo Right microphone (1,029 m)
and sound level of Speaker Front Right

Retry | Ignore |

Figure 4-30: Message for unexpectedly short delay

If the distance is less than the intended minimum distance, the speaker is too
close to the HATS. This warning can be ignored, if the measured distance
matches the actual position of the speaker. The 'Min distance HATS to speaker’
can be adjusted in the configuration window after cancelling the calibration.

The measurement can be repeated after the cabling or the amplifier level has been
corrected.

If the R&S Input switcher R&S UPZ is used, the connections are automatically
switched without any user interaction. Otherwise the cabling must be changed during
and after the delay measurement; the user is instructed to do this in dialog boxes.
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4.8.9.1

Calibration

& Ensure Right Ear is connected to UPY analyzer chi,
\!J) Left Ear is conmected to UPY analyzer chz,
and UPP TRG Qut is connected ko UPY TRG IN!

Figure 4-31: Instructions for change of cabling during the calibration process

The distance between HATS and subwoofer cannot be measured but must be entered
manually. This value is not critical for the measurement and can be given with an
accuracy of 10 cm.

- )

Subwmyoofer Distance

boo.oo= em
Cancel | Ok |

y

Figure 4-32: Delay measurement, manual entry of subwoofer distance

After completion of the delay measurement, it is thus ensured that the HATS ears are
correctly cabled and the output level is high enough. A list showing all of the
determined distances is displayed before the actual equalization begins.

Delay compensation ==

'0' These distances between HATS and speakers have been measured:
W L7394 m from HATS to Speaker Front Left
~ 1515 m from HATS to Speaker Rear Left
L7772 m from HATS to Speaker Front Right
L1601 mm from HATS to Speaker Rear Right
1.500 mm from HATS to Subweoofer

OF, Cancel

Figure 4-33: List of determined distances

Preparatory Measurements for Equalization

Equalization can only be performed successfully if the room acoustics meet certain
requirements.

Noise Floor

The acceptable noise floor is max. 30 dB(A)spl. If it is above this value, equalization
may fail in the case of weak noise fields.
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4.8.9.2

Calibration

=3
ﬂl Measuring ﬁ

BGMoise, noige floor measurement

‘ Cancel I

Repeat cunent sequence |

Moise floor measurerment E3

. Moise floor too high; 33.39922 dBspl(a); should be below 30 dBspl{a)!
__I_'h Irnprocee noise absorption
or continue with current noise floor by selecting IGNORE |

Abhort | Retry Ignore

Figure 4-34: Warning for exceeded noise floor limit

This warning is suppressed if "Ignore uncritical level warnings" is activated in
configuration window. After the soundproofing has been improved, the measurement
can be repeated. "Ignore" continues the calibration process although this limit has
been exceeded.

Frequency Response of unequalized Speakers

The frequency response of each speaker before equalization is measured in the range
of 40 Hz to 20 kHz (or the range selected as "Bandwidth low/high" in configuration
window, if modified).

The acceptable flatness deviation for fullrange speakers is max. +9 dB in the range 50
Hz to 10 kHz (or the range selected as "Flatness start/end at" in configuration window,
if modified).

The graph displays the frequency range that is to be equalized, the Y axis is scaled
from -20 to +20 dB. The limit curve shows the range that is checked for flatness.
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Measuring

Figure 4-35: Frequency response of unequalised fullrange speaker

If the flatness deviation is above this value, equalization is hard to achieve for the
room, and the room properties and the speaker layout should be improved before
equalization is performed.

B

Pink equalization of Speaker Front Left ot of tolerance (9,95 dE)1

1\ Should be below 9 dt
Improve the set-up arrangement, use higher quality loudspeakers!
or continue with current set-up by selecting IGNORE

Retry Ignore

Figure 4-36: Warning for excessive equalization needs
"Ignore” continues the calibration process although this limit has been exceeded.

This warning is suppressed if "Ignore uncritical level warnings" is activated in
configuration window.

The final curve for each speaker and the flatness result for each fullrange speaker are
added to the report.

The subwoofer frequency response can be used to determine the cutoff frequency, if
unknown. If it is below the default value of 120 Hz, then the actual cutoff frequency
must be modified in the configuration window. If the subwoofer does not pass
frequencies down to 40 Hz, then the lowest third octave should not be equalized. In
this case the user should set the Bandlimit Low in configuration window to 50 Hz. If it
does not pass 50 Hz, then this subwoofer is not appropriate for this calibration.
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Figure 4-37: Frequency response of unequalised subwoofer

4.8.9.3 Total Harmonic Distortion

Measurement of the total harmonic distortion is performed for each speaker at nominal
level in order to prevent speakers from being overdriven. Since destructive interference
of the fundamental can occur at discrete frequencies which then results in a poorer
total harmonic distortion being determined, the measurement is repeated at different
frequencies in the case of an error.

Connection Test a8 x|
L] THD of Speaker Front Left out of tolerance;
L3 seems to be overdriven!

Retry | Ignore

Figure 4-38: Warning for excessive total harmonic distorsion of a speaker

If speakers with a high total harmonic distortion are used, the tolerance limit "Max
THD" must be set higher (e.g. -10 dB) in the configuration window.

4.8.9.4 Cabling Check

This measurement which was already performed during the delay measurement is
intended to ensure that the cabling is correct if the delay measurement is skipped and
after the cabling has been changed. The results are the same as those under 4.8.7.2.

4.8.10 Shared Equalization Method

The fastest way to establish a valid calibration is to equalize room and speakers with
only one signal — preferably Pink Noise — and use the equalization data for all
ambiances. Afterwards the levels of all ambiances are individually adjusted. This is the
default setting. Alternatively, the operator can select any of the ambiances as
equalization signal in the noise calibration configuration window, see Choice of
calibration method on page 29.
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At the beginning of the equalization a check is performed to determine whether a valid
equalization data set is available. If this is the case, equalization can be skipped (by
selecting "No") and the calibration process continues with individual level setting:

Moise calibration ==

I.-"'_"“-.I Do youwwant to update the Calibration using Fink Moise now?
WY YESto recalibrate the complete noise field

MO to skip equalization and continue with level setting
{using existing equalization).
CAMCEL to abort calibration,

Yes Mo Cancel

Figure 4-39: Valid Shared Equlization, recalibration prompt

Once started, the equalization as well as the subsequent level adjustment are largely
performed without operator interaction. Input is only required if errors occur and the
operator is prompted for a decision on the next action.

During calibration process, the equalization result graph — if equalization had been
performed — and the values of the level adjustment are stored and can be reviewed in
the report after termination or abort of calibration.

4.8.11 Individual Equalization Method

Alternatively the calibration process can generate individual equalization data for each
ambiance. Depending on the room and speaker characteristic this method could
generate even better flatness, but it is very time consuming. Each ambiance will first be
adjusted in level and then equalized. Before starting the calibration process the
operator has to select this calibration method in the noise calibration configuration
window, see Choice of calibration method on page 29.

For each ambiance the existence of valid calibration data is checked. If this is the case,
equalization of this ambiance can be skipped by selecting "No":

- -

Moise calibration [

"-.I Armbiance Pub_Moise W2 is already adjusted,

¥ PRecalibrate?

WES to calibrate this and all following ambiances,
MO o skip this ambiance,

CAMCEL to abort calibration,

Yes Mo Cancel

Figure 4-40: Valid Individual Equalization, recalibration prompt
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Once started, the level adjustment and equalization are largely performed without
operator interaction. Input is only required if errors occur and the operator is prompted
for a decision on the next action.

During calibration process each measured equalization result graph and the values of
the level adjustment are stored and can be reviewed in the report after termination or
abort of calibration.

4.8.12 Level Adjustment

Level adjustment is performed with a maximum of five iteration steps. Normally two
steps are sufficient to achieve the desired level tolerance (< 0.3 dB, can be modified as
“Max level deviation” in the noise calibration configuration window). This number may
not be sufficient for the subwoofer, especially for ambiances with low energy in the low-
frequency range. A message is then displayed where the user can choose whether to
accept the actual level deviation or to perform a further iteration. This dialog box by
default is disabled in the noise calibration configuration window:

|gnore uncritical level warningz v

Figure 4-41: Checkbox for suppressing the message caused by excessive single level deviation and
other uncritical warnings

Level adjustment is performed before (in case of individual equalization) or after (in
other cases) the single speaker equalization.

4.8.13 Equalization

Equalization is performed in 4 steps:

e single speaker equalization

e pairwise equalization of the two left and the two right speakers

e flatness check of all speakers

e all speaker post equalization (optional)

Each of the two steps is performed with a maximum number of iteration steps which is
selected in the configuration dialog box. 2 or 3 iterations are usually enough to achieve
a flatness of 1 dB. If additional iterations are desired (up to 5), the operator can modify
this setting in the configuration window

If the all speaker equalization check does not result in a PASS, the user can try to
achieve a PASS by repeating this measurement. This may be successful if, for
example, the tolerance violation is only slight or unwanted noise had impaired the
measurement.
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Equalization check, Pink Noise a8

vetification of all speakers including subwoofer Failed!
! 5 Left Spectrun out of talerance; 6.23 dB
Right Spectrum out of tolerance; 6,24 dB
katal level deviation left = 3.2 dE
tokal level deviation right = -0,39524 dB
Please select
ABORT to abort equalization and improve the set-up atrangement {recommended),
RETRY to repeat this check,
IGMNORE ko proceed with next equalization step.

Rekry | Ignore |

Figure 4-42: Message for failed verification of all speaker equalizations

This dialog can be suppressed by predefining the desired behavior in the configuration
window:

Achan on final flathess dewiation Prompt -

- Prompt
I1ze Al zpeaker Equalization
vwe - - . Retry bwice

Figure 4-43: Selection of action on failed verification of all speaker equalizations in the noise
calibration configuration window

Additionally optional post equalization can be performed if the all speaker equalization
check fails. Activated by default, this part of the calibration slightly modifies the
equalization of individual speakers to fulfil the flatness requirement. The result of each
intermediate step is displayed as a trace during equalization. By selecting "Report
intermediate steps" in configuration window all these traces are stored in the report.

Figure 4-44: Display of intermediate equalization results

4.8.13.1 All Speaker Post Equalization

Following an unsuccessful all speaker equalization check, it is possible to adjust the all
speaker equalization to within the +3 dB tolerance band by subsequent correction of
individual speakers.

Since the algorithm recommended by ES 202 396-1 is extremely time-consuming and
not always successful, a much faster post equalization is selected by default.
Alternatively user can select the ETSI recommendation or deactivate the post
equalization in the configuration window.
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Ilze Al speaker Equalization v

All Speakers Post Equalization F azst [recommended by Bi5]
accaording to ES 202 396-1

Repart intermediate steps

Fast [recommended by BES)

Figure 4-45: Checkbox in the noise calibration configuration window for deactivating the additional
all speaker equalization step

deactivating the "Use All speaker Equalization" is not recommended because it will
cause a final FAIL of calibration if the first all speaker check fails.

If "All Speaker Post Equalization according to ES 202 396-1" is activated, these further
equalization steps are performed:

e Measurement of the crosstalk flatness separately for left and right. If at least one
of these is outside the tolerance, the crosstalk speaker which impairs the
frequency response most is determined (by switching off the other crosstalk
speaker). Starting with this speaker, the four crosstalk speakers are equalized
again individually (next is the other speaker on the same side followed by the next
worse speaker) until the interaction of all speakers is below the tolerance limit or
repeated equalization of all four speakers was unsuccessful.

e If this equalization step was unsuccessful, adjustment with the direct speakers is
attempted. Once again the direct speaker which impairs the frequency response
most is determined. Starting with this speaker, the four direct speakers are
equalized again individually until the interaction of all speakers is below the
tolerance limit or repeated equalization of all four speakers was unsuccessful.

If "All Speaker Post Equalization Fast" (recommended by R&S) is activated, these
further equalization steps are performed:

e  Equalization of each pair (left and right) with the attenuated inverse frequency
response of the opposite pair.

e If this equalization step was unsuccessful, then equalization of each pair (left and
right) with the attenuated inverse frequency response of the same pair.

If this equalization step is also unsuccessful, equalization has definitively failed and
must be repeated with improved room properties. After successful termination of the
background noise field calibration the calibration data is valid and can be used for
measurements in the presence of background noise.
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Final Equalization check [

& Fackground Moise Field calibration f verification terrminated
Vosuccessfully!

oK

Figure 4-46: Message of successful calibration or verification

4.8.14 Final Test of All Ambiances

This test performs a flatness and level check of each ambiance, with the A-weighting
filter activated. It can be performed during the calibration process or separately after a
calibration had successfully been terminated. So it allows checking a valid calibration
to see if any modification had been done that requires a recalibration.

For each checked ambiance a report entry is generated with the graph (documenting
the flatness over frequency) and the numeric deviations of flatness and level for left
and right channel. Note that the +3 dB tolerance limits in the graphs are displayed
centered to the highest left and right deviation.

If performed during the calibration process the final test section additionally adjusts the
total level to minimum level deviation of both channels. To have this final level
optimization it is strongly recommended not to deactivate the final test!

Final test of all ambiances Iv

Figure 4-47: Checkbox for activation of the final test of all ambiances

To perform the final test separately, the operator has to start the calibration and skip all
calibration sections. Note that the preparatory measurements cannot be skipped but
have to be done to ensure proper cabling. The final test cannot be skipped but of
course aborted at any time.

4.8.15 Calibration Sections and Resuming Points

The calibration process consists of the following sections, depending on the calibration
method used:

For Pink Noise Equalization or Equalization with shared ambiance:

Delay Measurement

Preparatory Measurements

Pink Noise Frequency response before equalization
Equalization with Pink noise or shared Ambiance
Level adjustment of each ambiance

Final test of all ambiances

For Individual Equalization of each ambiance:
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Delay Measurement

Preparatory Measurements

Pink Noise Frequency response before equalization
Level adjustment and Equalization of each ambiance
Final test of all ambiances

Resuming points are located after successful termination of

e Delay Measurement

Delay compensation

i 1 Currently these distances between HATS and speakers are set:

¥ 1794 m from HATS to Speaker Front Left

1515 rn from HATS to Speaker Rear Left

L7172 m from HATS to Speaker Front Right

L601 rn from HATS to Speaker Rear Right

1500 m fram HATS to Subwoofer

Recalibration is required if position of HATS or any speaker has been
rnodified since last Calibration

Recalibrate delays?

Yes Mo Cancel

Figure 4-48: Resuming Point after delay measurement

e Equalization with Pink noise or shared Ambiance

Moise calibration

Do wou weant to update the Calibration using Pink Moise now?
@ %ESto recalibrate the complete noise field
MO to skip equalization and continue with level setting
[using existing equalization),
CAMCEL to abort calibration,

Yes Mo Cancel

Figure 4-49: Resuming Point after (shared) equalization

Calibration
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e Level adjustment (and Equalization) of each ambiance
Moise calibration (5]

¥ Recalibrate?

YE= to calibrate this and all following ambiances,
MO ta skip this ambiance,

CAMCEL to abort calibration,

Yes Mo Cancel

Figure 4-50: Resuming Point after level adjustment or individual equalization of any ambiance, e.g.
Pub_Noise_V2

Selecting "Yes" always resumes the calibration at the current resuming point (with the
current beginning calibration section), No skips the current calibration section and goes
to the next resuming point. If the calibration section following the current resuming
point is not valid, then the calibration process will continue with this section.

4.8.16 Calibration Report

In the results overview of the main window an entry is available to open the report of
the — failed, aborted or passed — calibration process. For each calibration that has
been started a new entry is generated.

| [T maseriems121803 Moise Field Adjustment Office Room FASS [null]
The complete report includes

e frequency response (unequalized) of all speakers
limit check is done for fullrange speakers only; no FAIL verdict

Frequency Response Speaker Rear Right
30

20+

Specirum [d3]
T
N
e
N
//
g
N
——

-30 T T T T 1
40 100 1000 10000 20000
Frequency [Hz]

LMt Right Ear ™' Upper mit o Lower limil

Figure 4-51: Report Content: frequency response of unequalised (fullrange) speaker
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e all speaker flatness of equalization method used (graph and values)
limit check for flatness and level deviation

Pirk Maoise (all speakers including subwoofer)
€04

Spectrum [dBsH]
B
E
[\

A0

T I 1
40 100 1000 10000 20000
Frequency [Hz]

Ly LeftEar Right Ear /" Upper Imt A< Lower limit

Figure 4-52: Report Content: All speaker flatness after equalization

e final test results of all ambiances (graph, flathess and level deviation)
limit check for flatness (FAIL verdict for individual equalization method only) and
level (including PASS/FAIL verdict)

Outside_Traffic_Crossrcads (all speskers including subwacfer)
-

T, ~

RN '\\J_,_f—“—*—u../’ B e

Spectium [dE[&]sol
g

T T 1
40 100 1000 10000 20000
Frequency Hz]

Lyt Left Ear Right Ea /' Upper lmt #' Lower limit

Figure 4-53: Report Content: final test of each ambiance

e  other numeric calibration results
including Delays (verdict for fullrange speakers only), Noise Floor (no FAIL
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verdict)
Values:
Value Result Lower Limit Upper Limit Verdict
Delay Spesker Front Left 523 ms 437 ms 7.28 ms PASS
Delay Spasker Rear Left 442 ms 437 ms 7.29 ms PASS
Delay Spasker Front Right 517 ms 437 ms 7.29 ms PASS
Delay Spasker Rear Right 467 ms 437 ms 7.28 ms pASS
Delay Subwoofer 437 ms
Noise floor 3378 daspl(A) 30.00 despl(A)
Flatness Spaaker Front Left 1163 d3 18.00 dB PASS
Flatness Spesker Rear Left 1546 d8 18.00 d8 PASS
Flatness Spasker Front Right 1033 d8 18.00 d8 PASS
Flatness Spasker Rear Right 13.12 dg 18.00 d8 PASS
Pink Nois level dav left -1.55 d2 -2.00 d2 2.00 d2 pASS
Pink Noise level dev right -1.87 &8 200 &2 2.00 dB PASS
Pink Noise flatness left 343 d8 4,00 dB PASS
Pink Noise flatness right 345 d2 4.00 d8 PASS

Figure 4-54: Report Content: other numeric values

e Test Parameters (configuration window and internal settings)
unused or irrelevant parameters are skipped

Test Parameters

Description: ETSIES 202 3961
Vi4.1 (2012-10) SW Version = Beta 2.3.4.64

Name Type Value Fix
UPP setup folder String De\UEVY, No
Sonic speed [mys] Double 343.0 No
retry i single flatness beyond [dB] Double 1.0 No
Max noise floor [dBspl(A)] Double 300 No
left microphane at UPY channel Integer 2 No
right microphone at UPV channel Integer 1 No
re-adjust level after equalization Boolean False No
Max equalization [+/- 8] Double 5.0 No
Number of fullrange speakers Integer 3 No
Number of subwoofers Inbeger 1 No
Subwoofer connected to UPP Channel Boolean 7 No
Maximum cutpart level [dBV] Double 13.78 No
Ear equalization String in) Mo
Bandlimit low [Hz] Double 40 HNo
Bandlimit high [Hz] Double 20000 ™
Flstness start at [Hz] Double 50 Mo
Flatness end at [Hz] Double 10000 No
Crossover Frequency [Hz] Double 120 Mo
Fatness Width [dE] Double q No
Min distance HATS to spaskar [m] Double 15 No
Max distance HATS to speaker [m] Double 5 No
Max level deviation [dB] Double 0.3 No
Max THD [dE] Double 20 No
Min Sound Pressure Level [dBspl] Double 20 No
Use Input Switcher UPZ. Boolean Trus Mo
Modify speaker delay Boolean True No
Additional delay FL [ms] Double o Mo
Additional delay RL [ms] Double 17 No
Additional delay FR [ms] Double 11 Mo
Additional delay RR [ms] Double 3 N
Max iterations during equalization Integer 3 No
Use Pink Noise for all equalizations Boolean True Mo
Pink MNoise level [dBspl(A)] Diouble 65 No
Pink Maise duration [s] Double 30 No
Pink Moise filename String PinkNoise 16Bit120sFilterad. wav No
Final test of all ambiances Boolean True No
Ignore uncritical level wamings Boolean False No
Action on final istness devistion Integer o No
Use All speaker Equalization Boolean True No
Al speaker Post-Equalization policy Integer Fast (recommended by R&S) No
Report i fiabe steps Boolean False No

Figure 4-55: Report Content: Test parameters

e  Calibration data (of HATS) used

Calibrations
Date/Time Usage Manufacturer  Type Serial Operator Value
05262014 1256:13 HATS Type 3.3 At Ear Defaut Lab D, Thomae A871dBre1V/Fa
Lechner
05262014 125639 Second Typs 3.3 Ant. Ear Defaut Lab D, Thomas 480168
Lechner

Figure 4-56: Report Content: HATS Calibration data

If the calibration process was aborted or partly skipped, only a subset of these data is
stored.

]
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If "Report intermediate steps" is activated in configuration window, additional graphs
and numeric values are stored which represent the iteration of single speaker
equalization, pair of speaker equalization and all speaker equalization. To avoid this
unnecessary information it is recommended to activate this option only for support
purposes.



R&S UPV-K9/-K92

5

5.1

5.2

Data Entry for Reporting

Data Entry for Reporting

Operator

Under "Data->Operator" an operator’s name can be entered which is stored in
association with all calibration and measurement results. If Operator is activated in the
report settings, the name will appear in all reports about these measurements.

Test object

Under "Data > Test object > New" a description of the device under test can be
entered.

Test Object

Mame

Type

b anufacturer

Senal Mumber

[ Immediately select this test object

Cancel | | Save and cloze

b

Figure 5-1: Window for input of information about a test object

If the checkbox" Immediately select this test object” is checked, the test object
associated with the entered data is automatically selected upon closing the window.
The data of this selected test object will be stored in association with all measurements
and appear on the associated reports if "DUT information" is activated in the report
settings.

A previously entered test object can be selected with "Data > Test object > Select".
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6

6.1

6.2

Measurements

Measurements

General

Special problems caused by the coding and decoding algorithms of mobile phones are
encountered when measuring acoustic characteristics. Vocoders are used to attain the
lowest possible data rate. Mobile phone voice codecs are optimized for transmitting
human speech with low data rate. Not the actual voice signals but only the filter and
fundamental parameters required for signal reconstruction are transmitted.

Purely sinusoidal tones normally used for audio measurements cannot be transmitted
with such a system. In commercially available mobile phones, no special test interface
is accessible which would allow to measure the acoustic performance of the mobile
without codec involved. Measurements during normal operation can therefore only be
performed via the air interface with the speech coder and decoder included.

The codec types specified for the use in CDMA2000 phones even do not transmit
complex artificial test signals like modulated multisine according to ITU-T P.501 or
artificial speech according to ITU-T P.50 with sufficient fidelity. Therefore TIA-1042 and
TIA-1042-A specify the use of natural speech.

Starting measurements

Measurements can be started from the "Measurement" menu. This menu contains
either all available measurements, or the measurements belonging to the selected
standard if the checkbox "Allow only selected measurements"” in the "Options = Select
standard window" is checked.

The menu “Standards” allows to start any measurement, whereby the measurements
are structured into submenus according to the standards to which they belong. This
allows a quick and easy access to all available measurements.

|Standards Config. Meas. Seguence Report Options  Help

TIA-1042:2005 +
TIA-1042:2005 and Auxiliaties

[ [ ardi | bl zin Bac it -
3 3GPPZ Receiving Handset ME, nom. Yal.
3 3GPPZ Receiving Handset ME, max. Yal.
TIA-1042-A-2013 Handset Wide 3 3GPPZ Receiving Handset ME, max. Yal., w. Limits
TIA-1042-A-2013 Handset Wide and Auxiliaries ¥ 3GPPZ Idle channel noise receiving, max. vol.
CDMAZKk HHHF Marrowe 3 3GPP2 Sending Handset Marrowband
»
3
»
3
3
3

COMAZk HHHF \Wide 3GPPZ Weighted Terminal Coupling Loss, ME
CDMAZK DTHF and YMHF Marrow 3GPPZ Idle Channel Maoise Sending NE
CDOMAZk DTHF and YMHF Wide 3GFRZ STIMR MB, Mominal Yolume Setting
Configurable Handset and Headset 3GPPZ STMR ME, All Wal, Steps

Configurable HandsFree 3GPPZ Talker Sidetone Delay

More ... 3GPPZ Delay ME, CHMU

3IGPP2 Talker Sidetore Delay U | :'B’ C';"W_ » e
3GPP2 Receiving Handset ME, nom, Vol UE 3GPP2 Speech Quality in Snd. in Presence of Ambient Moise NE
AZEET Idla channal maies racciving mau oal 1F = BACE ldla Mhamnal b aies R anai

Figure 6-1: "Standards" menu with submenu for narrow band handset tests according to TIA-1042-A-
2013

]
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6.3 Functionality and control of the measurement macros

@EDMA Sending Handset - |Ofx
10

Sending sensitivity [dB re 1%/Pa]

-30

40 I 1
100 1000 10000
Frequency [Hz]
E Measured, SLR = 9.00 dB . Mandatory lower limit E Desired lower limit
. I andatary upper limit E Dresired upper limit

| |Tyne 3.2 Low Leak ArtEa |CMU ZCRTU |Sampla test object \

Save curve as | Load curve

Figure 6-2: Example of a measurement window

Save curve ax

Enter
imilt file: measLremeant

Camrment

| Change Scale Create Repart Close

When a measurement macro is started, e.g. from the “Measurement” menu, the
standardized measurement is immediately executed. With a single measurement, the
window of the measurement macro stays open after the measurement is terminated. At
that time, the following functionality is available:

LT

Iz

Show Cursor

Zhange Scale

Daka Paink Size
Carnmerkt

Save Screenshok as ..

Figure 6-3: Context menu of the graph window

6.3.1 Zooming

When the “Shift” key on the keyboard is pressed, the mouse cursor changes to the
zoom cursor. When the left mouse button is pressed, a rectangle can be marked in the

graph. As soon as the left mouse button is released, the graph is zoomed into the area
of the marked rectangle

“Zoom Out” in the graph context menu reverses the last zooming step. “Unzoom”
zooms completely out to the original scaling.
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6.3.2 Changing the Scale of the Graph

“Change Scale” in the context menu opens a window in which the upper and lower
bounds of both axes can be entered by numbers.

@)Ehange Scale O

# MinirnLim # I aximLim
| 1 EIEI.IJIZI::I | 1 IZIEIEIEI.EIEI::I
t* MinirnLim Nl

| -EEI.EIEI::I | EI.EIEI::I
s | [0 ]
wd | o],

Figure 6-4: Window for changing the scale of the graph

6.3.3 Cursor

When the item “Show Cursor” is marked in the graph context menu, a cursor is
displayed which can be dragged along the graph with the mouse. X and Y values of
the data points below the cursor are displayed.

6.3.4 Data Point Size

“Data Point Size” in the graph context menu opens a window in which the size of
marks at the measured data points can be specified. Moving the mouse cursor over
one of the marks causes the associated X and Y values to be displayed.

6.3.5 Making Additional Measurements

The softkey “Add Measurement” triggers another measurement according to the
specification of the test. Loudness ratings and noise values are calculated and
displayed in the legend. However, limits are not checked, and the report shows only
the original results.

This function can e.g. be used to find the correct volume setting to pass nominal RLR.
It can further be used for adjustments in the device under test.

6.3.6 Storing and Loading Curves

All curves in the graph can be stored to an ASCII file, and such curves can be loaded

back into the graph. The softkey “Store Curve” opens a window in which a combo box
offers choice between the legends of all curves in the graph. The curve associated in

which the selected entry is stored to the file at the specified location.
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6.3.7

6.3.8

6.3.9

6.3.10

Measurements

Storing Curves as Limit Curves

With “Store As Limit Curve” a curve can be selected and stored into a R&S UPV format
limit file with a specified shift in Y axis direction. This functionality can be used to
generate limit curves from “golden” devices for evaluation purpose.

Entering a Comment

With the softkey “Enter Comment” or the item “Comment” in the graph context menu, a
comment can be entered and edited which will appear in the report about the
respective measurement.

Storing a Hardcopy of the Graph

With the menu item “Save Screenshot as ...” in the graph context menu, a hardcopy of
the current graph window with all numeric displays, legend etc. can be stored as
image. The current view of the graph including additional curves, current scaling and
size is copied. However, colors are inverted to a printer-friendly color set.

10
I | I I [ 1
SLR=883dE "|Pass | Mandatory Frequency Response Margln 4 50 dB “| Pass

L L1 | | | L

Y fTOlR=-%82 dB

| Desired Frequency Response Margln 3 97‘ dB

N

\
q

Sending sensitivity [dB re 1 V/Pa]

=30

'Pass

404 b .
1 DU 1000 10000
Frequency [Hz]

,/_\/ Measured, SLR = 883 dB W tdandatary lower limit W Desired lawer limit
W Mandatory upper limit ,/T/ Desired upper limit

Figure 6-5: Hardcopy of measurement graph

Creating a Report

The softkey “Create Report” causes a report to be prepared. The report preview
window (see Figure 9-3: Report preview window) opens and shows the preview of the
report. Buttons in the preview window allow to print the report or to export it to PDF,
WORD, EXCEL or Rich Text format.
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6.3.11

6.4

6.5

6.5.1

Measurements

Closing the Measurement Window

The softkey “Close” closes the measurement window. The control is returned to the
R&S UPV-K9 main window. All relevant data associated with the measurement is
imported to the results data. A new entry appears for the measurement as new row on
the bottom of the overview data grid in the main window.

Notes on Individual Measurements

Sending Frequency Response and Loudness Rating

Sending Frequency Response

The sending frequency response is specified as the transmission ratio in dB of the
voltage at the decoder output to the input noise pressure at the artificial mouth.

The mobile phone under test is installed in the LRGP (loudness rating guard-ring
position) according to ITU-T P.76, and the receiver is sealed to the artificial ear.

Natural speech with an active speech sound pressure level of -4.7 dBPa is created
with the artificial mouth at the MRP (mouth reference point), and the corresponding
output voltage spectrum is measured at the CMU speech decoder output and
compared to the reference spectrum obtained at the MRP.

The sending frequency response must be within the (floating) mandatory limit lines
specified according to table 2.2-1 of TIA-1042. The absolute sensitivity is not taken into
account.

Table 1 of TIA-1042 also specifies “desired” limit lines as a target for the acoustic
design, which, however, are not mandatory to be passed. The sending tests of

R&S UPV-K92 display also the desired limit template which is centered around the
measured frequency response curve independently from the mandatory template. A
verdict for the desired limit is also shown, which, however, does not influence the total
verdict of the test case. TIA-1042-A does not specify desired limit lines.

For each of the two templates, the offset of the measured frequency response to the
upper or lower limit line is calculated and then the whole limit template is shifted to be
centered with respect to the measured curve. Then another limit check is performed. If
the shifted curve is now within the limit lines, PASS is output, otherwise FAIL is
displayed. The limit check is performed at each measured frequency. If the measured
value and the end point of a limit line are not at the same frequency, it may happen
that the trace slightly crosses a corner of the limit line although there are no limit
violations. The remaining margin is displayed. A negative margin shows the amount of
limit violation.

]
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6.5.2 Sending Loudness Rating

The sending loudness rating (SLR) takes into account the absolute loudness in the
transmit direction and weights the tones in compliance with the normal sensitivity of the
average human ear.

To this end, for narrowband connections the frequencies (Hz) of bands 4 to 17 are
evaluated according to table 1 of ITU-T P.79. For wideband connections bands 1 to 20
are evaluated.

Table 5: Band centre frequencies according to ITU-T P.79

Band 1 2 3 4 5 6 7 8 9 10

fm/Hz | 100 125 160 200 250 315 400 500 630 800

Band 11 12 13 14 15 16 17 18 19 20

fm/Hz | 1000 1250 1600 2000 2500 3150 4000 5000 6300 8000

The sensitivity at each frequency is defined as the ratio dBV/Pa referenced to the rated
internal level in dBmO, and the sending loudness rating is calculated according to
formula 5-1 of ITU-T P.79. Note that loudness rating values are loss values, i.e. a high
loudness rating value indicates a low gain and a low loudness rating value indicates a
high gain.

Due to the input sensitivity tolerance of the CMU speech coder, the individual
sensitivity of the R&S CMU used has to be taken into account in order to calculate the
sending loudness rating (see calibration routines). According to TIA-1042, the sending
loudness rating should be between 6 dB and 19 dB, with lower dB values
corresponding to greater loudness (6 dB = maximum loudness, 19 dB = minimum
loudness). Target SLR should be 11 dB. In TIA-1042-A the SLR shall fall within the
range +11 dB to +5 dB. The measured SLR is indicated in a window in the frequency
response display and checked for compliance with these limits. In addition to the
numeric value, either PASS or FAIL is displayed.

The general PASS or FAIL information is obtained from the limit check of the frequency
response curve and the loudness rating. PASS is output only if both the curve and the
loudness value are within tolerances.

The AMPS version of this test (‘“AMPS Sending Handset”) automatically looks for
existing CDMA2000 results with the same mobile. If a result is found, the loudness
contrast is displayed and checked against the limit of £3 dB.

]
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< CDMA Sending Handset _[O]x
10

20

Sending sensitivity [dB re 1 %/Pa]

-an

40

1 1 1
100 1000 10000
Frequency [Hz]

B Measured, SLA = 9.00 dB . Mandatary lower limit m Desired lawer limit
. M andatory upper limit E Desired upper limit

| |Type 3.2 Low Leak ArtEa |EMU JCRTU |5amp|e test object |

Save curve as | Load curve

Figure 6-6: Sending frequency response with SLR value displayed
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lirnit file:

Enter
Comment

measurement Change Scale Create Report Cloge

6.6 Receiving Frequency Response and Loudness Rating

The following two measurement definitions are available, as the permissible limit
values of the loudness rating depend on the volume set in the mobile phone under test:
“CDMA Receiving Handset, nom. Vol.” checks loudness rating limits for nominal
loudness setting and at the same time compliance with the frequency response limit
template. “CDMA Receiving Handset, max. Vol.” checks the receiving loudness rating
at the highest volume setting against a minimum.

As the loudness rating is a loss value, a high RLR is associated with a soft speech
signal and a low RLR is associated with a loud speech signal

6.6.1 Receiving Frequency Response

The receiving frequency response is specified as the transmission ratio in dB of the
sound pressure in the artificial ear to the input voltage at the speech coder input of the
R&S CMU. The measured sound pressure is referenced to the ear reference point
(ERP). For ear types 3.x, the measuring microphone is applied to the drum reference
point (DRP), which is the reason why any measured value has to be converted to the
ERP by means of calibration factors. According to TIA-1042, the measurement must
be referenced to the ear reference point (ERP). For information only there are separate
measurements supplied with R&S UPV-K92 which measure referenced to the DRP.
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The mobile phone under test is installed in the LRGP (ITU-T P.76) or on the HATS. In
case of ear type 3.2, the receiver is sealed to the rubber gasket of the artificial ear. If

the low leak version of this ear type is used, care must be taken that the defined leak

opening at the circumference of the artificial ear is not accidentally covered.

The speech coder is driven such that the received speech has an active level
of -19 dBmO (TIA-1042) or -16 dBmO (TIA-1042-A) on the digital side. The sound
pressure in the artificial ear is measured and evaluated.

Ear type 1 is not specified in TIA-1042 for measurements on CDMA2000 mobile
phones. TIA-1042-A mandates the use of ear type 3.3 for receiving tests.

The receiving frequency response must be within the (floating) mandatory limit lines
specified according to Table 1 of TIA-1042 or TIA-1042-A, respectively. The absolute
sensitivity is not taken into account.

Table 1 of TIA-1042 also specifies “desired” limit lines as a target for the acoustic
design, which, however, are not mandatory to be passed. The receiving tests of

R&S UPV-K92 display also the desired limit template which is centred around the
measured frequency response curve independently from the mandatory template. A
verdict for the desired limit is also shown, which, however, does not influence the total
verdict of the test case. TIA-1042-A does not specify desired limit lines.

For each template, The margins of the measured frequency response to the upper and
lower limit lines are calculated separately, and then the whole template is shifted such
that the resulting margins to upper and lower limit are equal. Then another limit check
is performed. If the shifted curve is now within the limit lines, PASS is output, otherwise
FAIL is displayed. The limit check is performed at each measured frequency. If the
measured value and the end point of a limit line are not at the same frequency, it may
happen that the trace slightly crosses a corner of the limit line although there are no
limit violations. The remaining margin is displayed. A negative margin shows the
amount of limit violation.

6.6.2 Receiving Loudness Rating

The receiving loudness rating (RLR) takes into account the absolute loudness in the
receive direction and weights the tones in compliance with the difference between an
average speech spectrum and the normal threshold of hearing in quiet of the average
human ear.

To this end, for narrowband connections bands 4 to 17 are evaluated according to
table 1 of ITU-T P.79. For wideband connections bands 1 to 20 are evaluated.

The sensitivity at each frequency is specified as the ratio dBPa/V referenced to the
rated internal level, and the receiving loudness rating is calculated according to formula
5-1 of ITU-T P.79.

Due to the input sensitivity tolerance of the speech encoder, the individual sensitivity of
the encoder input used has to be taken into account in order to calculate the receiving
loudness rating, see section Calibration on page 38.

The receiving loudness rating depends on the receiving loudness set on the mobile
phone under test and, according to TIA-1042, should be between -5 dB and +5 dB at a
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rated nominal loudness setting, with lower dB values corresponding to a higher
loudness. According to TIA-1042-A, the RLR shall be between -1 dB and +5 dB, and
the nominal target value should be 2 dB.

To prevent damage to the human ear, the maximum receiving loudness must not
exceed a certain value. With the user volume setting of the mobile unter test set to
maximum, the RLR must not fall below -18 dB according to TIA-1042 and it shall not
be less (louder) than -13 dB according to TIA-1042-A.

The measured RLR is indicated in a window in the frequency response display and

checked for compliance with these limits. In addition to the numeric value, either PASS
or FAIL is displayed.

According to TIA-1042-A, the RLR with the receive volume control set to minimum
shall not be higher (quieter) than 18 dB.

The AMPS version of this test (“AMPS Receiving Handset”) automatically looks for
existing CDMA2000 results with the same mobile and same volume control setting. If a

result is found, the loudness contrast is displayed and checked against the limit of £3
dB.

@EDMA Receiving Handset, nom. Yol. 9 =] 3
30

20

Receiving sensitivity [dB re 1 Pa/\]

20 I |
100 1000 10000
Frequency [Hz]

E Meazured, RLR = 2.62 dB . hdandatary lower limit E Desired lower limit
. andatory upper limit m Desired upper limit

| [Type 3.2 Low Leak AEa CMU / CRTU \Sample test obisct \

Save curve az | Load curve

Figure 6-7: Receiving frequency response with RLR value displayed

Save curve as
lirnit il

Enter

o Change Scale Create Report Close

id
MEasWEMEant

6.7 Wideband to Narrowband Loudness Contrast

For a mobile phone supporting both narrowband and wideband speech and tested
according to TIA-1042-A, the differences between the sending loudness ratings in
wideband mode and narrowband mode and the differences between the receiving
loudness ratings in wideband and narrowband mode have to be reported as wideband
to narrowband loudness contrast.
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For this purpose the R&S UPV-K9y program provides a pseudo measurement which
does not really perform a measurement on the mobile phone under test, but collects
the loudness ratings from the result database and calculates the difference. The
evaluated loudness ratings must be measured with the currently selected device under
test. If more than one result exists for a specific loudness rating of this device under
test, the latest result is used.

6.8 Weighted Terminal Coupling Loss (TCLw)

The echo loss is the attenuation between the speech coder input and the speech
decoder output (gain of speech coder + decoder = 1). Normally the echo loss is caused
by internal acoustic coupling between the telephone receiver and the microphone.
Since the echo considerably reduces the sound transmission quality, it must not
exceed a certain value.

The mobile phone under test is positioned according to one of the options listed in
IEEE Std 269-2002. These options comprise the handset to be mounted on the ear
simulator used for the receiving measurements, suspended in free air under anechoic
conditions or facing a hard, smooth surface free of any obstacles for at least 500 mm.
The positioning of the mobile for this test will greatly influence the result. Hence it
should be noted, e.g. as comment in the measurement result.

Artificial speech “Echoloss” is used as test signal and applied to the speech coder. The
spectral energy distribution of the generated signal is measured in the third-octave
bands from 200 Hz to 4 kHz. At the same time, the spectral distribution in the output
signal of the speech decoder is measured. The echo loss is calculated from the
differences of the bands according to ITU-T G.122.

The actual gain of the speech coder and decoder must also be considered in the
result. This value is available in the R&S CMU after calibration of the coder. In addition,
the attenuation of the echo path is displayed as a curve.

TIA-1042 specifies a TCLw of at least 45 dB; mobile phones with good echo cancellers
can meet this requirement. Since the microphone of the mobile phone under test also
picks up any side noise and treats it like an echo, it is essential that the test chamber is
well shielded against external noise.
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Figure 6-8: Typical result of echo loss measurement
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6.9 Peak Acoustic Pressure Level

To avoid damage to the ear in use of the mobile phone, the maximum sound pressure
level generated by the earpiece in the ear of the user should be limited. IEC 60950-1
specifies a respective test using the test signal “PeakLevel”, a heavily clipped artificial
signal which is designed to produce a high output level at the speech decoder. The
maximum sound pressure level obtained in the measurement is checked against a
maximum of 42 dBPa (136 dB relative to 20 yPa) as specified in IEC 60950-1.

If a receive volume control is provided at the mobile, this test should be performed with
maximum volume setting.

Operating Manual 1402.0643.12 - 03 85



R&S UPV-K9/-K92

6.10

Measurements

@EDMA Peak Acoustic Pressure Level =1o]x]

Peak acoustic pressure level = 14.42 dBPa

Peak acoustic pressure level <= 42 dBPa
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Figure 6-9: Typical result of peak acoustic measurement

Sidetone Masking Rating (STMR)

This test is not specified in TIA-1042. In this standard it is provided for reference only.

The sidetone path is the deliberate output of a part of the signal picked up by the
microphone to the phone's receiver. This is to create a natural hearing impression for
the person speaking on the phone as is encountered under normal conditions involving
an acoustic path between mouth and ear.

If an artificial ear type 3.2 is used (TIA-1042), the mobile phone under test is installed
in the LRGP (ITU-T P.76), and the receiver is sealed to the artificial ear. According to
TIA-1042-A the mobile phone is mounted on the HATS

The artificial mouth generates a test signal with a sound pressure of -4.7 dBPa at the
MRP (mouth reference point), and the sound pressure is measured in the artificial ear.
In the test according to TIA-1042-A, real speech is used as test signal. In the
measurement provided for reference for use with TIA-1042, the test signal is a
modulated multisine.

The attenuation of the sidetone path is determined at each frequency according to
table 1 of ITU-T P.79, and the sidetone masking rating (STMR) is calculated according
to formula 5-1 of ITU-T P.79 with the weighting factors of table 3 of ITU-T P.79 taken
into account. In addition, the gain of the sidetone path is displayed as a curve.

According to TIA-1042-A the STMR shall be between 15 dB and 23 dB for the nominal
setting of the volume control. For all other positions of the volume control, the STMR
shall be = 10 dB.
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Figure 6-10: Typical Measurement of sidetone masking rating
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6.11 Stability Margin

This test is provided for reference only. It is not specified in TIA-1042 nor in TIA-1042-
A.

The stability margin is measured to test the susceptibility of the phone to acoustic
feedback and instability.

For the test, the telephone is placed on an even, hard board with the receiver and
microphone pointing downwards.

A loop is closed in the R&S UPV between the receiving and the voice channel, and an
overall gain of 6 dB is set. The gain of the coder is automatically taken into account
(see also Echo Loss).

To activate the loop, a noise signal of -10 dBmO in line with ITU-T 0.131 is applied for
1 s and then switched off, with the loop remaining closed.
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The test person has to listen to determine whether any resonances or oscillations are
produced. If there are no oscillations, the minimum requirements according to 3GPP
TS 26.131 for a stability margin of 6 dB are met.

Stability Loss

This test is not specified in TIA-1042 or TIA-1042-A. It is provided as an auxiliary
measurement for reference.

From release 10 of 3GPP TS 26.132, the stability margin test case is replaced by a
stability loss test case. The test measured the attenuation between input and output of
the system simulator, similar to the echo loss measurement. Other than with the echo
loss measurement, the result is not integrated over frequency, but the spectral
minimum is searched.

The test routine first looks for valid delay results of the selected device under test in
sending and receiving direction. If no results are found, or if the delay results are older
than specified in the parameters of this measurement, the UE has to be first mounted
on the HATS for the delay measurements.

When valid delay values are available, the mobile has to be set up according to the
following illustration:

]
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Figure 6-12: Test setup for stability loss test

As soon as the operator has acknowledged the UE to be correctly placed, a PN signal
with high rms level is send to the network interface, and the returned signal at the
output of the system simulator after the roundtrip delay is measured. The spectral
attenuation is calculated from the difference of the level spectra.
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A second measurement is performed without test signal to show the noise “floor” of the
measurement. As the graph plots the path loss, the noise-induced result will usually be
above the stability loss result.

6.13 Echo Control Characteristics

This test is not specified in TIA-1042 or TIA-1042-A. It is provided as an auxiliary
measurement for reference.

The “Echo Control Characteristics” test has been added to 3GPP TS 26.132 in
Release 11. It requires update key R&S UPV-K9201 and option second analog
generator (R&S UPV-B3). It is a so-called “double-talk” test in which test signals are
sent in both uplink and downlink direction simultaneously. The signal sent by the
mobile to the network simulator is analyzed.

The uplink signal contains a section with single words separated by pauses (“single
near-end words”) and a section with continuous talk (“continuous double-talk”). These
sections are analysed separately.

In a first run, both uplink and downlink signals are played simultaneously. In a second
run only the uplink signal is played while the downlink path is silent. The level
difference between both situations is analyzed in frames of 5 ms. The results are
summarized separately for the following two categories:

“Double-talk” frames are defined as the frames where both the far-end (receiving
direction) signal includes active speech (extended with a hang-over period of 200 ms)
and the near-end signal is composed of active speech.

“Far-end single-talk adjacent to double-talk” frames are similarly defined as the frames
with active far-end speech and no active near-end speech.

The test method measures the duration of any level difference between the sending
signal of a double-talk sequence (where the echo canceller has been exposed to
simultaneous echo and near-end speech) and the sending signal of the same near-end
speech only. The level difference is classified for each of the two situations (with and
without simultaneous downlink signal) and for each of the two classified frame
categories separately into eight categories according to the following figure and table:

]
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Figure 6-14: Classification of level differences and their duration into categories

Table 6: Description of categories

Cat Level difference (AL) | Duration (D) Description

Al -4dB<AL<4dB Full-duplex and full transparency

A2 -15dB<AL<-4dB Full-duplex with level loss in Tx

B AL <-15dB D <25ms Very short clipping

C AL <-15dB 25ms <D <150 ms Short clipping resulting in loss of syllables
D AL <-15dB D =150 ms Clipping resulting in loss of words

E AL =24 dB D<25ms Very short residual echo

F AL =4 dB 25ms <D <150 ms Echo bursts

G AL =4 dB D =150 ms Continuous echo

For each category, the ratio of frames in this category to the total number of frames is
given, as well as the average level difference.

]
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Figure 6-15: Result screen of the "Echo Control Characteristics" test
Interpretation of the results:

A positive level difference means that the level of the signal sent by the mobile is
higher with simultaneous downlink speech than without. This is an indication of echo.

Short duration (category E) indicated short echo bursts.
Long duration (category G) indicates continuous echo.
A negative level difference is an indication of clipped uplink speech.

Short duration (category B) indicates short clipping, e.g. at the start of sentences or
words.

Medium duration (category C) indicates loss of syllables.

Long duration (category D) indicates continuous high attenuation.

6.14 Sending Distortion

This test is provided for reference only. It is not specified in TIA-1042 nor in TIA-1042-
A.

The mobile phone under test is installed in the LRGP or on the HATS.

There are two versions of this test according to 3GPP TS 26.132. The earlier version is
valid up to release 8 and provided as auxiliary measurement to TIA-1042. The latest
version is valid from release 9 and provided as auxiliary measurement to TIA-1042-A.

A pulsed sinusoidal tone with a pulse length of approx. 360 ms is used for the
measurement.

]
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For tests according to the earlier version, the frequency of the tone is 1015 Hz. At this
frequency, coding yields a sufficiently stable output signal. Voice activity detection
continues to be active in the mobile phone under test due to this pulsating signal.

The test signal is generated with the artificial mouth at the MRP (mouth reference
point) and the SINAD value of the received signal is measured at the R&S CMU200
decoder output.

The acoustic reference level (ARL) is defined as the sound pressure which creates a
signal level of -10 dBmO in the transmit channel. In the earlier version, an automatic
routine varies the sound pressure at the artificial mouth until the desired level is
attained. This value is then used as a reference for determining the SINAD value
versus level. The SINAD value is measured at sound pressures between -35 dB and
+10 dB relative to the acoustic reference level (ARL) and compared with the limits
specified in table 7 of 26.131 of 3GPP.

Signal processing of a modern mobile phone comprises a voice activity detector which
determines whether a voice signal is present or whether the sending signal just
comprises background noise. For this reason the sending distortion measurement
omits levels below -25 dB and starts at high test tone levels gradually reducing the
level.

The measurement is performed up to a maximum sound pressure of 10 dBPa at the
artificial mouth if the value 10 dB relative to ARL with 10 dBPa cannot be attained. The
actual trace may therefore end at a lower pressure. This occurs for mobile phones
under test which have a low sensitivity in the transmit direction.

If the measured trace is above the limit line, PASS is output, otherwise FAIL is
displayed.
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Figure 6-16: Sending distortion measurement

Enter

Save Curve s
Camrment

d
Limit File | MeEsurETE Dielete Curve Create Report Cloze

Operating Manual 1402.0643.12 - 03 93



R&S UPV-K9/-K92

Measurements

In the latest version of this test, additional measurements are performed at the
frequencies of 315 Hz, 408 Hz, 510 Hz and 816 Hz with a SPL of -4.7 dBPa at the
MRP. Other than in the previous version of the test, the levels are not defined relative
to ARL, but as absolute SPL at the MRP. A CSS activation signal is issued before each
measurement to activate the VAD (voice activity detector) of the mobile under test.
Alternatively an activation signal specified by the terminal manufacturer may be used.
To avoid an impact of the activation signal on the result due to the processing delay in
the transmission chain, the test routine comprises a delay measurement. The start of
the analysis is delayed against the start of the test signal by the measured delay time.
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Figure 6-17: Recommended activation signal according to the latest version of the sending

distorsion test
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Figure 6-18: Sending distorsion measurement for wideband according to the latest version od the

test
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The UPV-K9y software provides the CSS activation signal as a default. However,
before first use the signal has to be imported using “Options - Activation Signal >
Import” (see Preparation and Start of the Application Software on page 10). This step
checks the conditions on the wav file and calculates the active level of the signal. With
the same menu item also other wave files can be imported for use as activation signal.
The wav files must be mono with 48 kHz sampling frequency and have a duration of 10
seconds or less.

For the sending direction the activation signal must be pre-equalized according to the
inverse frequency response of the artificial mouth. This can be done during import of
the wav file. After a re-calibration of the artificial mouth, the equalization has become
obsolete and has to be re-done. The macro for the test case automatically detects an
obsolete equalization of the activation signal and does a new equalization before the
test is started.

If more than one activation signal is imported at the same time, the signal to be used
can be globally chosen with menu item “Options > Activation Signal - Select”. In
addition, the measurement definition for this test case has a parameter to specify the
file name without extension of the activation signal to be used. If this parameter is
provided, it overrides the global choice of the activation signal. Thus the test can be
repeated several times within a sequence, using different activation signals.

The test macro for distortion tests with activation signals from wav files also provides a
spectrum display of the signal sent by the mobile. This is provided for information e.g.
for troubleshooting purpose.

Receiving Distortion

This test is provided for reference only. It is not specified in TIA-1042 nor in TIA-1042-
A.

The mobile phone under test is installed in the LRGP (ITU-T P.76) with the receiver
sealed to the artificial ear, or on the HATS.

The SINAD ratio in the receiving path is measured as a function of the acoustic signal
level.

There are two versions of this test according to 3GPP TS 26.132. The earlier version is
valid up to release 8 of 3GPP TS 26.132 and provided as auxiliary measurement to
TIA-1042. The latest version is valid from release 9 of TS 26.132 and provided as
auxiliary measurement to TIA-1042-A.

A pulsed sinusoidal tone is used for the measurement.

For tests according to up to release 8 (narrowband) and up to release 7 (wideband),
the frequency of the tone is 1015 Hz. For measurements according to later releases
the frequency is 1020 Hz (see also Table 12 below). At these frequencies, coding
yields a sufficiently stable output signal.

Voice activity detection continues to be active due to this pulsating signal.

]
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The test signal is applied to the input of the speech coder, and the SINAD value of the
sound pressure in the artificial ear is measured with psophometric weighting according
to ITU-T G.714.

The SINAD value of the sound pressure is measured at levels between
-45 dBmO0 and 0.

The measurement is performed up to a maximum sound pressure of 10 dBPa in the
artificial ear; the actual trace may end at an earlier point if this maximum sound
pressure is reached.

If the operator desires to see the receiving distortion value at the point exceeding

10 dBPa, this can be achieved by pressing the “add measurement” button. This causes
the measurement to be repeated at all specified levels. The second measurement is
not taken into account for reporting and Pass/Fail decision.
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Figure 6-19: Typical result of receiving distortion measurement
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For tests according to the latest version, additional measurements are performed at the
frequencies of 315 Hz, 408 Hz, 510 Hz and 816 Hz with a digital level of -16 dBmO at
the network interface (encoder input). An activation signal precedes the test signal. To
avoid an impact of the activation signal on the result due to the processing delay in the
transmission chain, the test routine comprises a delay measurement. The start of the
analysis is delayed against the start of the test signal by the measured delay time.
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Figure 6-20: Typical result of receiving distorsion measurement in wideband according to release 8
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A CSS activation signal is recommended. Alternatively an activation signal specified by
the terminal manufacturer may be used.

The R&S UPV-K9y software provides the CSS activation signal as a default. However,
before first use the signal has to be imported using “Options - Activation Signal >
Import” (see Preparation and Start of the Application Software on page 10). This step
checks the conditions on the wav file and calculates the active level of the signal. With
the same menu item also other wave files can be imported for use as activation signal.
The wav files must be mono with 48 kHz sampling frequency and have a duration of 10
seconds or less.

If more than one activation signal is imported at the same time, the signal to be used
can be globally chosen with menu item “Options > Activation Signal - Select”. In
addition, the measurement definition for this test case has a parameter to specify the
file name of the activation signal to be used (without extension). If this parameter is
provided, it overrides the global choice of the activation signal. Thus the test can be
repeated several times within a sequence, using different activation signals.

The test macro for distortion tests with activation signals from wav files also provides a
spectrum display of the signal output at the earpiece of the mobile. This is provided for
information e.g. for troubleshooting purpose.
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Figure 6-21: Spectrum display of the receiving distortion test

During the test, the latest spectrum is displayed. After the test has finished, button
“Show Spectrum” or “Hide Spectrum”, respectively, toggles between spectrum display
and result display. In this state the spectra to be displayed can be configured in the
context menu of the graph, and the spectra can be exported to ASCII files.

6.16 Idle Channel Noise Sending

In TIA-1042 this test is provided for reference only.

The noise voltage at the speech decoder output is measured with the phone set up in a
quiet environment (<30 dB(A)).

When using a type 3.2 ear, the mobile phone under test is installed in the LRGP (ITU-T
P.76). When using a type 3.3 ear, the mobile phone under test is mounted on the
HATS.

The decoder output voltage is measured, weighted psophometrically according to ITU-
T G.223 and recalculated for the internal level in dBmOp.

To keep the mobile phone under test in the normal operating mode, a pulsed signal is
applied. The noise level is measured during the signal pauses. The voice activity
decoder (VAD) is activated and the mobile phone remains in the active normal sending
mode.

The idle noise level should not exceed -64 dBmOp. The measured noise voltage is also
displayed as a spectrum, making it easier to find causes if the limit value is exceeded.

]
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Figure 6-22: Typical result of sending noise measurement
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In TIA-1042-A a newer version of this test is provided, using a CSS activation signal.
When measuring a narrowband correction, the noise is psophometrically weighted. In a
wideband measurement, the noise is A-weighted.

Idle Channel Noise Receiving

In TIA-1042 this test is provided for reference only.

The sound pressure in the artificial ear is measured with the phone set up in a quiet
environment.

When using a type 3.2 ear, the mobile phone under test is installed in the LRGP (ITU-T
P.76), and the receiver is sealed to the artificial ear. When using a type 3.3 ear, the
mobile phone under test is mounted on the HATS.

The sound pressure in the artificial ear is measured with A-weighting on.

To keep the mobile phone under test in the normal operating mode, a pulsed signal is
applied to the speech coder input. The noise level is measured during the signal
pauses. The voice activity decoder is activated and the mobile phone remains in the
active normal receiving mode.

With rated loudness set on the mobile phone, the sound pressure should not exceed -
57 dBPa(A). In this case use test “3GPP Idle channel noise receiving, nom. Vol”.

At maximum receiving loudness, the sound pressure should not exceed -54 dBPa(A).
In this case use test “3GPP Idle channel noise receiving, max. Vol.”.

The measured noise voltage is also displayed as a spectrum, making it easier to find
causes if the limit value is exceeded.
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Figure 6-23: Typical result of receiving noise measurement
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This measurement makes high demands on the sound insulation of the test chamber
and the S/N ratio of the measuring microphone including preamplifier in the artificial
ear. A comparison measurement with the test mobile phone switched off or without a
DUT shows the measurement reserves of the test equipment. Due to the low inherent
noise of the Audio Analyzer R&S UPV, measurements can be made to about -

80 dBPa(A) at 0 dB microphone gain, and even to lower values when a higher
microphone gain is set.

In TIA-1042-A a newer version of this test is provided, using a CSS activation signal.

6.18 Talker Sidetone Delay

The sidetone delay measurement is specified in TIA-1042-A only.

The sidetone delay is measured by cross-correlation between the electric input signal
to the artificial mouth and the electric signal from the artificial ear. The sidetone delay is
defined as difference between first and second maximum of the cross-correlation
envelope.

Test signal is a short word “five” of real speech according to ITU-T P.501. Before the
test, the test signal is offline-filtered according to the mouth speaker equalization curve
obtained during mouth calibration. This offline filtering is only performed when the valid
speaker equalization curve is newer than the file with the filtered test signal.
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Figure 6-24: Typical sidetone delay result according to release 10
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6.19 Mobile Station Delay

In TIA-1042-A the measurement of the roundtrip delay is required. The roundtrip delay
is defined as the sum of the contributions of the UE under test to the uplink and
downlink end-to-end delay. To obtain the roundtrip delay value, the end-to-end delay
can either be measured separately for uplink and downlink, or the loopback delay can
be measured by establishing a loopback of the voice data in the system simulator. In
both cases the contribution of the system simulator has to be subtracted from the
measured end-to-end delay. The method specified in TIA-1042-A is using the loopback
in the network simulator. Roundtrip delay measured separately in uplink and downlink
is provided as auxiliary test.
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Figure 6-25: Typical roundtrip delay result
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The loopback delay is measured by cross-correlation between the generator output
signal and the analyser input signal.

Test signal is a short word “five” of real speech according to ITU-T P.501.

For system simulator R&S CMU200, an estimated processing delay is subtracted for
loopback or each direction, respectively. For system simulator R&S CMW500, the
actual processing delay of speech data inside the instrument is determined at the time
of the test. For this purpose a remote control connection must be established between
R&S UPV and R&S CMW500. See “CMW remote control” in the “Options” menu. The
R&S UPV-K9 program controls the R&S CMW500 to start and stop the internal delay
measurement, and queries the result for the internal processing delay via the remote
control connection.
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6.20 Speech Quality in Presence of Ambient Noise

6.20.1 Setup

St conooe
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Figure 6-26: Test setup and connection of external components with R&S CMW500 and input
switcher R&S UPZ for measurement "Speech Quality in Presence of Background Noise"

The arrangement of the elements in the block schematic does not reflect the physical
setup in the test room. See ETSI ES 202396-1 for details on the requirements for the
test room and the speaker setup. For the speaker positioning the following rules and
advice apply:

The four full-range speakers are to be arranged in a square

Distance of each of the four full-range speakers from the center of the HATS is 2m
Avoid positioning any speaker in any of the room corners

Avoid positioning of speakers including subwoofer or HATS exactly

in the room center or at one half, one third or one fourth of the room length or
width

6.20.2 Connections

Connect
LAN socket of R&S UPV to LAN socket of R&S UPP
R&S UPP trigger output to R&S UPV trigger input
R&S UPP-Z8A output 3 to input of front left active speaker

1

2

3

4. R&S UPP-Z8A output 4 to input of rear left active speaker
5. R&S UPP-Z8A output 5 to input of front right active speaker
6

R&S UPP-Z8A output 6 to input of rear right active speaker

]
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7. R&S UPP-Z8A configured subwoofer output (by default 7) to input of active
subwoofer

8. R&S UPV generator output 1 to artificial mouth via drive amplifier
9. Atrtificial ears to microphone power supply during noise field calibration

10. During the acquisition for the speech quality evaluation, a ¥2” microphone is
connected to R&S UPV analyzer input 1 via the microphone power supply

11. Output 1 of the R&S CMU / R&S CMW to R&S UPV analyzer input 2.

6.20.3 Switcher Support

If 'Input Switcher UPZ" is enabled in 'Noise Calibration Configuration’, the
measurement will try to connect all required signal sources automatically to R&S UPV
input instead of prompting user to change cabling. This presumes:

e R&S UPV is connected to R&S UPZ via serial cable (RS232) OR USB cable (do
not connect USB if you want to use RS232);

e  USB-to-serial device driver is installed (only if using USB connection);

e R&S UPZis powered ON (green 'ON'-LED on switcher front panel)

When starting the measurement the first time, a dialogue is displayed to instruct the
user how to connect the input switcher's analogue input and output connections

only 1 microphone needs to be connected to input channel 4 or 5, respectively

Sniitcher UPL =

Please connect input switcher UPZ to UPW:

- swyitcher output channel 1to UPY analog input channel 1

- switcher output channel 2 to UPY analog input channel 2

Please connect switcher input channels

- connect HATS output left ear to UPZ input channel 1

- connect HATS output right ear to UPZ input channel 2

- connect decoder output (ChW, Chill or CBT) to UPZ input channel 3
- connect free field reference microphone to UPZ input channel 4

- connect diffuse field reference microphone to UPZ input channel 5

- connect UPP-B3 output channel 10 to UPZ input channel &

Ok

Figure 6-27: Switcher support, analogue connection instructions

or — if no switcher could be detected — how to establish the control connection from
R&S UPV to R&S UPZ:
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6.20.4

6.20.5

Measurements

Swiitcher UPE ==

Input Switcher UPZ not connected or switched off, Please check

- USE or Serial connection must be established between UPY and UPZ

- Powver cable must be connected to UPZ

- UPZ must be turned OM (rear panel)

- if using COM interface 'Used for' must be setto "Switcher' (Config Panel
- if using U3E interface 'USE Serial Port' device driver must be installed
'‘Cancel will continue without switcher; cabling rmust be done manually!

Retry Cancel

Figure 6-28: Switcher support, control connection instructions

If the switcher cannot be enabled at this point, then “Cancel” will disable switcher for
the current measurement. The cabling has to be done manually. The corresponding
setting in configuration window will not be changed. On next start of this measurement
it will again be attempted to use the switcher.

The measurement checks the connection to R&S UPZ whenever the switcher needs to
be operated. If switcher control fails while measurement is running (e.g. by unplugging
the control or power cable), the operator will be prompted to establish the analogue
connections manually. This allows the measurement to continue correctly.

Switcher UPZ [

Switcher not available; please establish UMY input connections manually:
- connect UPP-BE output channel 10 to UMY analog input channel 1
- connect HATS output right ear to UPY analog input channel 2

Ok

Figure 6-29: Switcher support, error message if switcher failed during measurement

Prerequisites

e Reference Microphone Calibration
e Artificial Mouth Calibration

e Codec Calibration

e Noise Field Calibration
Measurement

Place the reference microphone close to the opening of the UE’s main microphone.

Start the test case from the “Measurement” or “Standard” menu. The test will start right
away in the following processing order:
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1. For each ambiance, measurement of uplink delay and checking if established call
still is alive

For each ambiance, recording the raw signals
For each ambiance, checking again if established call still is alive

Pre-processing all recordings for calculation

o M 0D

Processing of the acquired signals with simultaneous display of the results
according to the progress, including the “PASS/FAIL” criteria.

6. Deleting of temporary files.

A typical image showing the completion of steps 1-3 looks like following:

Total Verdict =

Figure 6-30: Running "Speech Quality in Presence of Background Noise" - all recordings are just
done

Pub_Noise_V2
Qutside_Traffic_Road
Qutside_Traffic_Crossmads
Train_Station
Fullsize_Car1_130Kmh
Cafeteria_Noise
Mensa

Work_MNoise_Office_Callcenter

Each recording resp. calculation can be repeated by clicking “Repeat current
sequence” in the status box:

Es)

ﬂl Measuring ﬁ

speech with Pub_Noise_ W2

‘ Cancel J

Repeat current seguence |

Figure 6-31: Busy message of "Speech Quality in Presence of Background Noise" with Pause,
Emergency Off, Cancel, Repeat

The “cancel” button cancels the complete measurement.

The “repeat ... sequence” button repeats the current step. This may be a delay
measurement, a recording of a specific noise ambiance or its calculation.
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6.20.6

Measurements

The “crossed speaker” symbol button stops the playback of the noise and test signal
and aborts the current acquisition which can be repeated thereafter.

The “pause” button symbol suspends execution and shows a message box which will
allow cancelling or continuing the measurement:

J

EX3)

Execution of sequence has been suspended.
Would you like to continue now? L

0K | Cancel

Figure 6-32: Message after the measurement execution has been suspended

When all recordings are done, the calculation process starts. For each ambiance, the
3QUEST batch calculator will be started with the preprocessed recordings.

Results are S-MOS, N-MOS and G-MOS for each ambiance and overall average. The
coloured values are the averages over all sentences, and the grey values are the
standard deviations between the sentences.

Depending of the predefined PASS / FAIL criteria, the result values will be coloured in
green or red. The total verdict is “Fail” if the average of all S-MOS-LQO is below 3.0 or
the average of all N-MOS-LQO is below 2.5 or the average of all G-MOS-LQO is below
2.5.

Continuing broken Measurements

When a measurement has been cancelled by “Cancel” for some reason and the
“Speech Quality in Presence of Ambient Noise” window has been closed, there is a
possibility of recovering the already existing recording within 1 hour after abortion of
the measurement.

When opening the measurement window again, the software will try to find the raw
data for each ambiance signal which has been recorded during the last hour with exact
the same settings like the current.

If raw data is found, the software will ask the user to reuse it for each ambiance:
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orse Field Averogealues - - - -

Pub_Moise_V2

Outside_Traffic_Road
Qutside_Traffic_Crossmads

recent measurement

A recent measurement for ambiance Outside_Traffic_Crossroads was found.
Do you want to keep the raw data of it 7

Cancel

Total Verdict =

sending delay

Figure 6-33: Recovering raw data from last "Speech Quality in Presence of Background Noise"
measurement

6.20.7 Typical Problems during measurement

In practice it can happen that a mobile under test drops the call after a few minutes.

Since the recording of the signals takes a quite long time and often runs without
supervision, the software contains a security check if the call still is alive:

1. Before any recording will be started, the current signal delay and signal level is
detected. If the signal level is below a lower limit, the measurement stops and
allows a retry.

2. After a recording is done the signal level is detected again. If the level is below a
lower limit, the measurement stops, too.

In both cases following message box appears:

Sending Delay 3

'.6.' sending delay measurement failed!

The measured signal level of 0.0002V
exceeds the minimum of 0.1V

- check the connection between CMU/CMW and UPY
- check if the call is set up.

Abort | Retry Ignare

Figure 6-34: Common Problem 1: "Speech Quality in Presence of Background Noise" detected lost
call

“Retry” will repeat the current noise ambiance measurement (e.g. after resetting the
call), “Ignore” will skip this measurement and continue with the next one (e.g. during a
demo if the result does not matter), “Abort” will cancel the measurement.
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A second problem may occur when the recordings are all done and the calculation
process is started: The 3QUEST does not find its license. This typically would look like
this:

| § ¥ § N |

se V&

. ®
affic_ HEAD acoustics

L]
c_Cry
Error =]

'nols EAD 3 ‘

. Mo license for HEAD 3QUEST-Batch found!
1_13| Version:

PN

_Noij ﬂl Measuring ﬁ

calculating MOS values

Retrieving

| Cancel |

Total Verdict

Repest current seguence |

Figure 6-35: Common Problem 2: "Speech Quality in Presence of Background Noise" running
3QUEST with missing License dongle

There may be two reasons for it:

e The 3QUEST license dongle is missing on the R&S UPV
e The R&S UPV is being operated remotely with Microsoft Remote Desktop while
the dongle is plugged in.

In both cases the user may either press the “Cancel” button in the yellow progress
window or he may quit the 3QUEST license message.

6.20.8 Additional operations when finished

When the noise measurement is completely finished, there are some extended
features which may be reached through the soft key bar:

HATS Type 3.3 Att. Ear

Verify Delay | Veri;’; ef[i;ise

Figure 6-36: The soft key tool bar of the "Speech Quality in Presence of Background Noise"

Enter Clear Temp

Level Measurement Comment ‘ Files

Verify Speech ‘ Repeat

‘ Creste Report ‘ Close ‘

measurement

Button label Function

Verify Delay Takes a single delay measurement of the current
call

Verify Noise Field Checks the sound pressure level of each ambiance
according to the specification. For this
measurement, both artificial ears are used.
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Button label Function

Verify Speech Level Checks the sound pressure level of the artificial
mouth according to the specification. For this
measurement, the reference microphone must be
placed to the HATS MRP.

Repeat Measurement Repeats the complete measurement
Enter Comment Allows to enter an additional comment for the report.
Clear Temp Files Normally, the intermediate files belonging to a

specific noise field calibration will not be removed.
This button allows to clear all temporary files to get
more space on the hard disk.

The files will be recreated automatically during next
measurement — but this will take some more time.

Create Report Allows direct creation of a report

6.20.9 Extended Speech Quality Measurements

In addition to the normative Speech Quality Measurements, R&S provides some extra
functionality which can be reached across the Menu. It is called “Extended Speech
Quality in Presence of Ambient Noise”

When the extended version of the background noise measurement is started, it will be
possible to measure only a subset of the given signals and to repeat a single signal as
well. This is done be using the additional check boxes in the window. Only for checked
ambiances the recordings and calculations will be done.

ose Field Rverage Values - - - -

SMOS NMO3 GMO3

Total Verdict =

Figure 6-37: Running "Extended Speech Quality in Presence of Background Noise" with only 3
ambiances: Recording is just one

Pub_Noise V2

1

Qutside_Traffic_Road

1

QOutside_Traffic_Crossroads

1

Clean (no noise)
Fullsize_Car1_130Kmh

Cafeteria_Noise

[ I N

Mensa

1

Work_Noise_Office Callcenter

sending delay
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In this example, the steps 1-3 of only three selected signals has just be performed
before the calculation starts.

6.20.10 Continuing broken Extended Measurements

In addition to the recovery functionality of already recorded raw signals, the extended
mode provides recovery of calculations already done, too:

SMOS NMOS GMOS
Pub_Nopise_V?2
Qutside_Traffic_Road
Qutside_Traffic_Crossmoads
Clean (no noise)
Fullsize_Carl_130Kmh
Cafeteria_Noise

Mensa

Work_Noise_Office_Callcenter

Total Verdict =

sending delay

Figure 6-38: Restarting "Extended Speech Quality in Presence of Background Noise" with only 3
ambiances: The first two ambiances have been calculated, now recording of third ambiance is just
done

This image shows a recovery situation after two ambiances have been calcuated and a
third one had been added. The calculation of the third one has not been done yet.
When reopening, the check marks of “Clean (no noise)”, “Cafeteria”, “Mensa” and
“Callcenter” had been set automatically again but were removed by the user.

When “Repeat Measurement” is clicked now, nothing will happen except that the
calculation of the missing ambient noise will be done. A typical final result will show like
this:
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Noise Field Average Values PASS

SMOS NMOS GMOS
Pub_Noise_V2
Qutside_Traffic_Road
Quiside_Traffic_Crossmoads
Clean (no noise)
Fullsize_Carl1_130Kmh
Cafeteria_Noise
Mensa

Work_Noise_Office_Callcenter

Total Verdict =

Figure 6-39: Completed "Extended Speech Quality in Presence of Background Noise measurement

sending delay

In a recovery situation, there also would be the ability for adding new noise ambiances.
The condition between each check mark and current display decides what exactly will
happen:

e If acheck mark is set, the corresponding noise ambiance will be recorded and
calculated again no matter if already a raw data set exists or not.

e If acheck mark is cleared, the corresponding noise ambiance will never be
recorded again. If there is still a result, nothing will happen. Otherwise, if there
exists a raw data set, the calculation will be performed.

6.21 Notes on Hands-Free Measurements

6.22 General Remarks

The standards 3GPP2 C.S0056, 3GPP2 C.S0056-A, TIA-1042 and TIA-1042-A do not
define requirements and test specifications for the tests of the acoustic behaviour of
the mobile phone in this mode

As bonus, R&S UPV-K92 CDMA2000® Mobile Phone tests provide test cases for
handheld hands-free and desktop hands-free mode with narrow band and wideband
speech. The method and requirements are analogous to those in 3GPP TS 26.132.
Test specifications and limits for hands free car kits are the same as for desk top
hands-free terminals.

Hands-free tests with R&S UPV-K92 support the use of either artificial mouth
according to ITU-T P.51 together with a free field measurement microphone or
alternatively the use of a HATS with type 3.3 or 3.4 artificial ear and artificial mouth
according to ITU-T P.58.
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6.23 Test Setup

All tests must be performed in an anechoic room. Background noise must be less than
24 dBSPL(A). Furthermore the room should be big enough and its walls should have
sufficient absorption to provide nearly free-field conditions at the hands-free reference
point. Not all test boxes which are appropriate for handset tests can be used for hands
free measurements.

If a free-field microphone with a discrete P. 51 mouth is used, it should be configured
to the Handheld hands-free UE as per Figure 58 for receiving measurements and
Figure 59 for sending measurements. The measurement instrument should be located
at a distance dHF from the centre of the visual display of the mobile station. The
distance dHF is specified by the manufacturer.

Normal vector
from front of phone

I
Free-field measurement J
microphone

=
|
I
|
|
I
|
I
I
|
|
|
|
|
I
I
1
I
|
)
|
1
A

______(__.__..[_._qj_

dm:
Figure 6-40: Configuration of handheld hands-free UE, free-field microphone for receiving
measurements
Cigfi Normal vector
Ip ring from front of phone
position

1
1
|
|
!
|
|
|
¥

Figure 6-41: Configuration of handheld hands-free UE and artificial mouth according to ITU-T P.51 for
sending measurements

If a HATS is used, the measurement can either be performed binaurally (with two
artificial ears and correction of the RLR by 6 dB) or monaural.

The selection of acoustic accessories used for the hands free tests can be entered in
menu item “Options > Hands free settings”.
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Hands Free Settings

LRGP ITU-T P.51 and free field
microphone

HATS ITU-T P.58 and type 3.3
artificial ear, monaural

HATS ITU-T P53 and type 3.3
artificial ear, binaural

HATS ITU-T P.58 and type 3.4
artificial ear, maonaural

HATS ITU-T P.58 and type 3.4
artifizial ear, binaural

enerc speaker and free figld
microphone

Cancel 0k /L
e

Figure 6-42: Hands free settings

, s A

HATS 1 L
Reference I Normal vector

Point ' from front of phone

Figure 6-43: Configuration of handheld hands-free UE with HATS

For desk top hands-free it is referred to ITU-T P. 340 (ITU: Committed to connecting
the world) for the use of free field microphone and discrete P.51 mouth. The hands free
terminal should be placed on a table of approximately 1 m2 with the centre of its front
edge 400 mm perpendicularly from the centre of the front edge of the table. The
surface area should not be less than 0.96 m2 and its width should not be less than 0.8
m. The front centre of the measuring microphone or centre of the lip ring, respectively,
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should be placed 300 mm above the centre of the front edge of the table with the axis
of the microphone or artificial mouth inclined towards the centre of the front edge of the
hands-free terminal.

For the use of a HATS with both types of hands-free terminals it is referred to ITU-T
P.581. For handheld hands free the setup of ITU-T P.581 corresponding to “portable
hands-free” should be used. For desk top hands-free, the centre of the lip ring is
positioned as described above, but the axis of the artificial mouth should be horizontal.

6.24 Acoustic Calibration for Hands Free Tests

The calibration for the free field microphone or type 3.3 or type 3.4 HATS ear,
respectively, is done as described in chapter 4 above.

For binaural measurements, the second artificial ear has to be calibrated accordingly,
using the sub-item “Second Type 3.3 ear” or “Second type 3.4 ear”, respectively, in
“Calibration > Artificial Ear”. Note that the second artificial ear must be connected to
Analyzer input 2 instead of the R&S CMU200 connection.

According to 3GPP TS 26.132, free field equalization has to be taken into account.
Free field data can either be imported as an average table from the standard or from
an individual calibration disk, using the menu item “Calibration > Free field
equalization”.

The calibration of the artificial mouth for hands free tests comprises two additional
steps. After the level has been adjusted and the frequency response has been
equalized at the MRP, the reference microphone has to be repositioned at the so-
called Hands-Free Reference Point (HFRP or HATSHFRP).

For the mouth according to ITU-T P.51 the HFRP is in 50 cm distance from the lip ring
on the axis of the mouth. The calibration has to be performed at this point independent
of the measuring distance currently used.

The HATS HFRP is stipulated in ITU-T P.581. It is one of the points 11 to 17 defined in
table 6a of ITU-T P.58. It should be on the axis which is closest to the actual axis from
the lip ring to the microphone under test. The distance is always 50 cm from the lip
ring. The axis may be azimuthally centric (i.e. 0° horizontally) with an elevation
(vertical) angle of 0°, £15° or +30°. Points 16 and 17 are located on an axis with 0°
elevation and an azimuth angle of 15° or 30°.

The level at this point is adjusted to -28.7 dBPa. For the last step, the reference
microphone is returned to the MRP, and the level and spectrum at the MRP are
measured as reference for the transfer function calculation.

The mouth calibration for hands-free tests is started with the menu item “Calibration >
Artificial Mouth (Hands Free)”. This procedure comprises the mouth calibration for
handset tests and has also effect on subsequent handset tests with the same
individual artificial mouth.
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6.25 Customizing Measurements

The first item in the “Measurement” menu which is called “Settings” opens a sub-menu
with all available measurements in it. Clicking on a measurement in this sub-menu
opens a window which allows to change parameters of the selected measurement.

Parameters of Sending Handset with Speech “Normal™

Template Files

IS ending Handse s peech "Mamal No\ File Mame | Type | Upper margin [dE] Lower margin [dB
Descripbon 1 COMA_Handset_Sending_M  Mandatorny up
COMA zending measurement using speech signal = 2 CDMA_Handzet_Sending M Mandatory lo

"Mormal” 3 COMA_Handset_Sending M | Desired uppe

4 CDMA_Handset_Sending_M  Desired lower

=

Add Number = Delete | Edit |
W Parameters
Dperator instruclion Nn‘ Name | Type ‘ Default VaIuE{ Fixed
— 1 test signal file Sting Mamal True

2 wideband Boolean false False
3 5LA upper limit [dB] Double 19 False
4 check SLR upper limit Boolean true False
5 SLA lower limit [dB] Diouble E False
E check SLR lower limit EBaoolean true False

Program File
SFR_twidl

I

Nn‘ File name

1 del_snd.set

2 ea_zhd.zet

Number I? Edit |
homber [T Eat | I Locked cancel [0k |

Figure 6-44: Measurement setup window

The “Title” appears in the measurement menu and forms the heading of the report.
The “Description” can be chosen to be included into the report.

“Date” shows the date of the last change to this measurement definition.

“Operator instruction” is the text displayed before the start of each measurement,
provided that the item “Show operator instructions” is activated in the “Options” menu.

The entry in the field “Program File” designates the measurement type and must not be
changed.

The field “Setup Files” specifies the R&S UPV setups used by the measurement. The
specified file can be replaced by a user defined file but the number of setups is defined
by the measurement type. The customized setup file must be stored in folder
D:\Hearing. Itis recommended to generate customized setups by copying existing
ones. Note that changes in the setup like changing the analysis function or generator
signal may cause malfunction of the measurement. Some parameters of the setup
might be overwritten by the macro during the measurement run.

The field “Template files” specifies limit template curves for the response curve. The
buttons “Add” or “Edit” produce the following input window:
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Template Curve
Hurnber I'I

b andatary upper limit

M andatary lower limit

Dezired upper limit

Dezired lower limit

Center curve

|Jpper tolerance  Lower
dB tolerance dB

==

Far information only |

File name Browse |

IED Ma_Handzet_Sending_Marmo

Cancel | Ok !
3

Figure 6-45: Input window for limit template curve

The radio buttons allow to determine whether the given curve should be used as upper
limit, lower limit or for information only (no limit check). The field “File name” must
contain the path name of the file. To generate a new limit curve file, use the softkey
“Save as limit curve” of the respective measurement window or copy and edit an
existing limit file using a text editor.

All other available parameters of a measurement definition are shown in the
“Parameters” data grid. The rightmost column with the headline “Fixed” displays
whether the respective parameter can be changed by the operator or not. In “generic”
measurements all parameters may be changed. In measurements which follow
standards, only parameters which are not determined by the standard may be changed
by the operator. The “Edit” button opens an input window for the parameter in the line
specified in “Number”:
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Murmnber I 2

Type
I Boolean j
Default Walue
Ifalse
[ Locked
Cancel Ok
| ,

Figure 6-46: Input window for parameter value

“Name” appears in the report and explains the meaning of the parameter. “Type” is
determined by the measurement routine and cannot be changed. In the field “Value” a
value must be entered which conforms with the syntax rules of the selected data type.
The syntax is checked automatically when the text box is left. However there is no
check for the allowable range of the value. Entering inadequate values (e.g. too high
levels, negative frequencies) may cause malfunction of the measurement.

6.25.1 Parameters for the different Measurement Types

6.25.1.1 Sending Response

Table 7: Parameters for sending response measurements

Name Type Value Explanation

test signal file String Normal | The file cannot be changed by the operator
wideband Boolean |false Do not change

SLR upper limit (dB) Double 19 Upper limit for SLR limit check

check SLR upper limit | Boolean |true Upper limit is checked if “true”

SLR lower limit (dB) Double 6 Lower limit for SLR limit check

check SLR lower limit | Boolean |true Lower limit is checked if “true”
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6.25.1.2 Sending Response AMPS

Table 8: Parameters for sending response measurements in AMPS

Name Type Value Explanation

test signal file String Normal | Cannot be changed by the operator

wideband Boolean |false Do not change

SLR upper limit (dB) Double 19 Upper limit for SLR limit check

SLR check upper Boolean |false Upper limit is checked if “true”

SLR lower limit (dB) Double 19 Lower limit for SLR limit check

SLR check lower Boolean |false Lower limit is checked if “true”

loudness contrast limit (dB) | Double 3 Limit for absolute SLR difference between CDMA2000
and AMPS

check loudness contrast Boolean |true Limit is checked if “true”

6.25.1.3 Sending Response with Speech “Single Talk”

Table 9: Parameters for sending response measurements with ST speech

Name Type Value Explanation
CDMA Boolean | True Defines 0 dBFS = 3.17 dBmO
signal file name String ST_100- The file cannot be changed by the operator
8000Hz_FS

analysis delay (s) Double 0 Start of the analysis after start of the signal
analysis length (s) Double 35.4116 Length of the analysed portion of the signal
selective Boolean |False Time-selective analysis of the spectrum
handsfree Boolean |False Use devices configured in handsfree settings
wideband Boolean |False Speech codec bandwidth
annex G weighting factors | Boolean |False False: Use Annex A of P.79

True: Use Annex G of P.79
SLR upper limit (dB) Double 11 Upper limit for SLR limit check
check SLR upper limit Boolean |True Upper limit is checked if “true”
SLR lower limit (dB) Double 5 Lower limit for SLR limit check
check SLR lower limit Boolean | True Lower limit is checked if “true”
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6.25.1.4 Receiving Response

Table 10: Parameters for receiving response measurements

Name Type Value Explanation

test signal file String Normal The file cannot be changed by the operator

DRP Boolean |false If “false”, the DRP-ERP correction is taken into account
Wideband Boolean |false Selects wideband measurement (100 Hz to 7 kHz). Not

available in the current version.

RLR upper limit (dB) | Double 5 Upper limit for RLR limit check
RLR check upper Boolean |true Upper limit is checked if “true”
RLR lower limit (dB) | Double -5 Lower limit for RLR limit check
RLR check lower Boolean |true Lower limit is checked if “true”

6.25.1.5 Receiving Response AMPS

Table 11: Parameters for receiving response measurements in AMPS

Name Type Value Explanation

test signal file String Normal The file cannot be changed by the operator

DRP Boolean false If “false”, the DRP-ERP correction is taken into
account

wideband Boolean false Do not change

RLR upper limit (dB) Double 5 Upper limit for RLR limit check

RLR check upper Boolean false Upper limit is checked if “true”

RLR lower limit (dB) Double -5 Lower limit for RLR limit check

RLR check lower Boolean false Lower limit is checked if “true”

max. loudness contrast Double 3 Limit for absolute RLR difference between

(dB) CDMA2000 and AMPS

check loudness contrast Boolean true Limit is checked if “true”

6.25.1.6 Receiving Response with Speech “Single Talk”

Table 12: Parameters for receiving response measurements with ST speech

Name Type Value Explanation

CDMA Boolean True Defines 0 dBFS = 3.17 dBmO
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Name Type Value Explanation
signal file name String ST_100- The file cannot be changed by the operator
8000Hz_FS

analysis delay (s) Double 0 Start of the analysis after start of the signal
Analysis length (s) Double 35.4116 Length of the analysed portion of the signal
selective Boolean False Time-selective analysis of the spectrum
handsfree Boolean False Use devices configured in handsfree settings
Binaural Boolean False Binaural measurement for binaural headsets
curve equalisation String DF Equalisation applied to frequency response
loudness rating String ERP Equalisation applied to loudness rating calculation
equalisation
wideband Boolean True Speech codec bandwidth
annex G weighting Boolean False False: Use Annex A of P.79

True: Use Annex G of P.79
RLR upper limit Double 5 Upper limit for SLR limit check
check RLR upper limit Boolean True Upper limit is checked if “true”
RLR lower limit Double -1 Lower limit for SLR limit check
check RLR lower limit Boolean True Lower limit is checked if “true”

6.25.1.7 Loudness Rating Contrast Calculation

Table 13: Parameter loudness rating contrast calculation

Name Type Value Explanation
compared value count Parameter count |2 Must be the same in all
instances

measurement testcase title (1) String Sending Handset WB | Exact name of first WB
with Speech "Single | testcase
Talk"

measurement testcase title (2) String Receiving Handset Exact name of second WB
WB with Speech testcase
"Single Talk"

compared value count Parameter count |2

measurement value name (1) String Sending Loudness Exact name of first WB value
Rating
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Name Type Value Explanation
measurement value name (2) String RLR Exact name of second WB
value
compared value count Parameter count |2

reference testcase title (1) String Sending Handset NB | Exact name of first NB
with Speech "Single |testcase
Talk"

reference testcase title (2) String Receiving Handset Exact name of second NB

NB with Speech
"Single Talk"

testcase

compared value count

Parameter count

2

reference value name (1) String Sending Loudness Exact name of first NB value
Rating
reference value name (2) String RLR Exact name of second NB
value
compared value count Parameter count |2

contrast value name (1) String Contrast Sending Name of the first result in the
report
contrast value name (1) String Contrast Receiving Name of the second result in

the report

compared value count Parameter count |2

upper limit (1) [dB] Double 3 Upper limit for first result

upper limit (2) [dB] Double 3 Upper limit for second result

compared value count Parameter count |2

check upper limit (1) Boolean True Upper limit is checked on first
result if “true”

check upper limit (2) Boolean True Upper limit is checked on
second result if “true”

compared value count Parameter count |2

lower limit (1) [dB] Double -3 Lower limit for first result

lower limit (2) [dB] Double -3 Lower limit for second result

compared value count Parameter count |2

check lower limit (1) Boolean True Lower limit is checked on first
result if “true”

check lower limit (2) Boolean True Lower limit is checked on

second result if “true”
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Name Type Value Explanation

maximum value age (hours) Double 0.5 Found values are only used if
they are younger than
specified here

store additional information as Boolean True Retrieved values are stored
comment as comment

6.25.1.8 Terminal Coupling Loss

Table 14: Parameters for TCL measurements

Name Type Value Explanation
signal file name String Echoloss The file cannot be changed by the operator
rms value (dBFS) Double -12.5 Rms value of the signal file, cannot be changed by

the operator

wideband Boolean false Selects wideband measurement (100 Hz to 7 kHz).
Not available in the current version.

TCL upper limit (dB) Double 0 Upper limit for TCL limit check
check upper limit Boolean false Upper limit is checked if “true”
TCL lower limit (dB) Double 45 Lower limit for TCL limit check
check lower limit Boolean true Lower limit is checked if “true”

6.25.1.9 Terminal Coupling Loss with Compressed Speech “Single Talk”

Table 15: Parameters for TCL with compressed ST speech

Name Type Value Explanation

CDMA Boolean |True Defines 0 dBFS = 3.17 dBm0

Wideband Boolean |False Speech codec bandwidth

Handsfree Boolean |False Use devices configured in handsfree settings
Signal File String ST_compressed_NB | The file cannot be changed by the operator
act. level to peak ratio String -17.873 Property of the test signal file

[dB]

signal level (dBmO) Double -10 Level of the test signal at the encoder input
pre-delay (s) Double 17 Start of the analysis after start of the signal
analysis length (s) Double 18 Length of the analysed portion of the signal
selective Boolean |False Time-selective analysis of the spectrum
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Name Type Value Explanation

max. age of delay Double 0.5 Not used

values [hrs]

TCL upper limit (dB) Double 80 Upper limit for TCL limit check

check TCL upper limit Boolean |False Upper limit is checked if “true”

TCL lower limit (dB) Double 45 Lower limit for TCL limit check

check TCL lower limit Boolean | True Lower limit is checked if “true”

show noise curve Boolean | True Show spectrum of second measurement

without test signal

6.25.1.10

Peak Acoustic Level

Table 16: Parameters for peak acoustic level measurements

Name Type Value Explanation

test signal file name String PeakLevel | File name (without extension) of the .wav file used
for the test

measurement interval (s) | Double 10 Length of the measurement

DRP Boolean false If “false”, the DRP-ERP correction is taken into
account

upper limit (dBPa) String 42 Upper limit for sound pressure level in dBPa

check upper limit Boolean true Upper limit is checked if “true”

6.25.1.11 Sending Noise

Table 17: Parameters for sending noise measurements

Name Type Value Explanation

average count Byte 10 Number of averaged measurements

upper limit [dBmO(P)] Double -64 Upper limit noise level limit check

check upper limit Boolean true Upper limit is checked if “true”

lower limit [dBmO(P)] Double -100 Lower limit for noise level limit check

check lower limit Boolean false Lower limit is checked if “true”

weighted spectrum Boolean true If “true”, the displayed spectrum is weighted, if
“false”, the spectrum is unweighted

store spectrum Boolean true If “true”, the spectrum is stored for reporting
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6.25.1.12 Sending Noise with Activation Signal
Table 18: Parameters for sending noise test with activation signal
Name Type Value Explanation
weighting filter String CCIT Can be CCITT or AWE
handsfree measurement Boolean False Use devices configured in
handsfree settings
lower frequency (Hz) Double 300 Lower end of analysis
frequency range
upper frequency (Hz) Double 3400 Upper end of analysis
frequency range
use activation signal Boolean True Switch activation signal on/off
activation signal String CSS_Act_48kHz If no signal is specified, the
activation signal specified in
the “Options” menu is used
activation signal level (dBPa) Double -4.7 Level of the activation signal
at MRP
adapt activation signal level Boolean False Allow to reduce the level of
the activation signal if it
exceeds the generator range
measurement delay (ms) Double 100 Start of the analysis after
start of the signal
average count Byte 5 Number of measurements to
be averaged
show all spectra Boolean True Show spectra of all
measurements on the screen
store all spectra Boolean False Show spectra of all
measurements in the report
maximum spectral resolution Integer 1024 Maximum number of
frequency points in the
spectrum curves (has no
influence on the FFT size!)
total noise upper limit (dBmO) Double -64 Upper limit for total noise rms
check total upper limit Boolean True Upper limit is checked if
“true”
lower limit for total noise (dBmO0) | Double -90 Lower limit can be applied to
exclude dropped call
check total lower limit Boolean False Lower limit is checked if

“true”
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Name Type Value Explanation

upper limit for spectrum (dBm0) | Double -74 Upper limit for single
frequency disturbances

check spectral upper limit Boolean False Check upper limit for single
frequency disturbances

lower limit for spectrum (dBPa) Double -100 Lower limit can be applied to
exclude dropped call

check spectral lower limit Boolean False Lower limit is checked if
“true”

6.25.1.13 Receiving Noise
Table 19: Parameters for receiving noise measurements
Name Type Value Explanation
DRP Boolean false If “false”, the DRP-ERP correction is taken into
account
average count Byte 10 Number of averaged measurements
upper limit [dBPa(A)] Double -57 Upper limit for noise level limit check
check upper limit Boolean true Upper limit is checked if “true”
lower limit [dBPa(A)] Double -100 Lower limit for noise level limit check
check lower limit Boolean false Lower limit is checked if “true”
A weighted spectrum Boolean true If “true”, the displayed spectrum is weighted, if
“false”, the spectrum is unweighted
store spectrum Boolean true If “true”, the spectrum is stored for reporting
CDMA Boolean true Adapts the timing of the test for the CDMA2000
codecs
6.25.1.14 Receiving Noise with Activation Signal

Table 20: Parameters for receiving noise test with activation signal

Name Type Value Explanation

ear equalisation String DF Equalization of the artificial ear (DRP, ERP, DF or
FF)

weighting filter String AWE Can be CCITT or AWE

handsfree measurement | Boolean False Use devices configured in handsfree settings

lower frequency (Hz) Double 100 Lower end of analysis frequency range
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Name Type Value Explanation

upper frequency (Hz) Double 10000 Upper end of analysis frequency range

use activation signal Boolean True Switch activation signal on/off

activation signal String CSS_Act_48kHz | If no signal is specified, the activation signal
specified in the “Options” menu is used

activation signal level Double -16 Level of the activation signal at the encoder input

(dBmoO)

measurement delay (ms) | Double 100 Start of the analysis after start of the signal

average count Byte 5 Number of measurements to be averaged

show all spectra Boolean True Show spectra of all measurements on the screen

store all spectra Boolean False Show spectra of all measurements in the report

maximum spectral Integer 1024 Maximum number of frequency points in the

resolution spectrum curves (has no influence on the FFT
sizel)

binaural measurement Boolean False Binaural measurement for binaural headsets

total noise upper limit Double -57 Upper limit for total noise rms

(dBPa)

check total upper limit Boolean True Upper limit is checked if “true”

lower limit for total noise | Double -70 Lower limit can be applied to exclude dropped

(dBPa) call

check total lower limit Boolean True Lower limit is checked if “true”

upper limit for spectrum | Double -60 Upper limit for single frequency disturbances

(dBPa)

check spectral upper limit | Boolean False Check upper limit for single frequency
disturbances

lower limit for spectrum Double -100 Lower limit can be applied to exclude dropped

(dBPa) call

check spectral lower limit | Boolean False Lower limit is checked if “true”

6.25.1.15 Sending Distortion

Table 21: Parameters for sending distorsion measurements

Name Type Value Explanation

wideband Boolean false Selects wideband measurement (100 Hz to 7
kHz). Not available in the current version.

average count Byte 10 Number of averaged measurements
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Name Type Value Explanation

number of levels Parameter | 10 Number of test levels, equals number of level
count parameters given below

level 1 (dB relative to Double -35

ARL)

level 2 (dB relative to Double -30

ARL)

level 3 (dB relative to Double -25

ARL)

level 4 (dB relative to Double -20

ARL)

level 5 (dB relative to Double -15

ARL)

level 6 (dB relative to Double -10

ARL)

level 7 (dB relative to Double -5

ARL)

level 8 (dB relative to Double 0

ARL)

level 9 (dB relative to Double 5

ARL)

level 10 (dB relative to Double 10

ARL)

CDMA Boolean true Adapts the timing of the test for the CDMA2000

codecs

6.25.1.16 Sending Distortion with Activation Signal

Table 22: Parameters for sending distortion test with activation signal

Name Type Value Explanation

weighting String CCITT Can be CCITT or AWE

handsfree Boolean False Use devices configured in handsfree
settings

lower frequency boundary | Double 200 Lower end of analysis frequency range

(Hz)

upper frequency boundary | Double 4000 Upper end of analysis frequency range

(Hz)

test tone duration (ms) Double 360 Duration of the sine tone
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Name Type Value Explanation
settling time (ms) Double 50 Start of the analysis after start of the test
tone
average count Byte 5 Number of measurements to be averaged
use activation signal Boolean True Switch activation signal on/off
activation signal String CSS_Act_48kHz | If no signal is specified, the activation
signal specified in the “Options” menu is
used
adapt activation signal to Boolean True Allow to reduce the level of the activation
range signal if it exceeds the generator range
sweep 1 frequency (Hz) Double 1020 Test tone frequency for level sweep
number of levels Parameter 6
count
level 1 (dBPa) Parameter 5
count
level 2 (dBPa) Double 0
level 3 (dBPa) Double -4.7
level 4 (dBPa) Double -10
level 5 (dBPa) Double -15
level 6 (dBPa) Double -20
number of activation levels | Parameter 6 Must be equal to number of levels
count
activation level 1 (dBPa) Double 5
activation level 2 (dBPa) Double 0
activation level 3 (dBPa) Double -4.7
activation level 4 (dBPa) Double -10
activation level 5 (dBPa) Double -15
activation level 6 (dBPa) Double -20
sweep 2 level (dBPa) Double -4.7 Test tone level for frequency sweep
sweep 2 activation level Double -4.7 Activation level for frequency sweep
(dBPa)
number of frequencies Parameter 0
count
show spectrum Boolean True Show spectrum on the screen
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Name Type Value Explanation

memorize spectrum Boolean True Store spectrum until the measurement is
closed, to be viewed after completion of
the test

maximum resolution Integer 400 Maximum number of frequency points in
the spectrum curves (has no influence on
the FFT size!)

6.25.1.17 Receiving Distortion

Table 23: Available parameters for receiving distortion measurements

Name Type Value |Explanation

DRP Boolean false

average count Byte 5 Number of averaged measurements

number of levels Parameter |10 Number of test levels, equals number of level parameters

count given below

level 1 (dBmO) Double -45

level 2 (dBmO) Double -40

level 3 (dBmO) Double -35

level 4 (dBmO) Double -30

level 5 (dBmO) Double -25

level 6 (dBmO) Double -20

level 7 (dBmO) Double -15

level 8 (dBmO) Double -10

level 9 (dBmO) Double -5

level 10 (dBmO) Double 0

upper SPL limit (dBPa) | Double 10 Highest SPL for which the distortion is displayed and
checked in the first test run. Pushing “Add measurement”
causes all levels to be measured and displayed

CDMA Boolean true Adapts the timing of the test for the CDMA2000 codecs

6.25.1.18 Receiving Distortion with Activation Signal

Table 24: Parameters for receiving distortion test with activation signal

Name Type Value Explanation
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Name Type Value Explanation

equalization String DF Equalization of the artificial ear (DRP, ERP,
DF or FF)

weighting String CCITT Can be CCITT or AWE

handsfree Boolean False Use devices configured in handsfree settings

lower frequency Double 100 Lower end of analysis frequency range

boundary (Hz)

upper frequency Double 6000 Upper end of analysis frequency range

boundary (Hz)

test tone duration (ms) Double 360 Duration of the sine tone

settling time (ms) Double 50 Start of the analysis after start of the test tone

highest tested level Double 10 Result is not checked if the measured level

(dBPa) exceeds this value

average count Byte 5 Number of measurements to be averaged

use activation signal Boolean True Switch activation signal on/off

activation signal String CSS_Act_48kHz | If no signal is specified, the activation signal

specified in the “Options” menu is used

adapt activation signal to | Boolean True Allow to reduce the level of the activation
range signal if it exceeds the generator range
sweep 1 frequency (Hz) |Double 1020 Test tone frequency for level sweep

number of test tone levels | Parameter 8

count
test tone level 1 (dBmO) | Double 0
test tone level 2 (dBmO) | Double -3
test tone level 3 (dBmO) | Double -10
test tone level 4 (dBmO0) | Double -16
test tone level 5 (dBmO0) | Double -20
test tone level 6 (dBmO) | Double -30
test tone level 7 (dBmO) | Double -40
test tone level 8 (dBmO0) | Double -45
number of activation Parameter |8 Must be equal to number of levels
levels count
activation level 1 (dBm0) |Double 0
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Name Type Value Explanation

activation level 2 (dBm0) |Double -3

activation level 3 (dBm0) |Double -10

activation level 4 (dBmO) | Double -16

activation level 5 (dBmO) | Double -20

activation level 6 (dBm0) |Double -30

activation level 7 (dBm0) | Double -40

activation level 8 (dBmQ0) | Double -45

sweep 2 test tone level Double -16 Test tone level for frequency sweep

(dBmoO)

sweep 2 activation level | Double -16 Activation level for frequency sweep

(dBmoO)

number of frequencies Parameter |5

count

frequency 1 (Hz) Double 315

frequency 2 (Hz) Double 408

frequency 3 (Hz) Double 510

frequency 4 (Hz) Double 816

frequency 5 (Hz) Double 1020 Show spectrum on the screen

show spectrum Boolean True Store spectrum until the measurement is
closed, to be viewed after completion of the
test

memorize spectrum Boolean True Maximum number of frequency points in the
spectrum curves (has no influence on the FFT
size!)

6.25.1.19 Sidetone Masking Rating

Table 25: Available parameters for STMR measurements

Name Type Value |Explanation
DRP Boolean |false If “false”, the DRP-ERP correction is taken into account
wideband Boolean |false Selects wideband measurement (100 Hz to 7 kHz). Not

available in the current version.

STMR upper limit (dB) Double 23 Upper limit for STMR limit check

check STMR upper limit | Boolean |true Upper limit is checked if “true”
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Name Type Value |Explanation

STMR lower limit (dB) Double 13 Lower limit for STMR limit check

check STMR lower limit | Boolean | true Lower limit is checked if “true”

CDMA Boolean |true Adapts the timing of the test for the CDMA2000 codecs

6.25.1.20 Sidetone Masking Rating with Speech “Single Talk”

Table 26: Parameters for STMR measurements with ST speech

Name Type Value Explanation
signal file name String ST_100- Cannot be changed by the operator
8000Hz_FS

analysis delay (s) Double 0 Start of the analysis after start of the signal
analysis length (s) Double |35.4116 Length of the analysed portion of the signal
selective Boolean |False Time-selective analysis of the spectrum
curve equalisation String ERP Equalisation applied to frequency response
STMR equalisation String ERP Equalisation applied to STMR calculation
wideband Boolean |True Binaural measurement for binaural headsets
unsealed Boolean |True False: Apply leakage correction
LRGP method Boolean |False Enforce use of type 1 or type 3.2 ear
HATS method Boolean |False Enforce use of type 3.3 or type 3.4 ear
Autoselect Boolean |False False: Use Annex A of P.79

True: Use Annex G of P.79
binaural Boolean |False Binaural measurement for binaural headsets
STMR upper limit (dB) |Double |23 Upper limit for STMR limit check
check upper limit Boolean |True Upper limit is checked if “true”
STMR lower limit (dB) | Double 15 Lower limit for STMR limit check
check lower limit Boolean |True Lower limit is checked if “true”

6.25.1.21 Sidetone Delay with Cross-Correlation

Table 27: Parameters for sidetone delay tests with cross-correlation

Name Type Value Explanation
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Name Type Value Explanation

test signal String CSS_48kHz | The file cannot be changed by the operator
signal level [dBPa] Double -4.7 SPL at MRP

initial delay [ms] Double 49 Start of the analysis after start of the signal
correlation length Integer 2048 Length of cross-correlation result

[samples]

analysis length [ms] Double 200 Length of cross-correlated signals

upper limit [ms] Double 5 Upper limit for sidetone delay limit check
check limit Boolean | True Upper limit is checked if “true”

binaural measurement Boolean |False Binaural measurement for binaural headsets

6.25.1.22 Stability Margin

Table 28: Available parameters for stability margin tests

Name Type Value |[Explanation

loop gain (dB) |Double |6 Specifies the gain applied between decoder output and encoder input
for the stability test

6.25.1.23 Stability Loss

Table 29: Parameters for stability loss test

Name Type Value Explanation

wideband Boolean |True Bandwidth of the speech codec

handsfree measurement |Boolean |False Use devices configured in handsfree settings
play training sequence Boolean |True Switches training signal on/off

signal name String StabLossWB.arb | The file cannot be changed by the operator
act. level to peak ratio Double |4.927 Property of the test signal file

[dB]

signal level [dBmO] Double -3 Level of the test signal at the encoder input
pre-delay [ms] Double 85 Start of the analysis after start of the signal
lowest measured Double 100 Lower end of analysis frequency range
frequency [Hz]

highest measured Double 8000 Upper end of analysis frequency range
frequency [Hz]
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Name Type Value Explanation

max. age of delay values | Double |0.5 Not used

[hrs]

maximum spectral Integer 256 Maximum number of frequency points in the

resolution spectrum curves (has no influence on the FFT
size!)

stability loss lower limit Double 6 Lower limit for stability loss limit check

[dB]

check stability loss lower |Boolean | True Lower limit is checked if “true”

limit

stability loss upper limit | Double 100 Upper limit for stability loss limit check

[dB]

check stability loss upper | Boolean |False Upper limit is checked if “true”

limit

show noise curve Boolean |True Show spectrum of second measurement without
test signal

training signal name String ST_100- The file cannot be changed by the operator

8000Hz_FS

act. level to peak ratio Double 19.331 Property of the training signal file

[dB]

training signal level Double -16 Encoder input level

[dBmO]

CDMA Boolean | True Defines 0 dBFS = 3.17 dBmO

6.25.1.24

Delay Measurement with Cross-Correlation

Table 30: Parameters for the delay measurement with cross-correlation

Name Type Value Explanation

test signal String five The file cannot be changed by the operator

signal level 1 (dBPa) Double -4.7 SPL at MRP

signal level 2 (dBmO) Double -16 Encoder input level

initial delay (ms) Double 0 Start of the analysis after start of the signal

correlation length (samples) Integer 32768 Number of samples submitted to cross-
correlation

analysis length (ms) Double 1800 Length of cross-correlation result

undersample factor Integer 4 Undersampling before cross-correlation
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Name Type Value Explanation

ingore initial peaks (ms) Double 0 Suppression of sidetone for loopback on
network side

minimum S/N factor Double 1.2 Ratio between highest and second-highest
cross-correlation peak

path String Nloop Signal path (one of Mloop, Nloop, Rcv,
Snd, Snd+Rcv)

CDMA Boolean | True Defines 0 dBFS = 3.17 dBmO

hands free Boolean | False Use devices configured in handsfree
settings

binaural measurement Boolean |False For binaural headsets

store curves Boolean | True Show cross-correlation curves in the report

subtract roundtrip delay (ms) Double 0 Delay contribution of system simulator

unused Double 0

snd delay upper limit (ms) Double 60

check snd delay upper limit Boolean |False

snd delay objective (ms) Double 50

check snd delay objective Boolean |False

rcv delay upper limit (ms) Double 70

check rcv delay upper limit Boolean | False

rcv delay objective (ms) Double 55

check rcv delay objective Boolean |False

roundtrip delay upper limit (ms) Double 220 Upper limit for calculated roundtrip delay

check roundtrip delay upper limit Boolean | True Upper limit is checked if True

roundtrip delay objective (ms) Double 185 Objective upper limit for roundtrip delay,

does not contribute to total verdict

check roundtrip delay objective Boolean | True Objective upper limit is checked if True
interaural diff. upper limit (ms) Double 5

check interaural diff. upper limit Boolean | False

interaural diff. objective (ms) Double 2

check interaural diff. objective Boolean |False
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6.25.1.25 Delay Measurement with Cross-Correlation and subtraction of
measured CMW500 delay

Table 31 Parameters for the delay measurement with cross-correlation and subtraction of measured

CMWS500 delay

Name Type Value Explanation

test signal String five The file cannot be changed by the operator

signal level 1 (dBPa) Double -4.7 SPL at MRP

signal level 2 (dBmO) Double -16 Encoder input level

initial delay (ms) Double 0 Start of the analysis after start of the signal

correlation length (samples) Integer 32768 Number of samples submitted to cross-
correlation

analysis length (ms) Double 1800 Length of cross-correlation result

undersample factor Integer 4 Undersampling before cross-correlation

interval Integer 96 Interval for the determination of relative
maxima in the cross-correlation curve. Has
impact on the S/N factor.

ingore initial peaks (ms) Double 0 Suppression of sidetone for loopback on
network side

minimum S/N factor Double 1.2 Ratio between highest and second-highest
cross-correlation peak

path String Nloop Signal path (one of Mloop, Nloop, Rcv,
Snd, Snd+Rcv)

CDMA Boolean | True Defines 0 dBFS = 3.17 dBmO0

hands free Boolean | False Use devices configured in handsfree
settings

binaural measurement Boolean |False For binaural headsets

store curves Boolean | True Show cross-correlation curves in the report

subtract CMW delay Boolean | True Subtract delay contribution of system
simulator

Radio access network String CDMAZ2000 | Specification of selected radio access
network for CMW remote control (one of
GSM, WCDMA, VoLTE and CDMA2000).
If nothing is specified, the active radio
access technology is determined by
remote control queries.

snd delay upper limit (ms) Double 60

check snd delay upper limit Boolean | False
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Name Type Value Explanation

snd delay objective (ms) Double 50

check snd delay objective Boolean | False

rcv delay upper limit (ms) Double 70

check rcv delay upper limit Boolean |False

rcv delay objective (ms) Double 55

check rcv delay objective Boolean | False

roundtrip delay upper limit (ms) Double 220 Upper limit for calculated roundtrip delay
check roundtrip delay upper limit Boolean | True Upper limit is checked if True

roundtrip delay objective (ms) Double 185 Objective upper limit for roundtrip delay,

does not contribute to total verdict

check roundtrip delay objective Boolean | True Objective upper limit is checked if True
interaural diff. upper limit (ms) Double 5

check interaural diff. upper limit Boolean | False

interaural diff. objective (ms) Double 2

check interaural diff. objective Boolean | False

6.25.1.26 Echo Control Characteristics

Table 32: Parameters for echo control characteristics test

Name Type Value Explanation

handsfree Boolean |False Use devices configured in
handsfree settings

CDMA Boolean | True Defines 0 dBFS = 3.17 dBm0

max. delay age (h) Double |0 Not used

crosscorrelation length (samples) | Integer | 8192 Length of cross-correlation result

crosscorr. analysis length Integer | 16384 Number of cross-correlated

(samples) samples

near-end signal String EchoControl_Nearend The file cannot be changed by the
operator

near-end level (dBPa) Double -4.7 SPL at MRP
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far-end signal String EchoControl_Farend_WB | The file cannot be changed by the
operator

far-end level (dBmO) Double |-16 Encoder input level

conditioning time (s) Double |[23.5 Start of the analysis after start of
the signal

analysis time 1 (s) Double |20 Length of continuous double-talk
section

analysis time 2 (s) Double |15 Length of single near-end words
section

cat. lower limits for analysis 1 dt | String 0,0,0,0,0,0,0,0 For categories A, B, C, D, E, F, G,

(%) H

check cat. lower lim. for analysis | String False,False,False,False,F | For categories A, B, C, D, E, F, G,

1dt alse,False,False,False H

cat. upper limits for analysis 1 dt | String 100,100,100,100,100,100, | For categories A, B, C, D, E, F, G,

(%) 100,100 H

check cat. upper lim. for analysis | String False,False,False,False,F | For categories A, B, C, D, E, F, G,

1dt alse,False,False,False H

level lower limits for analysis 1 dt | Double 0,0,0,0,0,0,0,0 For categories A, B, C, D, E, F, G,

(dB) H

check level lower lim. for anal. 1 | String False,False,False,False,F | For categories A, B, C, D, E, F, G,

dt alse,False,False,False H

level upper limits for analysis 1 dt | Double 0,0,0,0,0,0,0,0 For categories A, B, C, D, E, F, G,

(dB) H

check level upper lim. for anal. 1 | String False,False,False,False,F | For categories A, B, C, D, E, F, G,

dt alse,False,False,False H

cat. lower limits for analysis 1 st | Double 0,0,0,0,0,0,0,0 For categories A, B, C, D, E, F, G,

(%) H

check cat. lower lim. for analysis | String False,False,False,False,F | For categories A, B, C, D, E, F, G,

1st alse,False,False,False H

cat. upper limits for analysis 1 st | String 100,100,100,100,100,100, | For categories A, B, C, D, E, F, G,

(%) 100,100 H

check cat. upper lim. for anal. 1 | String False,False,False,False,F | For categories A, B, C, D, E, F, G,

st alse,False,False,False H

level lower limits for analysis 1 st | Double 0,0,0,0,0,0,0,0 For categories A, B, C, D, E, F, G,

(dB) H

check level lower lim. for anal. 1 | String False,False,False,False,F | For categories A, B, C, D, E, F, G,

st

alse,False,False,False

H
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Name Type Value Explanation

level upper limits for analysis 1 st | Double |0,0,0,0,0,0,0,0 For categories A, B, C, D, E, F, G,
(dB) H

check level upper lim. for anal. 1 | String False,False,False,False,F | For categories A, B, C, D, E, F, G,
st alse,False,False,False H

cat. lower limits for analysis 2 dt | String 0,0,0,0,0,0,0,0 For categories A, B, C, D, E, F, G,
(%) H

check cat. lower lim. for analysis | String False,False,False,False,F | For categories A, B, C, D, E, F, G,
1dt alse,False,False,False H

cat. upper limits for analysis 2 dt | String 100,100,100,100,100,100, | For categories A, B, C, D, E, F, G,
(%) 100,100 H

check cat. upper lim. for analysis | String False,False,False,False,F | For categories A, B, C, D, E, F, G,
2dt alse,False,False,False H

level lower limits for analysis 2 dt | String 0,0,0,0,0,0,0,0 For categories A, B, C, D, E, F, G,
(dB) H

check level lower lim. for anal. 2 | String False,False,False,False,F | For categories A, B, C, D, E, F, G,
dt alse,False,False,False H

level upper limits for analysis 2 dt | String 0,0,0,0,0,0,0,0 For categories A, B, C, D, E, F, G,
(dB) H

check level upper lim. for anal. 2 | String False,False,False,False,F | For categories A, B, C, D, E, F, G,
dt alse,False,False,False H

cat. lower limits for analysis 2 st | String 0,0,0,0,0,0,0,0 For categories A, B, C, D, E, F, G,
(%) H

check cat. lower lim. for analysis | String False,False,False,False,F | For categories A, B, C, D, E, F, G,
2 st alse,False,False,False H

cat. upper limits for analysis 2 st | String 100,100,100,100,100,100, | For categories A, B, C, D, E, F, G,
(%) 100,100 H

check cat. upper lim. for anal. 2 | String False,False,False,False,F | For categories A, B, C, D, E, F, G,
st alse,False,False,False H

level lower limits for analysis 2 st | String 0,0,0,0,0,0,0,0 For categories A, B, C, D, E, F, G,
(dB) H

check level lower lim. for anal. 2 | String False,False,False,False,F | For categories A, B, C, D, E, F, G,
st alse,False,False,False H

level upper limits for analysis 2 st | String 0,0,0,0,0,0,0,0 For categories A, B, C, D, E, F, G,
(dB) H

check level upper lim. for anal. 2 | String False,False,False,False,F | For categories A, B, C, D, E, F, G,
st alse,False,False,False H

handsfree Boolean |False For categories A, B, C, D, E, F, G,

H
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7.1

7.2

Measurements with electric connections

Measurements with electric connections

Introduction

Usually the mobile under test is connected via RF connection to the R&S CMU200 and
via acoustic interfaces (artificial mouth and ear) to the R&S UPV. Therefore no
intrusion in the mobile device is required.

There may, however, be cases during the design process of a mobile phone where the
usual interfaces are not available:

e if a mechanic mockup is to be measured just with the acoustic components but
without the rest of the circuitry
if a circuit of a mobile phone is to be measured without acoustic components
if a hands free kit or headset is to be measured without mobile phone
if the hands free or headset connection of a mobile phone is to be measured
without hands free kit or headset, respectively.

In these cases either coder and decoder or artificial ear and artificial mouth may be
replaced by direct electrical connections to the R&S UPV. To use electric connections,
select “Electric connection” in the respective item of the “Options” menu.

Calibration values for electric connections

Electrical connections cannot be calibrated. Instead a virtual sensitivity has to be
entered for each type of electrical connection under “Calibration - Electric
connections > ...".

Electric connection replacing artificial ear
R&S UPV Analyzer input 1 is directly connected to the earpiece amplifier output.

A nominal sensitivity of the receiver (earpiece speaker) for which the circuit is intended
has to be entered in dB re 1 Pa/V.

Electric connection replacing artificial mouth

R&S UPV generator output 1 is directly connected to the microphone input of the
mobile phone circuit.

A nominal sensitivity of the microphone for which the circuit is intended has to be
entered in dB re 1 V/Pa.

Electric connection replacing encoder

R&S UPV generator output 2 is directly connected to a earpiece or headset speaker or
to the speech input of a hands free kit.

A nominal full scale output voltage (output voltage corresponding to digital full scale) of
the circuit intended to drive the speaker or car kit has to be entered.

Electric connection replacing decoder
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R&S UPV analyzer input 2 is directly connected to a microphone or to the speech
output of a hands free Kkit.

A nominal full scale input voltage (input voltage corresponding to digital full scale) of
the respective microphone or speech input has to be entered.

7.3 Performing the measurements

After applying the settings in the “Options” menu and after entering appropriate
calibration values for the electric connections in use, the measurements may be
started as usual.

Some parts of the standard require the use of particular artificial ears for particular
measurements. Therefore the checkbox “Allow only selected measurements” should
be unchecked in “Options > Standard”.

For sending tests, the output voltage range in the R&S UPV is set to a large value in
order to be able to drive the speaker of the artificial mouth. In rare cases sending
distortion and/or sending noise results may be degraded with electric connections if a
low microphone sensitivity is entered. In this case please contact R&S support.
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8 Automatic Test Sequences

File Data Calibration Measurement | Sequence Report  Ophions  Help

Teszt rezults overnew

| Measureme
il | [l © FI0 ANAC T 7. 30 Dk AEOD C e

Figure 8-1: Sequence menu

8.1 Creating and Editing a Sequence

The menu item “Sequence - New” first produces a window where a name for the new
sequence has to be entered. Subsequently the sequence window opens.

@UPV*K'JV cdmaz000{R} Mobile Phone Tests {D:'\Phone'Results.xml)
File Data Calbration Measurement Sequence Report Options  Help

=
AMPS Receiving Handset, max. Yol [l COMA Sending Handset
AMPS Receiving Handset, max. Yol & DRP Append - vl COM# Idle channel noise sending
. . [l CDMA Distartion Sending (5]
Editand Append - [l COMA Receiving Handset, nom. Yol
COMA fing, nom, vol

AMPS Sending Handzet
AMPS Sending Handset with speech "Namal

CDMA weighted Terminal Coupling Loss Delete vl COMA Sidetone Masking Rating
COMA Distartion Receiving

CDMA Receiving Handzet, mas. Vol Mowe up

CDMaA Receiving Handzet, max. Vol. @ DRP

CDMaA Receiving Handzet. nom. Yal.

COMA Receiving Handset, nam. Vol (@ DRP o dawn

COMA Idle channel noize receiving, mas. vol

COMA Idle channel noize receiving, nom. vol. EdilP n
CDMA Distartion Sending [v5) HIPEIENIERSE

CDMaA Distortion sending [VE)]
COMA Sending Handset Run highlighted

CDMaA Idle channel noise sending

CDMaA Stability margin

COMA Sidetone Masking Fating Clear
Echao Lose with Speech "Echoloss”

CDMA Peak Acoustic Pressure Level Check all
Peak Acoustic Pressure Level with Signal "PeakLes

Diztartion Receiving

Receiving Handset with speech "Normal Uncheck all
Idle channel noize receiving

Distartion Sending [v5)]

Sending Handset with S peech "Mormal” S
|dle channel noige sending ave sequence as
Stability margin

Close

Sidetone Mazking Rating with Modulated Multisine

4] i
Mo Standard [Type 3.2 Low Leak At Ear |CMU / CRTU | Sample test objeot 1
Tjifirst Stop/Eart: FHepeatiast Fepart
R Start sequence ey [ st Step | Y i [ Save sequence Save and cloze

Figure 8-2: Sequence window

Initially the right checked list box is empty. The list box on the left side displays all
available measurement definitions. A measurement is appended to the sequence by
highlighting it in the list box on the left side and clicking the “Append” button.
Subsequently a measurement, which is highlighted in the checked list box on the right
side, can be moved within the sequence using the buttons “Move up” and “Move down”
and deleted from the sequence with the “Delete X” button. For non-standard
measurements which allow to change parameters like limit curves, it is possible to edit
the parameters before appending the measurement to the sequence. This is done by
clicking the button “Edit and append”. It is for example possible to assemble a test
sequence which contains stability margin tests with different loop gains.
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8.2

Automatic Test Sequences

A sequence should be run with option “Show operator instructions” disabled. This
avoids interruption of the execution. If a message to the operator is to be inserted into
the sequence on purpose, e.g. “Set user volume control to maximum!”, the items
provided in the tree view under “Messages and Control” may be used. Such a
message will stop the execution of the sequence until it is closed by acknowledgement
of the operator.

Remote Control of R&S CMU200 within a Sequence

It is possible to remote control radiocommunication tester R&S CMU200 from the
R&S UPV within an automatic test sequence, for example to wait for a mobile to
register, or for originating a call to the mobile. First the connection interface to the
R&S CMU200 has to be set up using menu item “Options > CMU remote control”. To
insert a control instance into a sequence, choose one of the examples offered in
branch “Messages and Control” of the tree view and edit it if necessary. For details on
the remote control of the R&S CMU200 see the respective operation manuals.

Each control instance consists of a block of an arbitrary number of remote commands
followed by a status query. The query command (e.g. “SIGN:STAT?”) and the
response to wait for (e.g. “SYNC” or “CEST”) can be specified as well as a timeout for
the case that the desired response is not received. As the R&S CMU200 is organized
into subsystems for the different mobile phone systems, the subsystem has to be
specified as a parameter. Parameter “Auto” causes the control instance to use the
subsystem set with menu item “Options - CMU Subsystem”. Note that the remote
commands are not always compatible between different mobile phone systems.

In addition, a message to the operator like “Please switch on the mobile!” can be
entered in the “Operator Instruction” field of the parameter window. Parameter 1 allows
to choose whether the message is shown before or after the block of commands is
sent to the R&S CMU200.

When the R&S CMU200 control instance is executed within a sequence, a window
opens, showing the progress of the control action.
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By default, the R&S CMU200 changes its state when switching from local control to
remote control or vice versa. As a consequence, synchronicity / registration or an
established call would be lost during the transition. Therefore the command
SYSTem:GTRMode : COMPatible OFF has to be issued before the first real remote
control instance. Insert “CMU run this first!” in your sequence before any other remote
CMU remote control.

@)EMU synchronize mobile {GS™, selec... [B[=]

BAction |Cr'-'1l_l synchronize mobile (G5
IDuer_l,ling ChLl ztaties

Target state
B

CHL Responze
|50M

Error

IEI,"N o eror'

Communication

> PROCSIGH: CSWwW:ACT SOM
* 5YST:ERR?
< [0"Mo emrar*!
» SIGM:STAT?
< 50N

* 5YST:ERR?
< [0"Mo emrar"!
> SIGM:STATY
< S0OMN

* 5YST:ERR?
< [0"Mo emrar*!

Tirne Ieftl 57765 zeconds Catrcel |

Figure 8-3: CMU remote control window

“Action” shows the current remote control action. “Target state” shows the desired
query response. “CMU Response” shows the actual response of the R&S CMU200 to
the query. Error information returned from the R&S CMU200 after the last command /
query is displayed in the “Error” field. The “Communication” box lists all commands and
responses issued during the control process. During the status query, the box “Time
left” shows the time left until the timeout expires.
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8.3

8.4

8.5

Automatic Test Sequences

Opening an Existing Sequence

The menu item “Sequence - Open ...” opens a file selector for specifying the
sequence to be loaded. The sequence window opens with the specified sequence
loaded. The sequence can then be edited and/or run.

Running a Sequence

When the softkey “Start sequence” is pressed, all checked measurements in the right
list box are executed in sequence. The state of the checkboxes may be altered by
marking a measurement and then clicking on the checkbox.

A running sequence may be interrupted with one of the buttons in the measurement
control window which is visible while a measurement is running. “Cancel and continue
sequence” cancels the currently running measurement and resumes execution of the
sequence with the next measurement. “Cancel and stop sequence” aborts both
running measurement and sequence. “Stop sequence after this measurement”
completes the running measurement and stops the sequence afterwards.

2

Measuring
Distortion at -45 dBm0

Cancel and continue sequence

Cancel and stop sequence

Stop zequence after thiz
meazurernent

Figure 8-4: Measurement control window

Running a single measurement out of a sequence

If a measurement is highlighted in the right checked list box it can be run like a single
measurement using the button “Run highlighted”, irrespective of whether it is checked
or not. The measurement runs as if it would have been started from the “Measurement”
menu in the main window. That is, the measurement window stays open for further
actions like storing and loading of curves and reporting until it is closed by the user.
This functionality allows to assemble subsets of customized measurements without
overloading the list in the “Measurement” menu.
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8.6 Reporting on Sequence Results

A report on all executed measurements of the last run sequence is prepared and
displayed after the “Report Sequence” softkey has been pressed. After the sequence
window has been closed, a report on the last sequence can be obtained by pressing
the “Report last sequence” softkey in the main window.
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9.1

9.2

9.3

Reporting, Storing, Loading and Deleting Results

Reporting, Storing, Loading and Deleting
Results

Result Files

Measurement results are stored together with all associated data in XML files.
Separate files can be used for different projects or operators. They can be archived
together with other project data and re-opened later for generating reports.

It is recommended to keep result files small and to generate backups at frequent
intervals.

¢>UPY-K9y cdma2000(]

File Data Calbration f
Cpen results File I

Save results m
Save results as _1
e resulks File 1
Load settings 01
Save sethings D1
Save settings as 01

11

Exit 1

i LT ozezreem

Figure 9-1: File menu

A new (empty) result file can be created with “File > New Result File” from the main
menu.

An existing result file can be opened with “File - Open Result File” from the main
menu.

A currently opened result file can be stored under a new name with “File > Store
results as” from the main menu.

Report Settings

With “Report > Settings” or “Options - Report settings”, a selection can be made of
data which should appear in the reports. Thus, information which is the same for a
larger number of measurements does not have to be printed with every report again.
Generating a Single Report

A report on a single measurement result can be generated from the window of a
measurement macro by clicking or pressing the softkey “Generate report”.
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From the result overview of the main window, a report on a single measurement can
be generated by marking the row with the selected result by clicking on the row header
to the left, right-clicking into the data grid and selecting “Generate report” from the
context menu.

Subsequently data associated with the selected measurement is assembled, a graph
for existing curve data is generated, and the preview window is opened. Depending on
the amount of measurement data, this may take a few seconds.

9.4 Selection Report

A report on a selection of measurements can be generated from the results overview
data grid in the main window by checking the rows with the desired results in the
“Select” column and choosing item “Report Selection > Report Selected Results”.
Rows checked in the “Select” column will be added to the report. The selection can be
toggled by clicking into the respective “Select” cells.

P Create Report For Marked Fow FAIL RLR -
L Edit Comment of Marked Row PASS |RLR
! Delete Marked Row FAIL  Sendi
' Save Curve of Marked Row as ... FAIL [RLR -
] Repark Selection Report Selected Resulks

: Sort Chronologically Select all

= Ceselect all !
1 Sending WE

Delete Selected Results

4 Rerrivinn WH

Figure 9-2: Results context menu

9.5 Generating a Sequence Report

A report on a sequence of measurements can be generated from the sequence
window by clicking or pressing the softkey “Report sequence”.

Once the sequence window has been closed, a report on the last executed sequence
can be generated by selecting “Report > Last sequence” from the main menu.
Reports about previous sequences can be generated as single reports on the
measurements of this sequence, as all results appear in the overview data grid in the
main window.
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9.6 Preview Window

1
@Repurt !IEIE
i & » M1 fe 0 48 - CRYSTAL REPORTS'

I Main Report |
Verdict: PASS

04

104

Sending sensitivity [dB re 1 V/Pa]

-
4 3

Zurrent Page Moo 1 |Total Page Mo, 1+ Zoom Factor: 100%

Figure 9-3: Report preview window

The main area of the preview window shows a preview of the report as it will be printed
or appear in an exported PDF file. If the report comprises more than one page, the
pages can be browsed using the buttons

M4 » M
Alternatively, a page number can be directly entered in the page number field
1 M1+
To open the print dialog for installed windows printers click
3

To open a file selector for export of the report to Crystal Reports report format, PDF,
WORD, EXCEL, EXCEL-Data only format, Rich Text or editable Rich Text format, click

E

The scale of the document in the preview can be adjusted with
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Figure 9-4: Scale menu of the preview window

9.7 Storing and Loading Curves from Measurement Windows

Measured curves can be stored from and loaded into the graph of a measurement
macro (see above). This allows easy import into spreadsheets as well as direct
comparison of curves measured at different times or places. Measured curves can also
be stored in a R&S UPV limit file for use as a limit curve either in a R&S UPV sweep
graph or in the graph of a R&S UPV-K9/K92 window. This allows e.g. to derive
tolerance schemes from “golden devices”. The measured curve can be arbitrarily
shifted before being stored.

Limit Shift

Shift Curwe by o= d&

Cancel | ] 3

-

Figure 9-5: Input window for defining a shift of a measured curve for storage as limit curve

9.8 Storing and Loading Curves from the Results Overview

With menu item “Save Curve of Marked Row As ...” in the results context menu it is
possible to export curve data to ASCII files. If more than one curve is present for the
marked result, a selection window prompts to choose the curve(s) to be saved to a file.
The data can be saved in Tab separated (*.txt) and comma separated (*.csv) format.
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9.9 ASCII Result Files

When the item “Generate temporary export files” in the “Options” menu is checked, the
standard tests generate abscurve.exp, relcurve.exp and result.exp files
similar to those generated by UPL-B9. These files are always deleted and overwritten
by subsequent tests.

9.10 Deleting Results

It may be desirable to delete results of selected measurements from the result file, e.qg.
because the measurement was repeated due to a missing call to the mobile, a wrong
setting etc. To delete the result of a particular measurement, mark the row for the
selected measurement in the data grid of the main window by clicking on the row
header to the left, right-click into the data grid and select “Delete result” from the
context menu. After confirmation by the operator, the selected row of the result
overview will be deleted from the result file together with all associated data.

A set of results may be selected in the “Select” column of the results data grid and
commonly deleted using the context menu item “Report Selection > Delete Selected
Results”.

9.11 Automatic Backup and Restoration of the Results File

In order to speed up the execution of sequences, the result file is only saved when the
program is closed. However, backups of the result file called “*.xml~1" and “*.xml|~2"
are stored alternately after termination of each single measurement and after
termination of each sequence (“*” stands for the name of the results file without
extension). If the program is ended without closing it properly, or if the result file is not
existing anymore, the R&S UPV-K9 will by the time of its next start offer to restore the
result file from the latest backup file:

ok
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@Newer Backup File Found _ O] x|

The last session of this prograrm has ended
prematurely. Mot all results have been saved.

Lastwriting time of results file:
|1H 1/2007 4:12:11 PM|

Last writing time of backup file:
|1H 22007 2:40:08 AM

Would you like to backup the contents of the

resulfs file and restore the contents of the backup
file

No, keep results file | [ Yes, restore backup file |
Y

Figure 9-6: Restoration of data from backup file

If it is chosen to restore the result file from the backup, the supposedly damaged result

file is copied do “*.xml~3" before the backup file is copied to the original name of the
results file.
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Remote Controlled Start of Testcases via GPIB

Remote Controlled Start of Testcases via
GPIB

10.1 Preparations
1. Start the K9y test program on the R&S UPV.
2. Inthe “Options” menu, deactivate item “Show operator instructions” and activate
“Generate temporary export files”.
3. Ifitis desired to download screenshots from the R&S UPV to the host, activate
also “Generate temporary image files” in the Options menu.
4. Activate “Enable remote control” in the Options menu
5. Do all necessary settings and calibrations as would be done for manual control.
10.2 Starting a Measurement
A measurement can be started with remote command:
SYST:PROG:EXEC
C:\ControlK9.exe D:\Phone\3G2 rcv_handset narrow nom.mdf.mdf
wherein ControlK9.exe is the client program controlling the application and
D:\Phone\3G2 rcv handset narrow nom.mdf specifies a file which defines the
test to be executed. A list of files for various tests is given separately in the
spreadsheed file TestCaseList K9y 300.x1ls. The file name must be separated
from the program name by a space character. Thus it is recognized by the client
program as a command line parameter.
NOTICE
Do not attempt to control the R&S UPV-K9y software locally while a remotely started
test case is running.
10.3 Reading the Results

Result values and curves are available in memory buffers in the R&S UPV firmware
according to the following tables:
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Table 33: Assignment of string buffers for result values

String Buffers

1 Title <Tab> Date <Tab> Time

2 Total verdict

3 Result 1 heading

4 Result 1 value

5 Result 1 verdict

6 Result 2 heading

7 Result 2 value

8 Result 2 verdict

9 Margin 1 (upper) heading

10 |Margin 1 (upper) value

11 | Margin 2 (lower) heading

12 | Margin 2 (lower) value

13 | Margin 3 heading

14 | Margin 3 value

15 | Margin 4 heading

16 | Margin 4 value

17 | Delay heading

18 | Delay value

19 |Error message

20 |Result 3 heading

21 |Result 3 value

22 | Result 3 verdict

23 |Result 4 heading

24 | Result 4 value

25 | Result 4 verdict

26 |Result 5 heading

27 |Result 5 value

28 | Result 5 verdict
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String Buffers

29 |Result 6 heading

30 |Result 6 value

31 | Result 6 verdict

32 | Result 7 heading

33 | Result 7 value

34 | Result 7 verdict

String buffers can be queried using the remote command
SYSTem:MEMory:STRing<i>?

Table 34: Assignment of trace buffers for result curves

Trace Buffers

1 Result 1 (absolute) curve X values

2 Result 1 (absolute) curve Y values

3 Result 1 shifted / upper limit X values

4 Result 1 shifted / upper limit Y values

5 Result 1 lower limit X values

6 Result 1 lower limit Y values

7 Result 1 relative curve X values

8 Result 1 relative curve Y values

9 Result 2 (absolute) curve X values

10 | Result 2 (absolute) curve Y values

11 |Result 2 shifted / upper limit X values

12 | Result 2 shifted / upper limit Y values

13 | Result 2 lower limit X values

14 | Result 2 lower limit Y values

15 | Result 2 relative curve X values

16 | Result 2 relative curve Y values

Results are also available in files D: \Phone\result.exp, D:\
Phone\relcurv.exp and/or D:\ Phone\abscurv.exp, depending on the type of
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measurement. If “Options - Generate temporary image files” is activated, a
screenshot of the last finished test is available in D:\ Phone\Image.TIF. The
command for the file transfer is (for the example of the results file)

MMEM:DATA? 'D:\ Phonel\result.exp'

All results are stored in the database. However, it is not possible to change the test
object remotely. The results can be identified later by the test time given in the
result.exp file.

10.4 Determining the Termination of a Measurement

A running test is indicated with bit 13 of the Operation register in the status system set.
It is recommended to configure a service request on the GPIB for a negative transition
of this bit:

STAT:OPER:NTR 8192

STAT:OPER:ENAB 8192

*SRE 128

A service request will be issued as soon as the test has terminated.

To avoid obsolete result files to be downloaded from the R&S UPV, existing result files
can be deleted before the start of the measurement, using the commands:

MMEM:DEL 'D:\ Phone\result.exp'
MMEM:DEL 'D:\ Phone\relcurv.exp'
MMEM:DEL 'D:\ Phone\abscurv.exp'

Note that an attempt to delete a non-existing file will lead to an entry in the error queue.
The error queue can be flushed using the query “SYST:ERR?” until the response is
‘0,”No error”. Alternatively existing files can be overwritten by uploading empty files
with the same name. Downloaded files can then be checked for their size before they

are processed further, to determine whether they are empty dummy files.

For further details on remote control of the R&S UPV via GPIB and on the remote
commands mentioned above please see the user manual of the R&S UPV.

]
Operating Manual 1402.0643.12 - 03 157



11 Terminating the Application

The measurement can be terminated from the main window with the “Exit” softkey.
This causes the result file to be written to the hard disk.
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12 Appendix A Settings on the Radio
Communication Tester R&S CMU200

Hardware and firmware requirements:

e The R&S CMU200 must be equipped with option R&S CMU-B41, Audio
Generator and Analyzer *.
Firmware version 3.60 or later must be installed on the R&S CMUZ200.
An XLR-BNC adapter (1 male, 1 female) and two BNC cables for connecting the
R&S CMU AUX connectors to the R&S UPV are required. These adapters are
part of R&S UPV-K9.

* |f option R&S CMU-B41 was not installed at the factory, internal FM auto-calibration
of the R&S CMU200 must be run one time after installation.

Set all necessary AMPS settings in the AMPS menu of the R&S CMU200. To activate
the external speech connection at AUX1 and AUX2, you must switch AF Gen to ON
and select external reference as the modulation source:

e  From the OVERVIEW menu, press AFMod.Gen.
e Press Mod.G.Deviation and set it to ON with the ON/OFF key (the deviation value
has no influence).

Sl AVPS s
o Overview Control
LU0 wodulation Setup IJ
< Sigraling Info Modulation
——— Carrier Freg, Error MIN —
- N 3
=== Total Peak Deviation RS B Appli
cation
SAT Fregquency Error £ —_—
. auency Bandwidth
——= SAT Peak Deviation MEC - Analyzer
Dialled Murnber —|--- Level
=== ST Frequency Error ~Meas. Contral
——— 5T Peak Deviation Repetition Continuous
Stop Condition | None MS$ Signal
=== Audio Peak Deviation » Analyzer Level
——— RMS*SQRT{2) Dev. » MS Signal
» BS Signal .
-48.4 dBm Carrier Power ~AF/Mod Generatar | AF g e
Control aff Oon D —
LeveliDeviation 2000 mY 8000 Hz
LU0 AF Analyzer Frenuency 1004 Hz 1004 Hz
0.000 v AF Volimeter ¥ Fitter
G
= Deviatio
8000 He|

AF G .ﬁnm. | Mdsgnﬂdc | Menus
B“mel FI’B“I‘I K Deviation Fore “esr:.
Figure 12-1: AMPS overview menu of the R&S CMU200

e Go to the Connection menu and press AF/RF.
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e Using the Mod.Source key, select Mod.externRef.

B AMPS Connection Control g Signal On
AF Connector Overview RF Connector Setup
AL A2
RF30UT  RF2 RF 1 RF
of & ) Demodout Qutput
AF N AFOUT G —
anayzer Oy O Generator Ext. Att.
o e +00u8 +00a8 +00 aB Qutput
Mod. . RF 41N RF 2 RF 1 RF
B Mod. intern ¥ Input
Mod. intern [ —_—
Mod. extern Ext. Att.

+00a8 +00ae +0.0 dB
Mod. extern Ref - &

ME Eignal
| — | Wideband
Peak Power

Connection | Other Call | MSSignal | BS Signal I Network AFIRF@'I Sync. I.- z_|

Figure 12-2: Selecting the modulation source for AMPS on the R&S CMU200

If the generator cannot be operated after Mod.externRef is selected, the generator
must first be switched on!

The program allows to measure the sending and receiving characteristics in the AMPS
mode. The measured loudness value as well as the frequency response are displayed
as in the digital mode. The contrast is the difference between the measured loudness
rating of the mobile in analog mode and in digital mode. When an AMPS test is
performed, the program automatically scans the result data base for matching results
in cdma mode (same device under test, same kind of measurement). If such results
exists, the latest of them is retrieved and used for loudness contrast calculation.

The call must be established in the cdma mode. The standard settings are SO3 8k
Enhanced (low) (EVRC) codec. You should first perform both the sending and
receiving measurements in the cdma mode and then the analog measurements in the
AMPS mode, because the call is interrupted after fallback from AMPS to cdma.
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Figure 12-3: Voice coder settings for COMA2000 on the R&S CMU200

For the AMPS measurements in the Handoff menu, select the setting AMPS fallback.
After the HANDOFF key has been pressed, the R&S CMU200 makes a handoff to
AMPS using the previously (in the AMPS menu) selected AMPS parameters. The
AMPS parameters can also be set with the Destination Parameter key.

o CDMA200 N'.)ger. Overview : '_b ’

B CDMA2000NAPCS Connection Control [§° Connected

Select Target!

AMPS (Fallback)

AMPS

CDMAZ2000 Cell. (Fallback)
CDMA2000 Cell.

Figure 12-4: Selecting the fallback target on the R&S CMU200



Ch. 1 CDMAZOO Nl:gger‘. SR . ’_h |

& AMPS Connection Control [ Handoff Preparation Call Pending

87003 Mz

Figure 12-5: Setting the AMPS parameters for fallback on the R&S CMU200

The connection from the R&S UPV to the R&S CMU200 for the speech signal must be
changed for this measurement. The generator 2 output from the R&S UPV must be
connected with the AUX1 input of the R&S CMU, and the analyzer 2 input of the

R&S UPV must be connected with the AUX2 output of the R&S CMU. To do this,
remove the cable from the R&S UPV to the R&S CMU speech connector and make the
connections to the AUX BNC connectors.

CDMA2000® is a registered trademark of the Telecommunications Industry
Association (TIA — USA).



13 Appendix B Settings on the Radio
Communication Tester R&S CMW500

Hardware and firmware requirements:

e  Besides the basic hardware, the R&S CMW500 must be equipped with option
R&S CMW-B400B, R&S CMW-B405A, R&S CMW-B200A, R&S CMW-B220A and
R&S CMW-PK80.

e Firmware Base version 3.2.70 or later, CDMA2000 version 3.2.83 or later and
Audio version 3.2.30 or later must be installed on the R&S CMW500.

e Two XLR-BNC adapters (1 male, 1 female) and two BNC cables for connecting
the R&S CMW500 AF1 IN and AF 1 OUT connectors to the R&S UPV are
required. These adapters are part of R&S UPV-KO9.

Audio

Speech

Scenario External Analog Speech Analysis  ~
Analysis

Connector: o AR
Output Level Full-Scale (Peak): 1,000V

Figure 13-1: Audio measurement settings on the R&S CMW500

The input and output full-scale peak levels must be set to the same values as entered
in “Calibration - Codec > CMW?”. “Scenario” must be set to “External Analog Speech
Analysis”.
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Figure 13-2: Example of CDMA2000 signaling settings on the R&S CMW500

For narrowband acoustic tests either service option 3 or service option 68 COP0O
should be set. For wideband acoustic tests either service option 73 COPO or service
option 70 COPO should be selected. The COP (codec operating point) is set in the
Config page of the CDMA2000 signaling window.

5 (N
CDMA2000 1
TX Meas
~Scenario Standard Cell
~~Enable Speech Codec ¥ -
B System CDMA2000 1
B-Service Configuration BxMeos
-Accept Speech Calls Accept All Calls 34
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~Encoder Operating Point (Rate ... 0
--Average Encoding Rate 8.5 kbps v
- Rate Restriction Auto v
-Initialize Voice Coder Initialize
E-Test Data Service
E3-Packet Data Service At
I%}--Nelwork Parameter
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B-Shortcut Softkey
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Send SMS

Figure 13-3: Example of CDMA2000 signaling configuration on the R&S CMW500

“Enable Speech Codec” must be checked for establishing a speech connection with
the speech codec from/to AF 1 In and AF 1 OUT connectors.
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